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HARDWARE WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and workmanship
for a period of one (1) year from the date of shipment. If a product proves defective during this warranty period, Tektronix,
at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in
exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for
packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid.
Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the
Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any
other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting
from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair
damage resulting from improper use or connection to incompatible equipment; c) to repair any damage or malfunction
caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with other
products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO
THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE
LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE
OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.



SOFTWARE WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the
media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment.
If a medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange
for the defective medium. Except as to the media on which this software product is furnished, this software product is
provided “as is” without warranty of any kind, either express or implied. Tektronix does not warrant that the functions
contained in this software product will meet Customer’s requirements or that the operation of the programs will be
uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship
within a reasonable time thereafter, Customer may terminate the license for this software product and return this software
product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE
REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF
THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Use Proper Power Source. Do not operate this product from a power source that
applies more than the voltage specified.

Avoid Electric Overload. To avoid electric shock or fire hazard, do not apply a
voltage to a terminal that is outside the range specified for that terminal.

Avoid Overvoltage. To avoid electric shock or fire hazard, do not apply potential
to any terminal, including the common terminal, that varies from ground by
more than the maximum rating for that terminal.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Do Not Operate Without Covers. To avoid electric shock or fire hazard, do not
operate this product with covers or panels removed.

Use Proper Fuse. To avoid fire hazard, use only the fuse type and rating specified
for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. To prevent product overheating, provide proper
ventilation.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

To Avoid Fire or
 Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

 

Protective Ground
(Earth) Terminal

ATTENTION
Refer to Manual

DANGER
High Voltage

Symbols and Terms
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Preface

This document applies to the Tektronix MPEG Test System Real-Time Analyzer
(RTA) software and hardware. The MTS 205 contains only the RTA; the
MTS 215 also contains software for deferred-time transport stream analysis and
creation, and Data Store hardware and software for transport stream acquisition
and generation.

If you purchased an RTA test system and are looking for information about
installation, first-time operation, or specifications, refer to the MTS 200 Series
Hardware Installation and Specifications Compaq Proliant 1600 Platform
Technical Reference, Tektronix part number 071-0261-XX.

For the latest information about MTS200 Series Software features and bugs,
refer to the MPEG Test System Software Version 3.0 Read This First document,
Tektronix part number 071-0537-XX, that accompanied your test system,
software product, or upgrade.

Manual Structure
This manual is divided into the following sections:

Getting Started. This section contains all the information you will need to get the
RTA up and running.

Operating Basics. This section contains basic information for operating the RTA
user interface and tutorials to familiarize you with the functions of the RTA.

Reference. This section contains in-depth descriptions of the RTA analyses and
complete descriptions of configuration options.

Appendix A: ETR 290 Measurements. This section describes the ETR 290 tests and
measurements that the RTA can perform and report in the ETR 290 view.

Appendix B: ATSC Program Paradigm. This section describes the ATSC program
paradigm that the RTA uses.

Appendix C: Using the Private Syntax Interpreter. This section describes how to
use the Private Syntax Interpreter application to create and compile private
syntax definitions for use with the RTA.

Appendix D: Software Repair. This section contains information that you might
need in case of system disk errors, inadvertent software erasure, or application
file corruption.

Glossary. Consult the glossary when you encounter an unfamiliar term.

Index. 
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Symbols and Terms
The MTS200 Series Real-Time Analyzer interface uses many unique icons and
symbols. For an explanation of a particular icon or symbol, please refer to the
appropriate subsection of the Operating Basics section. For example, the icons
that appear in the Hierarchic view are explained in Using the Hierarchic View.

This manual uses several terms as defined below. Please see the Glossary for
additional definitions.

CARB (Carte d’Acquisition / Restitution Binaire)
French for Binary Acquisition/Restitution Board: the MTS 215 Data Store
system, which can capture, store, and output MPEG-2 compliant transport
streams.

RTA
Real-time Analyzer.

Related Documents
The MTS200 Series MPEG-2 DVB/ATSC System Analyzer User Manual,
Tektronix part number 071-0532-XX, contains information about using the
Deferred-Time Analyzer and DVB Channel Coding and Decoding applications.

The MTS200 Series Stream Creation Applications User Manual, Tektronix part
number 071-0534-XX, contains information about using the Multiplexer, DVB
Table Editor, ATSC Table Editor, DVB Channel Coding and Decoding, Jitter
Adder, Error Injector, and Open Mux Controller applications.

The MTS200 Series Program Stream Analyzer User Manual, Tektronix part
number 071-0384-XX, contains information about using the deferred-time
Program Stream Analyzer application.

The MPEG Test System Dolby Digital Audio Stream Analyzer User Manual,
Tektronix part number 071-0535-XX, contains information about using the
deferred-time AC-3 Audio Stream Analyzer application.

The MTS200 Series MPEG Audio Stream Analyzer User Manual, Tektronix part
number 071-0192-XX, contains information about using the deferred-time
MPEG Audio Stream Analyzer application.

The MTS200 Series Video Stream Analyzer User Manual, Tektronix part number
071-0249-XX, contains information about using the deferred-time MPEG Video
Stream Analyzer application.

The MTS200 Series Data Store Administrator User Manual, Tektronix part
number 071-0536-XX, contains information about using the Data Store (CARB)
system that is part of MTS 210 and MTS 215 test systems.
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For information about the Windows NT Workstation operating system, refer to
the Microsoft documentation that accompanied your test system.

For information about the Compaq server, refer to the Compaq documentation
that accompanied your test system.

Related Applications
The following table lists all MTS 200 Series MPEG Test System, version 3.0,
applications. The applications that appear in the Tektronix MPEG Test System
program group and Start menu of your test system depend on the system and its
installed options. See the version 3.0 Read This First document for additional
information about software options and licensing.

Table i: Tektronix MPEG Test System applications 

Icon Application title Function User Document

Real-Time Analyzer Continuously monitor an input bitstream for compliance
with the MPEG-2, DVB SI, and ATSC PSIP digital
television standards.

MTS 200 Series Real-Time
Analyzer User Manual
071-0076-XX

Private Syntax Interpreter Create table definitions used by the Real-Time Analyzer
to interpret private syntax sections and descriptors.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

MPEG-2 DVB/ATSC
System Analyzer

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Analyze transport streams and packetized elementary
streams that are saved in system disk or data store
(CARB) files.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
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MTS 200 Series MPEG-2
DVB/ATSC System
Analyzer User Manual
071-0532-XX

ÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁ
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DVB Channel Coding
and Decoding

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Code and decode transport stream files to DVB
specifications.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

MTS 200 Series Stream
Creation Applications User
Manual 071-0534-XX

(Information repeated in
both manuals)
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Table i: Tektronix MPEG Test System applications (Cont.)

Icon User DocumentFunctionApplication title
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

MPEG-2 Transport Stream
Multiplexer

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Create transport stream files from PSI/SI/PSIP table files,
elementary stream files, and data files.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
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MTS 200 Series Stream
Creation Applications User
Manual 071-0534-XX
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ÁÁÁÁÁÁÁÁ

DVB Table Editor ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Create and edit PSI and DVB SAI table files for use with
the transport stream multiplexer.
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ATSC Table Editor ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Create and edit PSI and ATSC PSIP table files for use
with the transport stream multiplexer.

ÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Jitter Adder ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Add jitter to the PCR data in an MPEG-2 transport
stream file.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁError Injector Insert or correct errors in transport stream packets. ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁReal-Time Multiplexer Configure the real-time multiplexer application to

remultiplex system and or elementary streams for
immediate output.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁOpen Mux Server Remultiplex various MPEG inputs (system, MPEG-2,

DVB, ATSC, and elementary streams) into a valid
transport stream for immediate output. The user interface
for this application is the Real-Time Multiplexer.
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Data Store Administrator ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Manage the data store (CARB) disks and control
acquisition/generation of MPEG-2 transport streams.
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MTS 200 Series Data
Store Administrator User
Manual; 071-0536-XX

Program Stream Analyzer Analyze MPEG program stream files that are saved in a
system disk or data store file.

MTS 200 Series Series
Program Stream Analyzer
User Manual; 071-0384-XX

MPEG Video Stream
Analyzer

Analyze MPEG-1 and MPEG-2 video elementary streams
that are saved in system disk or data store (CARB) files.

MPEG Test System Video
Stream Analyzer User
Manual; 071-0249-XX

MPEG Audio Stream
Analyzer

Analyze MPEG-1 and MPEG-2 audio elementary streams
that are saved in system disk or data store (CARB) files.

MPEG Test System Audio
Stream Analyzer User
Manual; 071-0192-XX

Dolby Digital Audio Stream
Analyzer

Analyze Dolby digital (AC-3) audio elementary stream
files or streams extracted from the MPEG-2 DVB/ATSC
System Analyzer.

MTS 200 Series Dolby
Digital Audio Stream
Analyzer User Manual;
071-0535-XX
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Table i: Tektronix MPEG Test System applications (Cont.)

Icon User DocumentFunctionApplication title

Tektronix Software
Protection

Enter or reenter the general password to enable licensed
applications.

Read This First, MTS 200
Series Software V3.0;
071-0537-XX

MPEG2_Part1
(ISO/IEC 13818-1)

The international MPEG-2 system standard in Windows
Help format.

none

UninstallShield Remove MPEG Test System software from the system
disk.

MTS 200 Series User
Manuals

Software Version
Table ii lists the MTS 200 Series MPEG Test System application version
numbers supported by this manual. To verify an application version number,
select Help in the application menu bar; then select About from the Help menu.

Table ii:  MTS 200 Series MPEG Test System (V3.0) supported applications

Application
Supported
version Applicable document(s)

Manual 
part numberÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Real-Time Analyzer
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

V2.0 and
above

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

MTS 200 Series RTA User Manual
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

071-0076-XX
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Contacting Tektronix

Product
Support

For application-oriented questions about a Tektronix measure-
ment product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. – 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tektronix.com

For product support outside of North America, contact your
local Tektronix distributor or sales office.

Service
Support

Contact your local Tektronix distributor or sales office. Or visit
our web site for a listing of worldwide service locations.

www.tektronix.com

For other
information

In North America:
1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

To write us Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000
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Getting Started

This manual explains the function and use of the Tektronix MTS200 Series
MPEG Test System Real-Time Analyzer (RTA) application. If you need
information about any other application included in the MTS200 Series system,
refer to Related Documents on page x for a list of MTS200 Series manuals.

NOTE. If you are not familiar with the Windows 95 or Windows NT 4.0 operating
systems, review the Windows NT documentation that accompanied your MTS 200
Series test system.

This section contains the following information:

� Product description page 1–2

� RTA signal connections page 1–2

� Logging on to the MTS200 Series system page 1–3

� Starting and exiting the RTA application page 1–4

� Shutting down the MTS200 Series system page 1–5

� Real-time analysis performance factors page 1–6

Refer to Operating Basics starting on page 2–1 for detailed information about
operating the RTA application.

Several tutorials are located in RTA Operating Tutorials starting on page 2–67
that are intended to introduce you to RTA operating capabilities, features, and
techniques.

Refer to Reference starting on page 3–1 for in-depth descriptions of the RTA
analyses and complete descriptions of configuration options.
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Product Description
The RTA application is designed to continuously monitor a transport stream (TS)
for compliance with the MPEG-2, DVB-SI, and ATSC/PSIP digital television
standards. You can use the RTA application to continuously monitor an array of
stream parameters to ensure decodability or you can concentrate on just a few
parameters for close examination.

The RTA conducts very few full-time analyses on the input stream. These default
analyses are fundamental to RTA operation and cannot be disabled. Refer to
Default Analyses on page 3–2 for a description of the full-time default analyses.
All of the remaining RTA analyses are user-initiated and user-controlled.

NOTE. To differentiate user-controlled analyses from RTA default analyses, this
manual refers to any user-controlled analysis as a Probe.

The number of stream parameters that you can monitor at one time while
maintaining real-time error reporting depends on the compliance level of the
input stream, the speed of the MTS200 Series test system’s processor, and the
amount of test system RAM. Refer to Real-Time Analysis Performance Factors
on page 1–6 for more information.

If you use the Data Store system, you can record a portion of the input stream for
use in off-line analysis by other MTS200 Series applications. Refer to Capturing
Input Streams (MTS 215 only) on page 2–96 for instructions.

The RTA provides the following types of analysis:

� Multiplex analysis

� Syntactic analysis of the transport and section levels

� Rate analysis of the transport and section levels

� Timing analysis of PCRs and PTS/DTSs

� Display pass/fail results of all ETR 290-recommended evaluations in one
display (the ETR 290 view)

� IP data transfer analysis

RTA Signal Connections
If you purchased an RTA test system and are looking for information about
installation, first-time operation, or specifications, refer to the MTS 200 Series
Hardware Installation and Specifications Compaq Proliant 1600 Platform
Technical Reference, Tektronix part number 071-0261-XX. After you have
installed the MTS200 Series server, the RTA is ready to operate.
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Logging On to the MTS200 Series System
Perform the following steps to log on to your MTS200 Series system:

1. Switch the MTS200 Series power on to begin the Windows NT initialization
process. Initialization can take up to two minutes. Under normal circum-
stances no action is required until the Begin Logon window appears.

2. When the Begin Logon window appears, press CTRL  + ALT  + DELETE  (all
three keys simultaneously) to open the Logon Information  window.

3. Enter MTS100 in the User name box, leave the password blank, and then
press ENTER (these are the default values set at the factory). This is the login
account you should use for most of your work. Refer to Login User Names
and Login Passwords below for more information about those topics.

The “MTS100” user name is the login account you should use for most of your
work. Two additional login user names are available. The first is “guest” with no
password. The guest login level has only limited access to files and applications.
The second is “administrator” with “MPEG2” as the password. The administra-
tor login level has administrator privileges to files and applications.

NOTE. You must use the “administrator” login when you perform any software
upgrades.

CAUTION. The “administrator” user has all the privileges of an administrator. If
you are connected to a network, you may have more privileges than you realize
within the network. It is recommended that you do not perform normal opera-
tions while logged in as an “administrator” user.

You can change the login passwords if necessary; refer to the Windows NT
documentation for instructions. If you change any login password, be sure to
create a new emergency repair disk. (Refer to Creating and Using an Emergency
Repair Disk  on page D–1.)

Login User Names

Login Passwords
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Starting and Exiting the RTA Application
Once you have logged in to the MTS200 Series system, you can start the RTA
application using one of the following two methods:

� Select Real-Time Analyzer from the Windows NT Start menu

� Double-click the Real-Time Analyzer icon (shown below) in the Tektronix
MPEG Test System window

You can exit the Real-Time Analyzer application using one of the following two
methods:

� Select Exit  from the Configuration menu

� Click the close button in the upper-right corner of the application window
(shown below)

Close button

When you exit the application, the current configuration is preserved and used
the next time you start the application. In the default configuration, information
and error messages (up to 20 Mbytes) are automatically saved in the Win-
dows NT Event Viewer. No other information is saved.
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Shutting Down the MTS200 Series System

CAUTION. Do not switch power off to your MTS200 Series system before the
message “It is now safe to turn off your computer” appears. Doing so may result
in lost data and difficulty in restarting Windows NT.

Perform the following steps to shut down the MTS200 Series system:

1. To avoid loss of data and possible problems during subsequent Windows NT
initialization, always shut down Windows NT before switching computer
power off. To shut down Windows NT, select Shut Down from the Start
menu (shown below).

2. Select Shut down the computer? in the resulting Shut Down Windows
dialog box (shown below) and then click Yes.

3. After a few seconds, the Shutdown Computer window appears with the
message that “It is now safe to turn off your computer.” You can now power
off the MTS200 Series system.
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Real-Time Analysis Performance Factors
The RTA application analyzes the input stream as it is received and attempts to
report errors as they are detected. When the RTA cannot process and display
errors in real time, the Buffer filling  bar becomes active. The Buffer filling bar
(shown below) is located in the center of the Status bar on the bottom of the RTA
application window. As buffer filling increases, RTA error and message displays
are less timely.

The following factors determine the real-time performance of the RTA:

� The number and type of errors in the stream

� The number and type of analyses that you have configured the RTA to
perform

� The host computer processor speed

NOTE. An RTA running on a 120 MHz Compaq Prosignia platform is more likely
to use the buffer than one that is based on a 200 MHz, 266 MHz, or 300 MHz
Compaq Proliant platform.

� The memory (RAM) that is available on the host computer. The computer
should have at least 32 Mbytes RAM; 64 Mbytes are standard on the
Proliant 1600

If the input stream contains many errors, you can reduce buffer filling by
limiting the number of analyses performed. Refer to Analysis starting on
page 3–1 for more information.



Operating Basics





MTS 200 Series Real-Time Analyzer User Manual 2–1

Operating Basics

NOTE. If you are not familiar with the Windows 95 or Windows NT 4.0 operating
systems, review the Windows NT documentation that accompanied your MTS 200
Series test system.

This section will familiarize you with the Real-Time Analyzer (RTA) display and
will provide you with a basic understanding of the functions available within the
application. Refer to Getting Started on page 1–1 for information about logging
onto the MTS200 Series test system and starting the RTA application. Refer to
the Reference section of this manual for information about analysis consider-
ations and configuring the RTA for specific analyses.

This section contains the following information:

� The RTA window display page 2–1

� Using the Hierarchic view page 2–11

� Using the Report view page 2–23

� Using the Client view page 2–39

� RTA operating tutorials page 2–67

� Remote control using SNMP page 2–103

The RTA Window Display
The RTA window (see Figure 2–1) fills the entire screen when you start the
application. The RTA window contains the following elements:

� Title Bar. In addition to identifying the RTA application, the title bar indicates
which of the three main RTA views is selected and the contents or subject of
the current display in the Client view. Refer to Title Bar on page 2–3 for
more information about the title bar.

� Menu Bar. The menu bar provides access to the various RTA command
menus. Refer to Menu Bar on page 2–4 for descriptions of the menu
functions available within the menu bar.

� Toolbar. The toolbar contains graphical command buttons for many of the
most-used menu commands as well as an icon indicating whether the RTA is
actively analyzing the input stream. Refer to Toolbar on page 2–8 for more
information.
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Hierarchic
view

Menu bar
Toolbar

Status bar

Title bar

Report
toolbar

Client
view

Report
view

Figure 2–1: Elements of the RTA application window

� Hierarchic View. The Hierarchic view uses icons to show the interrelationship
of stream components and displays additional text information about each
component. Refer to Using the Hierarchic View on page 2–11 for more
information.

� Client View. The Client view can contain one or more user-selected subordi-
nate views. Refer to Using the Client View on page 2–39 for more informa-
tion.

� Report View and Report Toolbar. The Report view includes the report toolbar
and displays all stream analysis results across the bottom of the RTA
window. Refer to Using the Report View on page 2–23 for more information.

� Status Bar. The status bar displays help statements and useful information
about the analyzed stream. Refer to Status Bar on page 2–9 for more
information.
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RTA Window Interface Conventions
Wherever possible, the RTA application follows Windows NT 4.0/Windows 95
user interface conventions.

As you use the RTA, you can change the relative sizes of the Hierarchic, Client,
and Report views, depending on the information that is most important at a given
time. To change the relative widths of the Hierarchic and Client views, position
the pointer over the split bar (the border between the two panes); the pointer
changes from an arrow to a special shape (). Press the mouse button down and
drag the border left or right to decrease or increase the width of the Hierarchic
view as shown below.

Default view widths Split bar moved to the right to show more of the hierarchy

You can change the height of all three views by dragging the split bar that
separates the Hierarchic and Client views from the Report view.

You can also maximize the height of the Hierarchic and Client views by
changing the Report view into a Client view. Refer to Hierarchic View Menus on
page 2–26 for instructions.

Title Bar
In addition to identifying the RTA application, the title bar indicates which of the
three main views (Hierarchic, Report, or Client) is selected and the contents or
subject of the Client view.

The RTA application prints from the currently selected RTA view. Because the
contents of the selected view are printed, it is important to know which view is
selected before choosing Print  from the View menu. To select a view, click
anywhere within the view.

Figure 2–2 shows some example title bar messages.
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The Hierarchic view is selected and the ETR 290 view is the current Client view:

The Report view is selected and the ETR 290 view is the current Client view:

The Client view is selected and the ETR 290 view is the current Client view:

The Client view is selected and EMM, PID 0x20, is the subject of the current Client view:

Figure 2–2: Examples of title bar messages

Menu Bar
The menu bar (shown below) contains the RTA command menus. You can access
the menus using your PC mouse, or you can use the keyboard by pressing the
underlined letter in the displayed menu name. The following pages describe the
selections available within each of the menus.

� Configuration Menu. The Configuration menu contains commands for
managing program settings and configurations and for exiting the RTA
application.

� View Menu. The View menu contains commands for managing the different
RTA views.

� Analysis Menu. The Analysis menu contains commands to start and stop
input stream analysis.

� Data Storage Menu. The Data Storage menu contains commands to start and
stop input stream storage (on the MTS 215 only).

� Window Menu. The Window menu contains commands for managing the
various displays within the Client view.

� Help Menu. The Help menu provides access to RTA online help and version
information.

� Active View Menu. The Active View menu, denoted with various view
symbols, appears on the left end of the menu bar when a view is maximized
in the Client view. The pie chart symbol in the menu bar shown above
indicates that the Statistic view is active in the Client view.
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The Configuration menu contains commands for managing program settings and
configurations and for exiting the RTA application (because there is no File
menu). Table 2–1 describes the menu selections available in the Configuration
menu.

Table 2–1: Menu bar Configuration menu 

Menu selection Function

Settings Open the Settings window (refer to Configuration on page 3–41)

Load Restore a previously-saved configuration

Save as Save the current configuration

Restore standard Restore default settings only when analysis is stopped

Exit Quit and exit the Real-Time Analyzer application

Use the View menu commands to control the information displayed in the RTA
application window. Table 2–2 describes the menu selections available in the
Configuration menu.

Table 2–2: Menu bar View menu 

Menu selection Function

Freeze views Suspend (freeze) window updates while analysis continues. Freezing
the views allows you to examine or capture transitory information (that
is likely to soon disappear from the display) and to find and examine
error messages that have scrolled off the top of a message window.

Reset past errors Acknowledge all previously-detected errors, reset all error counters to
zero, and restore all orange-colored indicators to their original color.

Report view Open the Report view or select the Report view and place it in front of
all other views if necessary.

Statistic view Open the Statistic view or select the Statistic view and place it in front
of all other views, if necessary.

ETR 290 view Open a (detailed or monitor) ETR 290 view or select the ETR 290
view and place it in front of all other views, if necessary.

Toolbar Toggle the presence of the Toolbar (Command buttons) in the RTA
application window. A check mark precedes the command when the
Toolbar is present.

Status bar Toggle the presence of the Status bar in the RTA application window.
A check mark precedes the command when the Status bar is present.

Print Print the current window or window pane. In the Message view just
the contents of the message view are printed.

Print Setup Configure the printer.

Configuration Menu

View Menu
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The Analysis menu contains commands for starting and stopping input stream
analysis. You may find it more convenient to use the command button equiva-
lents on the toolbar. Table 2–3 describes the menu selections available in the
Analysis menu.

Table 2–3: Menu bar Analysis menu 

Menu selection Function

Start Begin analyzing the input stream

Stop Stop input stream analysis

The Data Storage menu is only applicable to MTS 215 instruments, which are
equipped with the Data Store system. Table 2–4 describes the menu selections
available in the Data Storage menu.

Table 2–4: Menu bar Data Storage menu 

Menu selection Function

Start Begin saving the input stream to the data store disks

Stop Stop data capture

The Window menu contains commands for managing the various windows
within the RTA Client view. Table 2–5 describes the menu selections available in
the Window menu.

Table 2–5: Menu bar Window menu 

Menu selection Function

Cascade Arrange windows in the Client view in an overlapping upper-left to
lower-right cascade. The active window is on the lower right.

Tile horizontally Arrange Client view windows as non-overlapping tiles that stretch from
left to right across the Client view.

Tile vertically Arrange Client view windows as non-overlapping tiles that stretch from
from the top of the Client window to the bottom.

Arrange icons Arrange minimized view icons along the bottom of the Client view.

Restore standard Restore the default RTA window arrangement.

(List of open windows) Select the Client view to be shown in front of all other windows.

Analysis Menu

Data Storage Menu
(MTS 215 only)

Window Menu
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The Help menu provides access to online help and version information.
Table 2–6 describes the menu selections available in the Help menu.

Table 2–6: Menu bar Help menu 

Menu selection Function

Help topics Open the RTA Help window

About RTA Display RTA version and copyright information

The Active View menu performs actions on the top view in the Client view. You
access this menu by clicking on the icon at the far left of the Menu bar when the
Client views are maximized (the example below shows the Statstic view icon).
The icon representing the menu changes to match the type of the top panel in the
Client view. When the panels in the Client view are tiled, this menu can be
accessed on each panel in the Client view. The menu contains standard Win-
dows NT window-management commands. Table 2–7 describes the menu
selections available in the Active View menu.

Table 2–7: Menu bar Active View menu 

Menu selection Function

Restore Change all open Client views to windows or icons within the Client
view, depending on the last state of each window. This command is
equivalent to clicking on the Restore button above the upper right
corner of the Client view. The active view menu disappears from the
Menu bar when you select this command.

Move Move the selected view within the Client view.

Size Resize the selected view within the Client view.

Minimize Minimize all open Client views to icons within the Client view. The
Active View menu icon disappears from the Menu bar when you select
this command.

Maximize Maximize all open Client views. The Active View menu returns to the
Menu bar when you select this command.

Close Close the current active (top) Client view.

Next Select the next Client view. This command is equivalent to clicking the
view tab to the right of the tab attached to the currently active view.

Help Menu

Active View Menu
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Toolbar
The toolbar (shown below) provides shortcut buttons for many of the most often
used menu commands. Click the button to choose the corresponding command.
You can toggle the toolbar on and off using the View menu Toolbar command.
Table 2–8 describes the functions available in the toolbar.

Table 2–8: Toolbar functions and analysis indicator 

Icon Name Function
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Start Analysis
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Begin analysis; equivalent to the Start command on the Analysis
menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Stop Analysis ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

End analysis; equivalent to the Stop command on the Analysis
menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Freeze
(or Pause)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Suspend all window updates but continue monitoring the incoming
stream; equivalent to the Freeze views command on the View
menu.

Report view Open or select the Report view; equivalent to the Report view
command on the View menu.

Statistic view Open or select the Statistic view; equivalent to the Statistic view
command on the View menu.

ETR 290 view Open or select the ETR 290 Monitor view; use the ETR 290 view
command on the View menu to open the ETR 290 Detailed view.

Restore
standard

Equivalent to the Restore Standard command on the Window
menu.

Start Data Store
(MTS 215 only)

Begin capturing the incoming stream onto the data store disks;
equivalent to the Start command on the Data Storage menu.

Stop Data Store
(MTS 215 only)

Stop capturing the incoming stream; equivalent to the Stop
command on the Data Storage menu.

RTA analysis
indicator

This icon is animated when RTA analysis is enabled. The icon is
motionless when RTA analysis is disabled.



Operating Basics

MTS 200 Series Real-Time Analyzer User Manual 2–9

Status Bar
By default, the status bar appears at the bottom of the RTA application window.
You can toggle the status bar on and off with the View menu Status bar
command.

The Status bar shows the following information:

� Help and status messages for menu and toolbar commands. For example,
when you select the Freeze views command from the View menu, the
message PAUSE appears on the left end of the status bar.

� The status (percent usage) of the PC-to-RTA communication buffer.

� The number of bytes (188, 204, or 208) in the input stream transport packets.

� The global bit-rate of the input stream.

� Presence of level one (LV1), level two (LV2), and level three (LV3) ETR 290
errors. If no error is detected, a green sphere icon is displayed; when an error
occurs, the sphere becomes red. If the error stops, the icon becomes orange
to indicate that at least one error has been detected in the past.

� Status of the TEI (Transport Error Indicator). The error indicator icon
follows the same color conventions as the MG1, 2, and 3 indicators. The
icon is gray when TEI analysis is disabled.

� State of the UNP (Unsynchronized Packet). The error indicator icon follows
the same color conventions as the MG1, 2, and 3 indicators. The icon is gray
when UNP analysis is disabled.

� Running state of the data storage (MTS 215 only). If the input stream is
being saved on the data store disks, a cassette tape icon alternates with the
abbreviation “REC.”
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Using the Hierarchic View

The Hierarchic view (see Figure 2–3) uses icons to show the interrelationship of
transport stream components. Additional text information about each stream
component is listed next to the associated icon.

This section contains the following information about the Hierarchic view:

� Hierarchic view display page 2–11

� Identifying hierarchic icons page 2–14

� Hierarchic text messages page 2–17

� Hierarchic icon shortcut menus page 2–19

Hierarchic View Display
A portion of a fully expanded Hierarchic view of a simple DVB transport stream
is shown in Figure 2–3. The Hierarchic view uses the Windows NT 4.0 operating
system’s convention for viewing file directories to display different levels of the
transport stream.

The colored rectangles above each icon indicate the error status of that stream
component. Refer to Icon Error Indicators on page 2–14 for more information.

NOTE. When the PID Allocation panel of the Statistic view is open in the Client
view and Selection is highlighted in the PID Allocation panel, you can drag and
drop icons between the Hierarchic view and the PID Allocation panel to add and
remove stream items from the PID Allocation display. Refer to PID Allocation
Panel on page 2–46 for more information.
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Level 1: Transport stream

Level 2: PAT, CAT, DVB-SI, ATSC/PSIP tables

Level 3: PMT, MPEG-2 NIT, EMM (CAT), PSIP EIT, ETT

PID of item Type of item

Level 4: Video, Audio, Private Tables, ECM, PES, data

Figure 2–3: Hierarchic view display
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Table 2–9 summarizes the effects of mouse and keyboard actions that change the
appearance of the Hierarchic view and reveal (or hide) additional information
about the input stream.

Table 2–9: Mouse and keyboard actions in the Hierarchic view 

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Mouse action ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Keyboard action ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Effect on Hierarchic view

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Left-click on an icon ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select the icon

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Right-click on an icon ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Display a shortcut menu for the
hierarchy item. Refer to Hierar-
chic Icon Shortcut Menus on
page 2–19.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Double-click on an  icon
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Open an item Report view in
the Client view.

Click the + box next to an
icon

Press + on the numeric keypad Display one sub level (if any)
below the selected icon.

Click the – box next to an
icon

Press – on the numeric keypad Collapse the sub level below
the selected icon (will not
override the F7 through F10
selections explained below).

Press * on the numeric keypad Open all sublevels below the
selected icon.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Press the up or down arrow keyÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select the icon immediately
above or below the currently-
selected icon.

Press F1 Open the Help file.

Press F2 Toggle numeric display between
hexadecimal and decimal base
(for example, 0x00C1 ↔ 193).

Press F3 Freeze/unfreeze view updates.

Press F4 Reset all past errors; all orange
error indicators become green
or gray.

Press F6 Toggle section rate display.

Press F7 Show first-level hierarchy items
only.

Press F8 Show hierarchy items in the first
and second levels only.

Press F9 Show hierarchy items in the first
three levels.

Press F10 Show all hierarchy items in the
first four levels. There will be no
“+” signs to the left of hierarchy
icons.

Setting the Hierarchic
View Appearance
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The colored rectangles that appear over each icon in the Hierarchic view are error
indicators; the color of the error indicator conveys information about the
monitoring and error status of the stream element.

Error indicator

� A gray indicator signifies that no user-specified probes that affect the item
are set and that the automatic tests have detected no errors.

� A green indicator signifies that at least one user probe is set and that no error
has been detected.

� A red indicator signifies that at least one error has been detected and is still
pending.

� An orange indicator signifies that at least one error has been detected in the
past but is no longer occurring.

When an error occurs at a given level, the indicator changes its color not only for
the considered item, but also for all parent items. For example, if an error occurs
for an elementary stream, both the program icon and the multiplex icon captions
will change color. This is especially useful when the RTA detects errors when a
“+” sign next to the icon indicates that the tree is collapsed.

Refer to Hierarchic Error Reporting on page 2–18 for more information about
error reporting in the Hierarchic view.

Identifying Hierarchic Icons
The RTA uses a variety of icons to represent stream items. Each of the hierarchic
icons has an associated menu that allows you to perform specific functions
related to the stream item. Table 2–10 identifies the icons used in the Hierarchic
view and shows the associated menus.

The hierarchic icons normally appear in color on the RTA display except when
the corresponding stream item is referenced in a table but has not yet appeared in
the stream. Icons for these referenced but absent items remain gray until the item
appears in the input stream.

PCR clocks and scrambling symbols are superimposed on icons when appropri-
ate. Refer to PCR Clock and Scrambling Symbols on page 2–16 for more
information.

Use Table 2–10 to identify the icons used in the Hierarchic view.

Icon Error Indicators

Icon Appearance
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Table 2–10: Hierarchic view icon identification 

Icon
Hierarchy
level Element type

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport stream. This icon represents all (188/204/208-byte)
transport packets that make up the stream. If you visualize the
transport stream as a train, this icon represents every car in the
train, regardless of its configuration or what it contains.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

2 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PAT, CAT, or TSDT table

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

2
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Any other table (such as DVB-SI)

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

2
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ATSC-PSIP tables (such as CVCT, TVCT, MGT, STT, RRT)

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

2
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

A specific transport packet (such as MIP)

2 GHOST. A ghost indicates one or more transport packets
identified with a PID that is not referenced in an appropriate table.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PMT table

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

MPEG-2 NIT table

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

For ATSC: EIT and/or ETT tables referenced by MGT

3 EMM table

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

4
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Video stream

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

4 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Audio stream

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

4 ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Data stream

4 ECM table for program
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Table 2–10: Hierarchic view icon identification (Cont.)

Icon Element type
Hierarchy
level

4 For SIDAT 360 streams: DownloadInfoIndication tables for
one-layer Data Carousels

4 For SIDAT 360 streams: DownloadServerInitiate tables for
two-layer Data Carousels

4 For SIDAT 360 streams: Multiprotocol Encapsulation sections

4 DSM-CC generic stream (may carry several tables)

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

4
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Private table

5 ECM table for elementary stream

5 For SIDAT 360 streams: DownloadInfoIndication tables for
two-layer Data Carousels

5 For SIDAT 360 streams: Data Carousel module (one-layer Data
Carousels)

6 For SIDAT 360 streams: Data Carousel module (two-layer Data
Carousels)

A PCR clock ( ) symbol is added to the upper-right corner of stream icons to
indicate streams that carry PCR clocks. The TS railcar and clock icon (shown
below) represents PCR clocks in an independent stream (that is, transport
packets containing PCRs). A padlock symbol () is added to the lower-left
corner of stream icons to signify the streams that are scrambled. Examples of
icons with the PCR clock and scrambling symbols added are shown below.

PCR Clock and
Scrambling Symbols
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Hierarchic Text Messages
Information about a transport stream component appears to the right of its
associated icon. The information displayed about each stream component
depends on the type of item as shown in the following examples.

Network name, extracted from
the network_name_descriptor

field of the NIT

Frequency, extracted from the
satellite_delivery_system_descriptor

of the NIT

transport_stream_id,
extracted from the PAT

Polarization, extracted from the
satellite_delivery_system_descriptor
of the NIT
LH = linear horizontal
LV = linear vertical
CL = circular left
CR = circular right

Number of programs
defined in the PAT

Item PID

Table section rate and
maximum interval between

sections (toggled on/off
with the F6 function key)

Number of errors
detected by RTA

Program number
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Number of item errors
detected by the RTA

Network ID 
(DVB mode only)

Service ID and name

In addition to the error indicator at the top of each Hierarchic view icon, the
number of errors detected for the item are listed to the right of the item as shown
above. Refer to Icon Error Indicators on page 2–14 for information about icon
error reporting.

Hierarchic Error Reporting
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Hierarchic Icon Shortcut Menus
Every active hierarchy item that is represented by a color icon has a shortcut
menu that enables you to learn more about a selected item, reset errors,
and—depending on the item—set and clear probes directly from the Hierarchic
view. Right-click on an icon to open the shortcut menu; then left-click on a menu
command to select it.

The shortcut menu selections associated with the various stream components are
shown in Table 2–11. Many of the menu functions are similar; refer to
Table 2–12 on page 2–22 for descriptions of the functions available in these
shortcut menus.

Table 2–11: Hierarchic view icon shortcut menus 

Icon Element type Shortcut menu selections
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Transport stream ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

View report
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

PAT or TSDT ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PAT section probe (PAT icon only)
TSDT section probe (TSDT icon only)
View section analysis
View section rate
View report
Transport rate interval
Reset past errorsÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

PMT
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PMT section probe
View section analysis
View section rate
View report
PCR probe
View PCR analysis
Transport rate interval
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

MPEG-2 NIT ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

NIT MPEG section probe
View section analysis
View section rate
View report
Transport rate interval
Reset past errorsÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

DVB table
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Section probe
View section analysis
View section rate
View report
InterSI probe
Transport rate interval
Reset past errors
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Table 2–11: Hierarchic view icon shortcut menus (Cont.)

Icon Shortcut menu selectionsElement type

Elementary stream data View report
Transport rate interval
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Elementary stream video
or audio

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PTS/DTS probe
View PTS/DTS analysis
View report
Transport rate interval
Reset past errors

PRIV.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Private section
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Private section probe
View section analysis
View section rate
View report
Transport rate interval
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ECM
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ECM section probe
View section analysis
View section rate
View report
Transport rate interval
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

EMM ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

EMM section probe
View section analysis
View section rate
View report
Transport rate interval
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Generic DSMCC ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Private section probe
View section analysis
View section rate
View report
Transport rate interval
Reset past errors
IP monitoring

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Multiprotocol encapsula-
tion

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Multiprotocol encapsulation probe
IP datagrams monitoring
View section analysis
View section rate
View report
Reset past errors
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Table 2–11: Hierarchic view icon shortcut menus (Cont.)

Icon Shortcut menu selectionsElement type
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Data carousel View section analysis
View section rate
View report
Reset past errors

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Data carousel module ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Module probe
View section analysis
View section rate
View report
Reset past errors

MIP

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

MIP ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

View MIP packet analysis
View report
Transport rate interval
Reset past errors

Ghost View report
Transport rate interval
Reset past errors

Menu selection items that are gray are unavailable and cannot be selected. Menu
items may be unavailable for a number of reasons:

� PTS/DTS probes cannot be set on scrambled elementary streams

� The Reset past errors menu selection is unavailable when no errors have
been detected

The shortcut menu selections associated with each of the various stream
components are shown in Table 2–11 starting on page 2–19. Many of the menu
functions are similar between the icons. Table 2–12 describes each of the
functions available in the Hierarchic shortcut menus.
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Table 2–12: Hierarchic view shortcut menu commands 

Menu command Function

<stream icon> section
probe

Sets or removes the section probe for the selected stream icon.
When the section probe is active, a check mark appears by the
menu selection.

View section analysis Opens a section analysis view of the selected table in the
Client view. Opening a section analysis view automatically sets
the section analysis probe for the selected stream icon. Refer
to Section Analysis View on page 2–56.

View section rate Opens a section rate view for the selected table in the Client
view. Refer to Section Rate View on page 2–58.

View report Opens a message window for the selected stream item in the
Client view or brings an already-opened message view to the
front. Equivalent to double-clicking on the icon.

Transport rate interval Opens a dialog box where you can set transport rate error
thresholds for the selected stream item. Refer to Transport
Rate on page 3–2.

Reset past errors Clears error history and resets the error counter to zero. This
selection is enabled only when the error indicator for the
selected stream item is orange (indicating a past error, but no
current errors).

PCR probe
(PMT icon)

Sets or removes a PCR probe on the selected program. Refer
to PCR Timing Analyses on page 3–29.

View PCR analysis
(PMT icon)

Opens a PCR analysis view for the selected program in the
Client view. Refer to PCR Analysis View on page 2–61.

PTS/DTS probe
(elementary stream video
and audio icons)

Sets or removes the PTS/DTS probe on the selected
elementary stream video or audio item. Refer to PTS/DTS
Timing Analyses on page 3–31.

View PTS/DTS analysis
(elementary stream video
and audio icons)

Opens a PTS/DTS analysis view for the selected elementary
stream video or audio item in the Client view. Refer to
PTS/DTS Analysis View on page 2–59.

InterSI probe
(DVB table icon)

Sets or removes the InterSI probe. Refer to Using the InterSI
Analysis Probe on page 3–14.

IP monitoring
(generic DSMCC icon)

Opens an IP Monitoring view for the selected generic DSMCC
item in the Client view. Refer to IP Monitoring View on
page 2–65.

MIP packet analysis
(MIP icon)

Opens an MIP Packet view for the selected MIP item in the
Client view. Refer to MIP Packet Analysis View on page 2–63.
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Using the Report View

The Report view occupies the bottom of the default RTA window (see Fig-
ure 2–1 on page 2–2) and displays all of the stream analysis results.

This section contains the following information about the Report view:

� Report view display page 2–23

� Hierarchic report view page 2–24

� Summary report view page 2–28

� Graph report view page 2–32

� Message report view page 2–34

Report View Display
The Report view (see Figure 2–4) occupies the bottom of the default RTA
application window and displays all stream analysis results. The Report view is
divided into two sections. The left section contains the hierarchic view that you
use to specify the display and organization of the information in the right section.
Depending on the item selected in the hierarchic view, the right section of the
Report view can contain a summary view, a graph view, or a message view.

Hierarchic
view

Summary
(shown),
graph, or
message

views

Figure 2–4: Report view display
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Hierarchic Report View
The hierarchic view in the Report view lets you specify how RTA analysis
results are organized. You can view all or selected error messages. The hierarchic
view uses the Windows NT 4.0 operating system’s convention for viewing file
directories to display different levels of the transport stream.

When the RTA displays its analysis of the transport stream, initially only the top
level of the hierarchy is displayed. The top level of the hierarchy is displayed as
folder icons each representing a “Configuration.” A Configuration is a collection
of all analysis results gathered by the RTA since the previous synchronization.

NOTE. The RTA creates a new Configuration every time synchronization is
established. Therefore, if you stop and restart analysis, or if the RTA loses and
regains synchronization for any reason (such as a momentary loss of the input
signal), another Configuration icon appears in the hierarchic view.

The following figure shows a report hierarchy that contains two Configurations.
The time of synchronization appears to the right of the folder icon; the numbers
within the square brackets are the total number of error and warning messages,
respectively, generated for the Configuration. The top folder is open, indicating
that the right section of the Report window displays results in the first Configu-
ration.

To see additional levels of the results hierarchy, either click the + box to the left
of an icon, or double-click the icon itself. The figure below shows the hierarchy
being expanded by clicking the + boxes.

Selecting the various second- and third-level icons changes the contents and
appearance of the right section of the Report view. The actual appearance and
organization of the second and third levels depends on the current report mode.

Hierarchy Icons and
Levels
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Error Reporting. The color of each report hierarchy icon signifies the presence or
absence of errors and warnings within the corresponding item.

� A green icon indicates that no error or warning messages have been
generated for the item or its hierarchic descendents.

� A red icon indicates that at least one error message has been generated for
the item or its hierarchic descendents.

� A yellow icon indicates that at least one warning message has been generated
for the item or its hierarchic descendents.

When the item (or its descendents) contains both errors and warnings, the errors
take precedence, and the icon is red. Notice in Figure 2–5 that the RTA displays
the total number of error messages and the total number of warning messages in
the item (or its descendents) in square brackets to the right of the synchronization
time.

For your convenience, the RTA can parse and display results by program, by
ETR 290 level, or by advanced analyses. Figure 2–5 shows the same Configura-
tion hierarchy in each of the three report modes. You can access the report modes
using one of the following methods:

� Report view toolbar

� Hierarchic view Display menu

Program mode ETR 290 mode Advanced mode

Figure 2–5: Report view hierarchic display modes

The report toolbar, located on the left side of the Report view, allows you to set
the report mode for the Report view. You can also change report mode through
the report view shortcut menu. Select the desired report mode by clicking the
appropriate report view toolbar button, as indicated by the arrows in Figure 2–5.
The ✖  icon at the bottom of the toolbar closes the Report view. (To reopen the
Report view, either select Report View from the RTA View menu or click the
corresponding toolbar button.)

Report Modes

Report Toolbar
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You can use the right mouse button to access two different menus within the
Report view hierarchic view. The Display menu appears when you right-click
within the hierarchic view but not on a hierarchy item. The Message and Config-
uration menu appears when you right-click on a hierarchy item.

Display Menu. Table 2–13 lists the commands found in the Display menu, which
appears when you right-click within the hierarchic view of the Report view, but
not on a hierarchy item.

Table 2–13: Report view Display menu 

Menu selection Function

Program Sets the report display mode to Program, which organizes messages
for each program in the stream (see Figure 2–5).

ETR 290 Sets the report display mode to ETR 290, which organizes messages
by the ETR 290 error level (see Figure 2–5).

Advanced Sets the report display mode to Advanced, which organizes messages
by each of the Advanced analysis types: multiplex, syntax, timing, and
rate (see Figure 2–5).

Toggle docking Maximizes the Hierarchic and Client views by changing the location of
the Report view from the bottom of the RTA application window to
inside the Client view as shown in Figure 2–6. You can switch
between the views in the Client view using the tabs at the bottom of
the Client view.

To return the Report view to its default location at the bottom of the
RTA window, right click within the hierarchic portion of the Report view
in its location in the Client view, but not on a hierarchy item to reopen
this menu. Then select toggle docking again.

Close Closes the Report view. To reopen the Report view, either select
Report View from the RTA View menu or click the corresponding
toolbar button.

Message Menu. Table 2–14 lists the commands found in the Message menu,
which appears when you right-click on a hierarchy item in the Report view.

For information about acknowledging or deleting individual error messages,
refer to Acknowledging and Deleting Messages on page 2–35.

Hierarchic View Menus
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Figure 2–6: Toggle docking the Report view into the Client view

CAUTION. You cannot undo the following Message menu commands. Acknowl-
edged messages cannot be reset, and deleted messages or configurations cannot
be recovered.

Table 2–14: Report view Message menu 

Menu selection Function

Acknowledge all
messages

Acknowledges all of the Report view error messages for the selected
configuration. Acknowledging all messages is equivalent to resetting
past errors; the hierarchic icon becomes green (at least momentarily)
as if no messages had been generated. A checkmark precedes all
acknowledged messages.

Delete acknowledged
messages

Deletes all acknowledged error messages from the selected
configuration. Error messages that have not been acknowledged will
not be deleted.

Delete all messages Deletes all error messages (acknowledged or not) for the selected
configuration.

Delete configuration Deletes the selected configuration.

Delete all configura-
tions

Deletes all but the most recent configuration.
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Summary Report View
The Report view summary view (shown below) appears in the right section of
the Report view whenever you select a Configuration icon (folder) in the Report
view hierarchic view. The summary view presents a record of the input stream
characteristics, contents, and errors.

The summary view is divided into three regions: the summary error graph, the
general information panel, and the event panel. The three regions are explained
on the following pages.

General information panel

Event panel

Error graph

The error graph provides an at-a-glance indicator of the frequency and severity of
the errors measured during the current configuration, or monitoring session. The
level of each segment in the graph indicates the most significant error, if any,
detected during the corresponding time period. The most recent segments appear
at the right end of the graph, while the oldest segments scroll off the left end of
the graph. The error level of the current segment is indicated at the right of the
error graph.

Segment
duration

menu

Graph of
past error
segments

Current segment
error indicator

Error Graph
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The segment duration menu at the left end of the error graph controls the
duration of each graph segment. The selections range from 5s (five seconds) to
15m (fifteen minutes). The time span of the error graph (from 18 minutes, 15
seconds to 54 hours, 45 minutes) depends on the settings in the segment duration
menu.

As each measurement time period expires (as set by the segment duration menu),
one of the following five symbols appears in the right-most graph segment:

� A green dot indicates that no error was detected during the measurement
time period

� A short yellow bar (extending to the first graph line) indicates that at least
one warning message was generated during the measurement time period

� A short red bar (extending to the first graph line) indicates at least one
ETR 290 level three or other non-critical error was detected during the
measurement time period

� A medium red bar (extending to the second graph line) indicates at least one
ETR 290 level two or other critical error was detected during the measure-
ment time period

� A tall red bar (extending to the third graph line) indicates at least one
ETR 290 level one or other very critical error was detected during the
measurement time period

The general information panel (shown below) displays a variety of information
about the input stream. Displayed information includes the transport stream ID,
the network name, the number of programs, the conditional access, the transmis-
sion rate, and the available rate.

General Information Panel
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The event panel (shown below) presents information about the stream and its
contents as well as significant changes to the stream characteristics and content.
Information is presented in a three-level hierarchic format. To expand the
hierarchy at any point and reveal additional information about a stream item,
either click the + box to the left of the item icon or double-click the icon itself.

First Level Icons. The first level icons (see Figure 2–7) display event information
about the stream as a whole. The information displayed for each icon type is
listed below.

� Synchronization icons display the time of the last synchronization and
consequently the beginning of a configuration.

� Program icons display the program name and its current state (presence,
number of components, and rate).

� Lost Synchronization icons display the time of synchronization loss and,
consequently, the end of a configuration.

Synchronization icon

Program icon

Lost Synchronization icon

Figure 2–7: Event panel first level icons

Event Panel
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Second Level Icons. Click the + box to the left of a program icon to reveal the
second-level icons (see Figure 2–8). The second-level icons display the history
of each program. The information displayed for each icon type is listed below.

� The program State icon indicates whether the program is “present” or “not
present.” You can expand the State icon to reveal all program appearance and
disappearance times.

� The program Cond. access icon displays all changes in the program
conditional access.

� The program Rate icons show the current bitrate for the program, the
minimum/maximum bitrate for the program, and the average bitrate for the
program. Expand the rate items to reveal all program rate changes.

� The Audio, Video, Data, or Section Component icons displays the program
component type, its PID, and its current state (presence, scrambling, and
current, minimum/maximum, and average rate). (The Data and Section
component icons are not shown in Figure 2–8.)

State icon

Conditional access icon

Rate icons

Audio component icon

Video component icon

Figure 2–8: Event panel second level icons
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Third Level Icons. Click the + box to the left of a second-level icon to reveal the
third-level icons (see Figure 2–9). The third-level icons display the history of
each component The information displayed for each icon type is listed below.

State icon

Conditional
access icon

Scrambling
icon

Rate icons

Figure 2–9: Event panel third level icons

� The component State icon indicates whether the component is “present” or
“not present.” You can expand the State icon to reveal all component
appearance and disappearance times.

� The component Cond. access icon displays all changes in the component
conditional access.

� The component Rate icons show the current bitrate for the component, the
minimum/maximum bitrate for the component, and the average bitrate for
the component. Expand the rate item to reveal all component rate changes.

� The component Scrambling icon displays the status and history of changes
in the component scrambling state.

Graph Report View
The graph view varies slightly, depending on the selected report mode. Refer to
Report Modes on page 2–25 for more information. In all cases, the top, summary
graph indicates the most severe condition or error for each time segment. All
graphs use the same conventions as explained under Error Graph on page 2–28.
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When the Program report mode is displayed and you select the Program folder
icon as shown below, the Report view contains an error graph for each program
in the stream. In the case of multiple programs, a scroll bar may appear to the
right of the graph display to allow you to view all graphs.

5 s

When the ETR 290 report mode is displayed and you select the ETR 290 folder
icon as shown below, the Report view contains an error graph for each of the
three ETR 290 levels as well as a graph for other, non-ETR 290 errors.

When the Advanced report mode is displayed and you select the Advanced
folder icon as shown below, the Report view contains an error graph for each
type of advanced analysis (multiplex, syntax, timing, and rate) as well as a graph
for other errors. A scroll bar may appear to the right of the graph display to allow
you to view all graphs.

Program Report Mode
Graph

ETR 290 Report Mode
Graph

Advanced Report Mode
Graph
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Message Report View
The message view appears in the right side of the Report view when you select
an “other” report hierarchy icon or any third-level icon. The message view
contains all information and error messages that pertain to the selected item. For
example, when you select the program report mode and then select a program
icon as shown below, the message view displays the messages that pertain only
to the selected program.

The messages that appear are determined by your report view configuration
choices, all RTA settings that affect error detection, and the contents of the input
stream.

The message view has five or six columns, depending on the current report mode
and the selected icon.

� The Type column displays the type of message: Information, Warning,
Warning disappearance, Error appearance, and Error disappearance.

� The Program column displays the program, if any, that contains the event.

� The ETR 290 column displays the ETR 290 designation, if any, of the error
(Level 1.1 to Level 3.8.2).

� The Advanced column displays the type of advanced analysis of the
message (multiplex, syntax, timing, or rate).

� The Message column displays the content of the message.

� The Time column displays the time (and date) of the message.

Column Widths. To change the width of a column in the message view, position
the cursor over the divider to the right of the column heading; the cursor shape
changes to indicate that you can change the width. Then click and drag the
divider right or left to increase or decrease column width.

Message Columns
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To make the column width fit the longest message, double-click the column
heading divider; then you may have to drag the horizontal scroll box to the right
to read the entire message.

By default the messages appear in the order that they are generated. You can sort
the messages by type, ETR 290 level, advanced analysis type, and time by
clicking on the column headers.

You can acknowledge and delete messages using the Message menu. To
acknowledge or delete an individual message in a right-section message view,
position the cursor over the message type, right-click to open the menu, and then
select from the menu items listed in Table 2–15.

CAUTION. You cannot undo the commands in the Message menu. Acknowledged
messages cannot be reset, and deleted messages or configurations cannot be
recovered.

Table 2–15: Report view Message menu 

Menu selection Function

Acknowledge selected
message

Acknowledges the selected Report view error message. A checkmark
precedes all acknowledged messages.

Acknowledge all
messages

Acknowledges all of the Report view error messages for the selected
configuration. Acknowledging all messages is equivalent to resetting
past errors; the hierarchic icon becomes green (at least momentarily)
as if no messages had been generated. A checkmark precedes all
acknowledged messages.

Delete acknowledged
messages

Deletes all acknowledged error messages from the selected
configuration. Error messages that have not been acknowledged will
not be deleted.

Delete all messages Deletes all error messages (acknowledged or not) for the selected
configuration.

Each message can represent many individual events. When the RTA is set to log
messages to the Windows NT Event Viewer (as it is in the standard configura-
tion), you can double-click on a Type entry (for example, “Error detected”) to
open an Event viewer messages window that lists all events represented by the
particular message.

Sorting Messages

Acknowledging and
Deleting Messages

Viewing Message Events
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To print some or all of the data for a Report view Configuration, select the
Configuration icon and then select Print  from the View menu or press CTRL+P to
open the Print  window (shown below).

The Print window lists all the items you can print from the selected Configura-
tion. All items preceded by a check mark will be printed when you click OK .
Click on a Print window item to select or deselect the item for printing.

NOTE. A full report printout can be quite lengthy, depending on the complexity of
the input stream, the duration of the analysis, and the number of events and
errors encountered.

To print only the messages for one program, a single ETR 290 level, one
advanced analysis type, or the “other” category, select the corresponding report
hierarchy icon so the messages are displayed in the right report view section.
Then select Print  from the View menu (or press CTRL+P).

The RTA can also create additional Message views that are specific to a given
stream item. To open a stream item Message view in the Client view, either
double-click on the Hierarchic view icon or select View Report from the icon
shortcut menu (refer to Hierarchic Icon Shortcut Menus on page 2–19).

Printing Reports
and Messages

Specific Message Views
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The RTA can save message details in the Windows NT Event Viewer Applica-
tion log. This gives you the opportunity to save a permanent record of RTA
events, which would otherwise be lost when you pause window updates (Freeze
views in the View menu) or exit the application.

Turn Event Viewer logging on or off through the Settings command on the RTA
configuration menu; the Event viewer selection is on the Report View panel of
the resulting Settings window (refer to View:Report on page 3–78).

When you open an Event viewer messages window from within a Message
view, you are accessing the Event Viewer Application log. To access the log
directly, perform the following steps:

1. Start the Event Viewer application through the Windows NT Start menu by
selecting Programs, Administrative Tools (Common), and Event Viewer.

2. When the Event Viewer window opens, select Application  from the Log
menu.

The Application Log can contain hundreds of entries; use the vertical scroll bar
and arrows to see entries that will not fit in the window. If the RTA is running,
press F5 occasionally to refresh the view. To open an Event Detail window,
double-click on a log entry.

Messages and the
Event Viewer
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You can save the current contents of the Application Log to a file for later use,
you can clear the log to make room for more entries, you can change the log size,
and you can specify how the Event Viewer acts when the log is full. Refer to the
Windows NT documentation (or the Event Viewer online help) for more
information.

NOTE. For best results, do not select any Event Viewer log wrapping setting
other than Overwrite Events as Needed. The RTA may freeze if the application
event log fills to capacity during stream analysis. Choose Log Settings from the
Log menu of the Event Viewer to verify the current log wrapping option and to
change the size of the application event log, if necessary.
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Using the Client View

The Client view occupies the upper-right portion of the default RTA application
window (see Figure 2–1 on page 2–2). The Client view can display several
different views representing various aspects of the application’s analysis of the
input stream.

Listed below are the starting page numbers for descriptions of the various views
available in the Client view.

� Client view features and conventions page 2–40

� Statistic view page 2–42

� ETR 290 view page 2–53

� Section analysis view page 2–56

� Section rate view page 2–58

� PTS/DTS analysis view page 2–59

� PCR analysis view page 2–61

� MIP packet analysis view (DVB-T only) page 2–63

� IP (Internet Protocol) monitoring view
(SIDAT 360 only) page 2–65

From the Hierarchic view you can also open stream-component specific Message
views in the Client view. For more information refer to Using the Report View on
page 2–23.
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Client View Features and Conventions
By default, the Client view displays the Statistic view whenever you start RTA
analysis. The Statistic view contains several panels, which display data about the
input stream and the programs carried in the stream. Refer to Statistic View on
page 2–42 for more information. The Client view can contain numerous other
analysis panels that you can access through the Hierarchic view icons. Refer to
Using the Hierarchic View on page 2–11.

Normally, the individual Client views are maximized. That means that each view
occupies the entire Client view. If more than one view is open at a time in the
Client view, you can switch among them by clicking the appropriate Client view
tab (see illustration on page 2–41).

The Client view control buttons appear at the right end of the RTA Menu bar
when the Client views are maximized (see illustration on page 2–41).

� Click the Minimize button ( ) to reduce the top Client view to an icon
within the Client view and change all other Client views to windows or icons
within the Client view, depending on their previous size. Each window and
icon has its own sizing buttons; the sizing buttons disappear from the menu
bar.

� Click the Restore button ( ) to reduce all Client views to windows or icons
within the Client window, depending on their previous status, if any. The
sizing buttons disappear from the menu bar because each icon and window
has its own sizing buttons.

� Click the Close button ( ) to close the top (currently selected) view.

NOTE. Closing a view clears all existing information. Unless you are logging
messages to the Event Viewer, all information in a Client view is lost when you
close the view.

To simultaneously maximize the Statistic view and close other Client views,
click the Restore standard views toolbar button (refer to Toolbar on page 2–8
for more toolbar information).

Client View Control
Buttons
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Client view panel tabs Statistic view panel tabs

RTA window
control buttons
Client view
control buttons

The Client view uses the same colors for error indicators as the rest of the RTA.

� Gray signifies that no test is currently running.

A test is not performed for one of three reasons: the user probe is not set, the
test is disabled through the RTA Configuration menu, or the input stream
does not contain the applicable table. (MPEG-2 streams, for example, do not
contain SI tables; therefore, tests 3.2 through 3.8 cannot be performed on
non-DVB streams.)

� Green signifies that a probe is set and that the rate has remained within the
user-specified limits.

� Red signifies that an error is occurring.

� Orange signifies that the monitored parameter is currently within the user-set
limits but that an error has occurred since monitoring began.

Error Indicators
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Statistic View
The Statistic view is a collection of different tabbed panels that display data
about the input stream and the programs carried in the stream. One Statistic view
panel is displayed at a time.

This section describes the following Statistic view panels; the descriptions begin
on the indicated page:

� Statistic view features and conventions page 2–42

� Program Allocation panel page 2–43

� PID Allocation panel page 2–46

� Continuity Counter panel page 2–50

� Type Allocation panel page 2–51

� TP (Transport Packet) Error Indicator panel page 2–52

� Unsynchronized Packets panel page 2–52

By default, the Program Allocation panel of the Statistic view appears in the
Client view after you begin analysis on the input stream. You can view a
different panel by clicking on the corresponding tab on the bottom of the
Statistic view panel (see illustration on page 2–41).

When the Statistic view first opens, most panel tabs are hidden by the horizontal
scroll bar. You can click the scroll arrows to reveal the remaining tabs, or you
can click the thin split box and drag to the right to shorten the scroll bar.

Scroll arrows Split box

Statistic View Features
and Conventions
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The Program Allocation panel (see Figure 2–10) shows the bandwidth allocation
of individual items in the input multiplex using a graphical pie chart. The yellow
slice of the pie chart represents PSI/SI information; each remaining colored slice
represents a program, null packets, or unreferenced (ghost) packets. The
accompanying color-coded list of programs (matches the pie-chart colors)
provides a numeric report of bandwidth usage. A graphic bar displaying the
current or average transport rate for each program or service in the multiplex is
displayed on the right.

You can double-click on a slice of the pie chart to switch to the PID Allocation
panel (see Figure 2–11 on page 2–47) with the corresponding program or service
already selected.

The Reused rate is the rate of shared items (that is, PIDs shared between
programs).

The Used rate is the transmission rate less the Null Packet rate.

Service or
program name

Portion of the input
stream used by the
service or program

Current or average
transport rate of the
service or program

Minimum transport rate
(Current Rate display

mode only)

Maximum transport rate
(Current Rate display

mode only)

Display current or
average rate button

Figure 2–10: Program Allocation panel (current rate mode)

Program Allocation Panel
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Current Rate and Average Rate Display Modes. You can set the Program Alloca-
tion and PID Allocation panels to display current or average transport rates for
the current configuration.

� Select Display current rate to display current transport rates. In this mode
the minimum and maximum transport rates for the current configuration are
displayed as well as the current transport rate. Current Rate is displayed on
both the Program Allocation and PID Allocation panels when this mode is
selected.

� Select Display average rate to display average transport rates. In this mode
the transport rates for the current configuration are averaged and only the
average rates are displayed. Average Rate is displayed on both the Program
Allocation and PID Allocation panels when this mode is selected.

Setting Transport Rate Error Limits. You can set user-defined upper and/or lower
transport rate error limits for individual stream items so the RTA can alert you
when the transport rate is outside of the desired range. To set user-defined
transport rate error limits, perform the following steps:

1. Right-click in the horizontal region corresponding to a program or service
(as shown below) to open a Rate Interval dialog box for the selected program
or service.

Right-click within the area
bounded by the dashed
lines to set error limits
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2. In the resulting dialog box (shown below), select Low limit check and/or
High limit check, and then enter the desired error limit value or values.

3. Click OK  to accept the error limits and close the dialog box.

Setting new limit values can change the appearance of the graphic bar display
(shown below). When you have set limits inside the range of minimal and/or
maximal rates, the graphic bar displays the standard RTA colors to indicate error
conditions. Refer to Error Indicators on page 2–41 for more information.

The following conventions apply to the Program Allocation panel transport rate
display:

� The RTA shows the current rate in red when it violates either limit.

� When a limit has been violated, the region of the bar between the limit and
the actual min or max value becomes red; when the rate returns to the
preferred range, the region becomes orange.
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The PID Allocation panel (see Figure 2–11) gives a more detailed, program-level
view of input stream bandwidth allocation. Instantaneous, previous maximum,
and previous minimum multiplex rates are shown by PID for the selected
program. Each PID icon corresponds to the stream item type as it does in the
Hierarchic view.

You can select a program to view in the PID Allocation panel using one of the
following methods:

� Double-click the program slice in the Program Allocation panel to open the
PID Allocation panel for that program.

� Click the corresponding program button in the PID Allocation panel.

Additionally, you can view selected PIDs by clicking the Selection button in the
PID Allocation panel to display the PIDs you referenced using the PID Alloca-
tion View panel of the Settings window (refer to View:PID Allocation on
page 3–85 for more information).

NOTE. When you click the Selection button in the PID Allocation panel, the PIDs
referenced on the PID Allocation View panel of the Settings window are
displayed. You can add and remove PIDs directly from the PID Allocation panel
by performing a drag-and-drop action on stream icons between the Hierarchic
view and the PID Allocation panel in the Client view. Doing so will automatical-
ly update the PID Allocation View panel of the Settings window.

Each program button has a round error indicator “light” that shows the status of
any transport rate probe that is set. Click Reset past errors to reset previously
detected transport rate errors. Refer to Transport Rate on page 3–2 for complete
information.

The banner over the displayed PIDs in the PID Allocation panel contains
information about the selected program or service. In the panel shown on the
following page, PSI/SI has an instantaneous transport rate of 0.084 Mbits/s and
the rate has been between 0.075 and 0.096 Mbits/s for the current configuration.

The area below the banner lists each PID in the program or service and, with
graphics and text, reveals additional information about the stream item identified
with that PID. If the program or service contains more than a few PIDs, you may
have to use the vertical scroll bar to view the information for every PID.

NOTE. You can sort the PID Allocation display by clicking on the Type, PID,
Percent, or Rate column headers.

PID Allocation Panel
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Display current or
average rate button

Click a button to select
a service or program

Error indicators

Click on the Type, PID,
Percent, or Rate column

headers to sort the display
Current or average

transport rate of the PID

Minimum transport rate
(Current Rate display

mode only)

Maximum transport rate
(Current Rate display

mode only)

Portion of the input
stream used by the PID

Figure 2–11: PID Allocation panel (current rate mode)

Current Rate and Average Rate Display Modes. You can set the Program Alloca-
tion and PID Allocation panels to display current or average transport rates for
the current configuration.

� Select Display current rate to display current transport rates. In this mode
the minimum and maximum transport rates for the current configuration are
displayed as well as the current transport rate. Current Rate is displayed on
both the Program Allocation and PID Allocation panels when this mode is
selected.

� Select Display average rate to display average transport rates. In this mode
the transport rates for the current configuration are averaged and only the
average rates are displayed. Average Rate is displayed on both the Program
Allocation and PID Allocation panels when this mode is selected.
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Setting Transport Rate Error Limits. You can set user-defined upper and/or lower
transport rate error limits for individual stream PIDs so the RTA can alert you
when the transport rate is outside of the desired range. To set user-defined
transport rate error limits, perform the following steps:

1. Right-click in the horizontal region corresponding to a program or service
(as shown below) to open a Rate Interval dialog box for the selected PID.

Right-click within the area
bounded by the dashed
lines to set error limits

2. In the resulting dialog box (shown below), select Low limit check and/or
High limit check, and then enter the desired error limit value or values.

3. Click OK  to accept the error limits and close the dialog box.
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Setting new limit values can change the appearance of the graphic bar display
(shown below). When you have set limits inside the range of minimal and/or
maximal rates, the graphic bar displays the standard RTA colors to indicate error
conditions. The round error indicators in the program selection buttons match the
error condition displayed in the graphic bar display. Refer to Error Indicators on
page 2–41 for more information.

Low rate error limit

Number of
low-limit errors

Number of
high-limit errors

High rate error limit

The number of low-limit errors detected (in this case, 1) appears immediately
below the left end of the rate bar while the number of high-limit errors appears
below the right end.

The following conventions apply to the PID Allocation panel transport rate
display:

� The RTA shows the current rate in red when it violates either limit.

� When a limit has been violated, the region of the bar between the limit and
the actual min or max value becomes red; when the rate returns to the
preferred range, the region becomes orange.

� The number of (low- or high-limit) errors reported is the number of 500 ms
samples in which the actual transport rate has been below or above the
specified limits.
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The Continuity Counter panel (see Figure 2–12) shows the results of continuity
counter monitoring (per the DVB measurement guidelines, ETR 290) for each
PID in the selected program or service. The data are displayed PID-by-PID,
similar to the PID Allocation view. If a continuity error is detected, a message is
sent to the report view. The Transport Syntactic Analysis Settings panel controls
which PID are shown in this view. Refer to Analysis:Advanced: Syntax:Trans-
port on page 3–59 for more information.

Figure 2–12: Continuity Counter panel

Select a program by clicking the corresponding button on the left edge of the
panel. Each program button has a round error indicator light that shows the
presence or absence of continuity counter errors in that program; the right
portion of the panel shows the error status of each individual PID in the program.
The error indicators display the standard RTA colors to indicate error conditions.
Refer to Error Indicators on page 2–41 for more information.

Click Reset past errors (in the upper-left corner of window) to reset all
previously-detected continuity counter errors (all orange or red error indicators
become green).

Continuity Counter Panel
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The Type Allocation panel (see Figure 2–13) shows the bandwidth allocation of
each PID type in a pie-chart display. Each slice of the pie chart represents a PID
type (such as audio, video, or data).

The accompanying color-coded list of PIDs (matches the pie-chart colors)
provides a numeric report of bandwidth usage. A graphic bar displaying the
current transport rate for each PID in the multiplex is displayed on the right.

List of PID
types

Portion of the input
stream used by the
service or program

Current transport
rate of the PID

Minimum transport rate Maximum transport rate

Number of PIDs

Figure 2–13: Type Allocation panel

Type Allocation Panel
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The TP Error Indicator panel (see Figure 2–14) reports the results of transport
error indicator (TEI) monitoring per ETR 290. The Transport Syntactic Analysis
Settings panel controls this view. Refer to Analysis:Advanced: Syntax:Transport
on page 3–59 for more information. You must set the transport error indicator
probe in the Settings panel to perform TEI monitoring. When the probe is set,
the RTA checks the transport_error_indicator field of every transport packet
header and counts the number of packets with this bit-field set to 1 every
500 ms. The TP Error Indicator panel displays the last 150 seconds of the results
in graphical form.

The horizontal (time) scale of the graph is linear. The vertical (errors/500 ms)
scale is logarithmic to show both very low and very high error rates.

The TEI indicator in the status bar follows the same RTA color conventions for
error reporting. Refer to Error Indicators on page 2–41 for more information.

Figure 2–14: TP (Transport Packet) Error Indicator panel

The Unsynchronized Packets panel display is identical to the above TP Error
Indicator panel display except for the graph title. The Unsynchronized Packets
panel reports the results of sync byte monitoring per ETR 290 recommendations.
You must set the unsynchronized packet probe through the Multiplex Analysis
Settings panel to perform sync byte monitoring. Refer to Analysis:Ad-
vanced:Multiplex Panel on page 3–55 for more information.

When the unsynchronized packet probe is set, the RTA checks the sync_byte
field of every transport packet header and counts the number of packets with
sync_byte other than 0x47 every 500 ms. The number of those packets are
plotted on a graph with a logarithmic vertical scale to display both very low and
very high rates of error. The vertical units are UNP per 500 ms.

The UNP indicator in the status bar follows the same RTA color conventions for
error reporting. Refer to Error Indicators on page 2–41 for more information.

TP (Transport Packet)
Error Indicator Panel

Unsynchronized Packets
Panel
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ETR 290 View
There are two ETR 290 views: Detailed (see Figure 2–15) and Monitor. The
ETR 290 views provide an at-a-glance report of all ETR 2901 recommended tests
performed by the RTA.

To open an ETR 290 view, point to ETR 290 view on the RTA View menu and
then click either Detailed or Monitor . You can also click the ETR 290 view
toolbar button to quickly open the ETR 290 Monitor view (refer to Toolbar on
page 2–8 for more toolbar information).

Figure 2–15: ETR 290 detailed view (DVB mode)

The status bar includes indicators (LV1, VL2, and LV3) to indicate the status of
ETR 290 errors. Refer to Status Bar on page 2–9 for more information.

NOTE. ETR 290 level 3 deals with checking DVB-SI tables. In ATSC mode these
checks do not apply except for 3.4 Unreferenced_PID. Therefore, the RTA uses
six tests specific to ATSC/PSIP tables based on the model of ETR 290. As a
consequence, the ETR 290 views change dynamically with the analysis mode.

1 ETR 290 is the DVB consortium working group that is responsible for recommending measurements and controls to be
performed on all the elements of a digital television chain. Refer to Appendix A: ETR 290 Measurements for additional
information about the ETR 290 recommendations and tests.
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In both ETR 290 views, test numbers are those used in the DVB measurement
guidelines, ETR 290, except for the level 3 checks which apply only to the DVB
mode. In MPEG-2 mode, the level 3 column does not appear and in ATSC mode
the column is customized for that mode. Colored indicator lights show the status
of each test. The error indicators follow the standard RTA color conventions for
error reporting. Refer to Error Indicators on page 2–41 for more information.

In both ETR 290 views, you can double-click on an error indicator to open a
Message view in the Client view that displays the error messages pertaining to
that particular ETR 290 error condition.

In the ETR 290 Detailed view (see Figure 2–15 on page 2–53), three columns
list the tests defined in the ETR 290 recommendations by name and reveal
additional information about test thresholds and affected stream items. The level
3 column contains different information when the analysis mode is set to ATSC
and the column does not appear when the analysis mode is set to MPEG-2.

Tests 1.3.1, 1.5.1, 3.1.2, 3.5.1, 3.6.1, and 3.8.1 use error criteria that can be
changed on the Section Rate Analysis panel of the Settings window. Refer to
Analysis:Advanced:Rate:Section Panel on page 3–74 for more information. The
user-defined values set in the Section Rate Analysis panel are displayed in gray
on the ETR 290 Detailed view as shown below.

Maximum NIT section interval
(ETR 290 3.1.2 error threshold)

Maximum SDT section interval
(ETR 290 3.5.1 error threshold)

ETR 290 Detailed View
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Tests 2.3, 2.4, and 2.5 (PCR and PTS/DTS probes) are performed only on
user-selected PMTs and elementary streams. The ETR 290 detailed view shows
how many of the PMTs and elementary streams (ES) in the input stream have
been selected for monitoring as shown below.

Monitored PMTs/total
PMTs in stream

Monitored ES/total
ESs in stream

Click Reset Past Errors, at the bottom of the ETR 290 Priority 1 column, to
reset all previously detected ETR 290 errors (all orange and red error indicators
become green).

The ETR 290 Monitor view (shown below) is a simplified version of the
ETR 290 Detailed view. This view is useful when you have reduced all Client
views to windows because it leaves the greatest possible Client view area free for
other views. Click the magnifying glass icon at the bottom of the ETR 290
Monitor view to open an ETR 290 Detailed view.

As in the detailed ETR 290 view, double-clicking an error indicator opens a
Message view in the Client view that contains messages pertaining to the error.

ETR 290 Monitor View
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Section Analysis View
The Section Analysis view (shown below) provides both a hierarchic and
field-by-field view of the selected table section.

In the Section Analysis view hierarchy, related fields are grouped and shown as
folders and other icons. With some table types you can expand and collapse the
hierarchy as you would a Windows NT Explorer directory hierarchy. Click a
hierarchy icon to show the contents of the represented item in the right sub-view
as shown below. You can also double-click the same folder icon in the right
sub-view to show the same information.

Click the Close Folder button () to close an open folder in the hierarchy.

To open a section analysis view, select View Section Analysis from the shortcut
menu of the Hierarchic view icon that represents the table you are interested in.
Refer to Hierarchic Icon Shortcut Menus on page 2–19 for more information.

Opening a Section
Analysis View
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If you select View Section Analysis for an NIT, SDT, or EIT, a dialog box opens
to permit further selection of table sections. For example, the Select EIT Other
Present/Following list identifies the sections by their original network ID
(Onid), transport stream ID (TSid), Service ID, and Table ID. SDT sections are
identified by the Onid and TSid. You can reorder either list by any one of the IDs
by clicking the desired column header as shown below.

Highlight the desired sub-table and click View Section.

When more than one section of the selected sub-table exists, use the section
selection buttons to scroll among the sections.

Section selection buttons

Although the normal numeric display is hexadecimal, it may be convenient in
some instances to see the decimal value of one or more fields. Press the F2
function key to toggle between decimal and hexadecimal display.

Scrolling Among
Sub-table Sections

Changing Numeric
Display
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You can print a record of the current Section Analysis view by clicking inside the
view to select the view, and then choosing Print  from the View menu (or
pressing CTRL+P).

NOTE. Before printing a view, check the RTA title bar to confirm that the desired
view is selected.

Section Rate View
The Section Rate view (shown below) contains graphs that show the section rate
and time interval between sections of the selected table. To open a Section Rate
view of a table, select the corresponding Hierarchic view icon, right-click to
open the shortcut menu, and then click View Section Rate.

The lower Sub-Table Max Interval graph displays interval errors in red when a
maximum section interval probe is set for the particular table type (refer Section
Rate Analysis on page 3–37 for more information).

Printing a Section
Analysis View
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All scales on the rate and interval graphs are linear and by default the RTA
auto-scales the vertical scale on the graphs. To change the vertical scale on a
graph, clear the corresponding Auto-scale box and select an appropriate scale
increment from the drop-down list box. The Section Rate vertical scale ranges
from zero to four times the selected scale increment; the Sub-Table Max Interval
scale ranges from zero to approximately three times the scale increment. Both
vertical scales begin at zero regardless of the scale setting.

The two right section-analysis graphs are histograms, which show the relative
frequency of section rates and intervals. By default, the histogram readout lists
the maximum rate or interval measured. If you position the cursor within a
histogram, the cursor shape changes to resemble cross hairs and the histogram
readout changes to display the rate or interval value at the cursor position.

PTS/DTS Analysis View
The PTS/DTS Analysis view (shown below) graphs the interval between
consecutive time stamps in the selected video or audio elementary stream. The
minimum and maximum intervals between any two of the last 300 time stamps
are also shown.

Setting Graph Scales

Histogram Readout
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To open a PTS/DTS Analysis view of a video or audio elementary stream, select
the corresponding Hierarchic view icon, right-click to open the shortcut menu,
and then click View PTS/DTS Analysis. In the resulting PTS/DTS probe...
dialog box, you can enter a user-defined maximum PTS/DTS interval. Click OK
to set the probe and open the PTS/DTS Analysis view.

NOTE. The PTS/DTS Interval setting determines the threshold for errors
reported on the ETR 290 view. The default setting is consistent with ETR 290
recommendations. Do not change this setting if you plan to use ETR 290 tests to
judge DVB compliance of the input stream.

The RTA cannot open a PTS/DTS Analysis view for a scrambled elementary
stream. Therefore, the View PTS/DTS Analysis menu choice is unavailable when
the lock symbol appears on the stream icon.

Opening a PTS/DTS Analysis view automatically selects the PTS/DTS Probe
menu item as well, activating the probe for the selected elementary stream only.
The PTS/DTS interval graph does not update unless the PTS/DTS probe is active
for the given elementary stream.

The scales on the PTS/DTS Analysis view graphs are linear and by default the
RTA auto-scales the vertical scale on the graphs. To change the vertical scale on
a graph, clear the corresponding Auto-scale box and select an appropriate scale
increment from the drop-down list box. The PTS/DTS Interval vertical scale
ranges from zero to approximately three times the scale increment. The vertical
scale begin at zero regardless of the scale setting.

The right graph is a histogram, which shows the relative frequency of PTS/DTS
intervals. By default, the histogram readout lists the maximum interval mea-
sured. If you position the cursor within the histogram, the cursor shape changes
to resemble cross hairs and the histogram readout changes to display the interval
value at the cursor position.

Opening a PTS/DTS
Analysis View

Setting Graph Scales

Histogram Readout
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PCR Analysis View
The PCR Analysis view (shown below) is a graphical display of PCR precision
and frequency. The upper graph plots your selection of either the Jitter ,
Frequency offset, or Drift rate  of each clock reference of the selected program,
while the lower graph plots the interval between consecutive references used by
the program. Each graph contains numeric readouts of the minimum and
maximum values measured in the last 300 clock references. The graphs on the
right are histograms, which show the relative frequency of the PCR data in the
graphs on the left.

Red colored portions of the graphs and red Min or Max readouts indicate that the
data exceeds the PCR error limits. The default interval error limit is 100 ms in
MPEG-2 mode and 40 ms in DVB mode. Any interval between consecutive
clock references that exceeds these values is reported as an error. The default
precision error limit is +/– 500 ns for both modes. You can view or change PCR
error limits using the PCR Timing Analysis panel of the Settings window. Refer
to Analysis:Advanced:Timing:PCR Panel on page 3–65 for more information.

The RTA uses an internal Settling Filter to improve the accuracy of PCR jitter
analysis. The Settling Filter must have at least 60 seconds of data before the RTA
can detect and report PCR jitter errors. When you first set a PCR probe and open
a PCR Analysis view, a message appears in the upper histogram displaying how
many seconds remain before the settling filter completes its operation.

Settling Filter
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To open a PCR Analysis view, select the appropriate Hierarchic view PMT icon,
right-click to open the shortcut menu, and then click View PCR Analysis. In the
resulting PCR probe... dialog box (shown below), you can enter user-defined
maximum PCR interval and PCR jitter limits. Click OK  to set the probe and
open the PCR Analysis view.

NOTE. The PCR interval and PCR jitter settings determine the thresholds for
errors reported on the ETR 290 view. The default settings are consistent with
ETR 290 recommendations. Do not change these settings if you plan to use
ETR 290 tests to judge DVB compliance of the input stream.

Selecting View PCR Analysis automatically selects the PCR Probe menu item
as well. The PCR Analysis view graphs do not update unless the PCR probe is
active for the given program.

The scales on the PCR Analysis view graphs are linear and by default the RTA
auto-scales the vertical scale on the graphs. To change the vertical scale on a
graph, clear the corresponding Auto-scale box and select an appropriate scale
increment from the drop-down list box. The range of the Precision graph is
approximately twice the selected increment; the range of the Interval graph is
from zero to approximately three times the selected interval.

The graphs on the right are histograms, which show the relative frequency of the
PCR data in the graphs on the left. By default, the histogram readout lists the
maximum measured result. If you position the cursor within the histogram, the
cursor shape changes to resemble cross hairs and the histogram readout changes
to display the interval value at the cursor position. The histogram scales range
from zero to approximately four times the selected increment.

Opening a PCR Analysis
View

Setting Graph Scales

Histogram Readout
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RTA hardware considerations limit the accuracy of PCR analysis. Table 2–16
summarizes the accuracy possible for jitter parameters displayed in the PCR
Analysis view.

Table 2–16: PCR analysis accuracy 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Description

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Frequency Offset readout ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Accuracy
Drift, typical

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�3.0 ppm
�1 ppm per year

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Jitter readout and graphical display accuracy, typicalÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Parallel input
ASI input

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�30 ns peak
�60 ns peak

MIP Packet Analysis View (DVB-T only)
The MIP Packet Analysis view (shown below) provides both a hierarchic and a
field-by-field view of the selected MIP.

Advanced

PCR Analysis Accuracy
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In the MIP Packet Analysis view hierarchy, related fields are grouped and shown
as folders and other icons. With some table types you can expand and collapse
the hierarchy as you would a Windows NT Explorer directory hierarchy. Click a
hierarchy icon to show the contents of the represented item in the right sub-view
as shown below. You can also double-click the same folder icon in the right
sub-view to show the same information.

Click the Close Folder button () to close an open folder in the hierarchy.

There is also a control that displays the emitted Mega Frame size (between
brackets) and the measured Mega Frame size, side by side. If the measured Mega
Frame size differs from the emitted size, it means that an error occurred between
the emission point and the reception point.

To open an MIP Packet Analysis view, select the appropriate Hierarchic view
MIP icon, right-click to open the shortcut menu, and then click View MIP
Packet Analysis.

NOTE. Before the RTA can recognize an MIP, DVB-T must be selected in the
Analysis panel of the Settings window. Refer to Analysis Panel on page 3–50 for
more information.

On the bottom-left side of the view there are bar graphs, which report the
measurements of the intervals between MIPs and synchronization time-stamps.
You can control these measurements by adding user-defined intervals. You can
set user-defined intervals using one of the following two methods:

� Right-click on the desired bar graph to open either an MIP interval or a STS
interval dialog box.

� Use the Mega Frame Timing Analysis panel to set the STS interval (refer to
Analysis:Advanced:Timing:Mega Frame Panel on page 3–71) or use the
Mega Frame Rate Analysis panel to set the MIP interval (refer to Analy-
sis:Advanced:Rate:Mega Frame Panel on page 3–76).

On the bottom-right side of the view there are bar graphs that display the current
values of the transmitter functions. These bar graphs appear only when the
corresponding transmitter is selected. You can control these measurements by
adding user-defined intervals. You can set user-defined intervals for the
transmitters using one of the following two methods:

� Right-click on the desired bar graph to open either an interval dialog box.

� Use the Mega Frame Syntactic Analysis panel to set the interval (refer to
Analysis:Advanced:Syntax:Mega Frame Panel on page 3–63).

Opening an MIP Packet
Analysis View

Setting User-Defined
Intervals



Using the Client View

MTS 200 Series Real-Time Analyzer User Manual 2–65

IP (Internet Protocol) Monitoring View (SIDAT 360 only)
Depending on the type of protocol in use, the RTA can monitor the data transfer
between two Internet or MAC addresses. This is done only on Multiprotocol
Encapsulation sections, which are the only sections in which IP headers can be
detected and read properly.

If the probed stream contains multiprotocol encapsulated datagrams, an
interpretation of the IP (and TCP/UDP if present) headers is displayed, along
with the sender and receiver addresses, and the total amount of data exchanged
on that session. The RTA assumes that packets which have the same IP
source/destination couple and the same TCP/UDP ports belong to the same
session. A session line may disappear from the view when no corresponding
packets are sent for a certain period of time (40 seconds usually).

To open an IP Monitoring view (shown below), select the appropriate Hierarchic
view DSM-CC icon, right-click to open the shortcut menu, and then click IP
Monitoring . You must set a probe on one of the DSM-CC streams through the
Hierarchic view or through the Settings window before you can open this view.

NOTE. Before the RTA can recognize a multiprotocol encapsulation section,
SIDAT 360 data broadcasting analysis must be selected in the Analysis panel of
the Settings window. Refer to Analysis Panel on page 3–50 for more information.

NOTE. There is only one IP Monitoring view for the RTA application. Therefore,
if you add a probe on another stream, the results will be added to the same view.

IP monitoring can be tremendously bandwidth- and CPU-consuming. The
section rate of such streams is usually very high.

Opening an MIP Packet
Analysis View
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RTA Operating Tutorials

This section contains four step-by-step tutorials intended to introduce you to
RTA capabilities, features, and techniques. Refer to Operating Basics starting on
page 2–1 for detailed information about operating the RTA application.

Perform each tutorial with your own input stream and then spend some time
experimenting with the various configuration and analysis options. Consult the
Reference section of this manual if you need more information on any topic. If
you have an MTS 215, be sure to capture a portion of the stream and then
examine it more closely with the deferred-time analyzer. Doing so will enable
you to get the most out of your Tektronix MPEG Test System. The tutorials
begin on the following pages:

� Monitoring an input stream page 2–68

� Using the Hierarchic window page 2–70

� Using the Statistic view page 2–75

� Using the ETR 290 view page 2–79

� Setting probes page 2–86

� Capturing input streams (MTS 215 only) page 2–96

All of the tutorials assume that you have connected an input to the rear panel of
the instrument and started the Tektronix MPEG Test System (refer to Getting
Started on page 1–1 for instructions).

NOTE. If you are not familiar with the Windows 95 or Windows NT 4.0 operating
systems, review the Windows NT documentation that accompanied your MTS 200
Series test system.

Preliminary Setup
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Monitoring an Input Stream
Perform the following steps to have the RTA monitor your input stream:

1. Start the RTA application using one of the following two methods:

� Select Real-Time Analyzer from the Windows NT Start menu

� Double-click the Real-Time Analyzer icon (shown below) in the
Tektronix MPEG Test System window

2. From the Menu bar in the RTA application window, open the Configuration
menu and select Restore Standard.

3. Click OK  in the resulting RTA  dialog box to restore the default Configura-
tion settings.

4. From the Menu bar, open the Configuration menu and select Settings.

5. Select Hardware in the Settings window hierarchy display to reveal the
Hardware panel (shown below).

6. Select the appropriate input type to match the type of your stream.

7. Select Analysis in the Settings window hierarchy display to reveal the
Analysis panel (shown below).
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8. Select the appropriate analysis type to match the type of your stream.

9. Click OK  on the bottom of the Settings window to confirm your changes
and close the window.

NOTE. If you have selected ASI input or changed the Analysis mode, you may
find it convenient to save the current configuration for later recall. Then, to
return to a base configuration, you can load the saved setup instead of restoring
the standard configuration, which uses the parallel input and MPEG-2 mode.
Refer to Saving and Restoring Configurations on page 3–43 for more informa-
tion.

10. Start the RTA analysis using one of the following two methods:

� From the menu bar, open the Analysis menu and select Start

� Click the Start analysis toolbar button

Figure 2–16 illustrates the RTA display during the analysis of a stream.

Hierarchic view

Client view

Report view

Figure 2–16: Example of RTA display
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When you start the RTA analysis, the RTA hardware (known also as the PIA
board) is initialized and analysis begins. The animated train icon at the far right
of the toolbar indicates that an analysis is in progress (refer to Toolbar on
page 2–8).

The default RTA display resembles Figure 2–16. Icons that represent stream
items appear in the Hierarchic window. The colored rectangle above each icon is
an error indicator. Refer to Icon Error Indicators on page 2–14 for more
information.

Refer to Using the Hierarchic View on page 2–11 for more information.

The Program Allocation panel of the Statistic view appears in the Client window
pane. The panel uses a pie chart and table to show how the services (PSI/SI/
PSIP, programs, and null packets) use the available input bandwidth. A complete
discussion of the Statistic view begins on page 2–42.

You can access all information gathered about the input stream through the
Report view, which in the standard configuration occupies the bottom portion of
the application window. Refer to Using the Report View on page 2–23 for more
information.

The preceding steps are sufficient to begin monitoring an input stream. Continue
with this tutorial to learn more about using the RTA.

Using the Hierarchic View
The following procedure will acquaint you with features of the Hierarchic view.

1. Press F8 (on the keyboard) and notice what happens to the Hierarchic view.
You can also click on and drag the borders between window panes to enlarge
the Hierarchic view.

2. Press F9 and F10 in succession while paying attention to the Hierarchic view.
At each step, another level of the input multiplex hierarchy is revealed.

Press the F8 function key to show
the second hierarchy level.

Press the F10 function key to reveal
all levels and items in the hierarchy.
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3. Find the PAT icon near the top of the hierarchy (shown below). You may
have to use the vertical scroll bar to see the top of the hierarchy. Double-
click on the icon, and a PAT Message view opens in the Client view.

The PAT Message view contains information and error messages that apply
only to the PAT. If your input stream is reasonably compliant with the
analysis mode, there may be only one initial PAT: Update message, as shown
below.

4. Double-click the PAT: Update message. A Detail of message window opens
to display information that has been logged to the Windows NT Event
Viewer application log.

5. Click OK to close the Detail of Message window.
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6. Click the Client view Close box to close the PAT Message view. When you
click the Client view Close box, the selected view within the Client view is
closed. The Close box is at the right end of the RTA menu bar, immediately
below the RTA application window size boxes. Do not click the application
close box; doing so will exit the RTA application.

Don’t click here
Click here

7. Select the PAT icon in the Hierarchic view. Right-click on the selected icon
to open the PAT shortcut menu.
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8. Select View Section Analysis from the PAT menu to open a PAT section
analysis view in the Client view. Notice that the section analysis view has
two sub-views. The left sub-view contains a hierarchical representation of
the table section. The right sub-view shows the contents of the currently
selected left sub-view folder.

The first eleven items in the right sub-view are preceded by a round
indicator. The indicator identifies an item as a table section field; it is green
when the field contents are correct and is red if the field contents do not
comply with the applicable standards (MPEG-2, DVB, or ATSC, depending
on the analysis mode).

9. Press F2 and notice that the numbers in the Value column (in the right
sub-view) change to decimal base. Press F2 again to toggle the numbers back
to hexadecimal base.

10. Click on the gray vertical bar that divides the two sub-views; then drag the
bar to the right to reveal all program numbers in the left sub-view.

11. Drag the vertical scroll box down, if necessary, to see the remainder of the
right sub-view. Notice that each second-level folder in the left sub-view has a
corresponding folder item in the right sub-view. Each folder icon is green if
no errors are detected in the represented item; otherwise, the icon is red.
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12. Click on one of the “program number 0x...” folder icons in the left sub-view.
The right sub-view changes to show the PAT section fields that assign a PID
to the the NIT (program number 0x0) or to a particular program in the
stream.

Note that in several DVB-SI and ATSC-PSIP tables, the left sub-view
hierarchy can contain more than one sub-level. You can expand and collapse
levels as you would in a Windows NT Explorer hierarchy.

13. Click the Client view Close box to close the PAT syntax view.

14. Right-click on the PAT icon to open the shortcut menu. This time, select
View Section Rate. A section rate view (shown below) opens in the Client
view.

15. Watch the time cursors proceed across the graphs for a few seconds. If the
PAT appears in your input stream as often as required by the MPEG-2
standard, the graph text is green and the plot lines are pale blue.
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16. The bar chart readout displays the maximum rate. If you position the pointer
into the bar chart, you can use the cursor to measure the rate at any point in
the bar chart.

17. Move the pointer to the bottom of the Client view and click the Statistic
view tab. The statistic view is now visible in the Client view.

Using the Statistic View
The following procedure will acquaint you with features of the Statistic view.

1. The Statistic view in the Client view consists of six tabbed panels. When the
view first opens, most tabs are hidden by the horizontal scroll bar. Click the
thin split box at the left end of the horizontal scroll bar and drag to the right
to shorten the scroll bar and reveal the last three tabs.

2. Click each tab in turn to familiarize yourself with the information that each
contains. Notice that the Program Allocation, Type Allocation, TP Error
Indicator, and Unsynchronized Packets tabs pertain to the input stream as a
whole, while the PID Allocation and Continuity Counter tabs pertain to the
selected service (PSI/SI, programs, null packets, and unreferenced ghost
packets).

NOTE. The remainder of this tutorial explains features of the Program Allocation
and PID Allocation panels. For more information about the Continuity Counter,
Type Allocation, TP Error Indicator, and Unsynchronized Packet panels, refer to
the discussion of the Statistic view that begins on page 2–42.
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3. Return to the Program Allocation panel by clicking the Program Allocation
tab. Notice that the pie chart provides a quick graphic overview of input
stream contents while the table to the right provides equivalent numeric data.

Service or
program name

Portion of the input
stream used by the
service or program

Transport rate
of the service
or program

Minimum allocation
limit

Maximum allocation
limit

4. The yellow pie chart slice represents the service information (PSI, PSI/SI, or
PSI/PSIP). Double-click on any other slice of the chart. The PID Allocation
panel replaces the Program Allocation panel in the Statistic view. The PID
Allocation panel contains a dynamic transport rate display for each PID in
the selected service (PSI/SI/PSIP, program, null packets, or unreferenced
ghost packets).

The “pressed down” service-selection button and the PID list on the right
side of the panel both correspond to the pie slice that you have double-
clicked. The service selected in the following PID Allocation example is
composed of only one PID.
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Service-selection
buttons PID list PID rate bar chart

Rate-error
indicator

5. Click the PSI (MPEG-2 mode) or PSI/SI (DVB or ATSC mode) service
button to view the transport rates of all service information tables in the
input stream.

The PAT is the first PID listed. The rate bar chart shows the current transport
rate as well as the highest and lowest rates since you began monitoring. The
reported rates can change as often as twice per second.

Maximum rate measuredMinimum rate measured
Current transport rate

You can set transport rate error limits for any PID in the stream through the
PID Allocation panel or the Hierarchic view. When you do so, the limits and
any errors are visible on the PID allocation panel.
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6. To set error limits for the PAT, position the cursor over the PAT rate bar and
click the right-hand mouse button.

7. In the resulting dialog box, select both Low limit check and High limit
check. Then enter a low limit that is greater than the previous minimum (but
lower than the previous maximum) and a high limit that is greater than the
previous maximum. Click OK  and notice the changes in the PID Allocation
Statistic view as shown below.

Number of high errorsNumber of low errors

Color indicates
error status

Rate
limit

marker

The number of Low Errors  and High Errors  appear in readouts below the
ends of the bar chart to report the number of half-second intervals in which
the rate has violated the limits. The color of the bar chart shading between
the rate-limit marker and the end of the bar chart indicates the error status.
The color of the round indicator at the right end of the PSI (or PSI/SI)
selection button matches the highest error status of the bar chart.

Rate error indicator

The arrangement and colors of the rate bar and rate readout numerals also
change when errors occur. Refer to PID Allocation Panel on page 3–35 for a
complete description and explanation.
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Using the ETR 290 View
ETR 290 is the DVB working group that recommends measurements and
controls to be performed on all elements of the digital television chain. You can
configure the RTA to perform all but a few of the ETR 290 recommended tests
as a stream is received. The ETR 290 view presents pass/fail results of the
recommended tests in one display; you can use the ETR 290 view to get a quick
overview of the DVB compliance of the input stream.

Refer to Appendix A: ETR 290 Measurements for additional information about
the ETR 290 recommendations and tests.

Perform the following steps to familiarize yourself with the ETR 290 view:

1. If the RTA is not running, start the application and configure it as described
in Monitoring an Input Stream on page 2–68. Then continue with step 3,
below.

2. If the RTA is running, stop analysis and restore the original settings before
proceeding:

a. Click the red stoplight toolbar button and then select Restore Standard
from the Configuration menu.

b. If you are using a DVB or ATSC input stream, or are receiving your
input through the ASI connector, open the Configuration menu and
select Settings. Make the appropriate settings on the Hardware and
Analysis configuration panel of the Settings window. Click OK  to
confirm the changes and close the Settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Open the View menu, click ETR 290 View, and select Detailed.
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The detailed ETR 290 view opens in the Client view as shown below. The
view lists every ETR 290 test that the RTA can perform. This illustration is
for DVB mode only. The view will be different for ATSC or MPEG-2
modes.

A colored indicator accompanies each listing to shows the status of the test.
Notice that, in the standard configuration, all indicators are gray except the
TS_sync_loss indicator (number 1.1, in the upper left corner of the view).

� Gray signifies that the test is not running.

� Green signifies that the test is running and that no errors have been
detected.

� Red signifies that the test is running and an error is detected in the input
stream.

� Orange signifies that the test is running and that at least one error has
occurred since monitoring began (or since the last error reset) but that
the error is not currently present in the input stream.
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You can double-click on an error indicator to open a view in the Client view
of messages pertaining to the particular ETR 290 error. If the input stream
contains so many errors or message events that messages quickly scroll off
the top of the window, click the Freeze views toolbar button to pause
window updates. Then use the vertical scroll bar to locate the applicable
error message.

Other indicators may be gray because your input stream does not contain the
applicable table. MPEG-2 streams, for example, do not contain SI tables;
therefore, tests 3.2 through 3.8 cannot be performed on a non-DVB stream.

4. In the standard configuration, all ETR 290 tests are disabled to free RTA
processing and buffer resources for other functions, such as reporting the the
results of several computation-intensive “probes” in real time. Perform the
following steps to enable ETR 290 tests:

a. Select Settings from the Configuration menu, and then select Analysis/
ETR 290 in the Settings window hierarchy.
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b. In the ETR 290 Settings window, select 1.2 Sync_byte_error and then
click Add to add the test to the ETR 290 probe list. Click Apply  to
apply the test changes.

NOTE. The following step tells you how to change the error limits (thresholds)
for some ETR 290 tests, although doing so may not be consistent with ETR 290
recommendations.

5. Perform the following steps to change the ETR 290 error limits:

a. Select Settings from the Configuration menu and then select the
Analysis/Advanced/Rate/Section item in the Settings window
hierarchy. The Section Rate Analysis panel opens.

b. The ETR 290-recommended maximum interval between PAT sections is
500 ms. Highlight the PAT in the Probe Type list, change the Maximum
interval setting to 50 ms, and then click Add. The new PAT interval is
added to the Probes list as shown in the next illustration.

c. Click OK  to confirm the change and close the Settings window.
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6. The ETR 290 indicator for parameter 1.3.1, the PAT section rate, should be
red in the ETR 290 view. Locate the corresponding message in the Report
window, as shown below.
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7. Wait a short while and then double-click on “Error detected” at the left end
of the Level 1.3.1/Rate error message to retrieve error details from the
Windows NT Event Viewer (shown below). The single report view error
represents all such errors since you set the probe. If you close the window
and then reopen it (by again double-clicking the PAT error message), the
number of errors indicated by the “n message(s)” readout (below the OK
button) is greater.

8. Close the Event viewer messages window. Then choose Settings from the
Configuration menu. Select the Section Rate Analysis panel, if necessary,
and click Add to reset the PAT interval value to 500 ms. Finally, click OK to
confirm the change and close the Settings window.

9. If necessary, click the ETR 290 view tab at the bottom of the Client view to
bring the view back to the top of all client views.

Resetting the default PAT interval to 500 ms should change the 1.3.1 PAT
section rate indicator in the ETR 290 view to orange (if it remains red, your
input stream contains other PAT section rate errors). Click Reset past errors
in the lower-left of the ETR 290 view (you may need to scroll the ETR 290
view to locate). The 1.3.1 PAT rate indicator should change to green.

PAT section rate indicator
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10. Select Settings from the Configuration menu. Then select the Analysis/
ETR 290 in the Settings window hierarchy.

11. Click Remove All buttons to deselect all of the ETR 290 analyses except for
1.1 TS_sync_loss. Then click OK  to confirm the changes and close the
Settings window. On the ETR 290 view, only the TS_sync_loss indicator
remains colored; all others become gray, signifying that the associated tests
are no longer being performed.

NOTE. You can disable tests if you want to free RTA processing and buffer
resources for other functions, which may be necessary if you want to set several
probes and see the results in real time. However, disabled tests remain disabled
until you again set them through the Configuration menu or you restore the
standard configuration (even if you exit and restart the RTA application).
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Setting Probes
RTA probes are simply user-initiated analyses. Two of the probes, PCR and
PTS/DTS, fulfill ETR 290 recommendations.

Perform the following procedure to set PCR probes:

1. If the RTA is not running, start the program and configure it as described in
Monitoring an Input Stream beginning on page 2–68, and then continue with
step 3, below.

2. If the RTA is running, stop analysis and restore the original settings before
proceeding:

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. If you are using a DVB or ATSC input stream, or are receiving your
input through the ASI connector, open the Configuration menu and
select Settings. Make the appropriate settings on the Hardware and
Analysis configuration panels of the Settings window, and then click
OK  to close the Settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Press F8 to reveal the second level in the Hierarchic view.

4. Select a PMT hierarchy icon that is accompanied by a gray error indicator, if
possible, and then right-click to open the shortcut menu.

You can use either of the PCR Probe and View PCR Analysis commands to
set the PCR probe to monitor the clock references that apply to the selected
program.

Setting PCR Probes



RTA Operating Tutorials

MTS 200 Series Real-Time Analyzer User Manual 2–87

5. Select View PCR Analysis. A PCR probe dialog box for the selected
program opens (shown below). You can set probe parameters for the PCR
interval and PCR jitter. Click OK  to enable the PCR probe. The error
indicator for the selected PMT icon changes to green or red, signifying that
the PCR probe is set. At the same time, a PCR analysis view opens in the
Client window pane.

Refer to PCR Analysis View on page 2–61 for information about the view. If
the PCR precision and interval is within the ETR 290-recommended error
limits, the Min and Max readouts are green and the plots are light blue. You
can change the PCR error limits, but doing so will put the ETR 290 view out
of compliance with ETR 290 recommendations.
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6. Make a note of the Min: and Max: PCR intervals shown on the lower PCR
analysis view graph.

7. Choose Settings from the Configuration menu and then select the Analysis/
Advanced/Timing/PCR in the Settings window hierarchy to open the PCR
Timing Analysis panel.

8. Depending on your operating mode, change either the DVB interval or the
MPEG-2 interval to a value that is between the actual minimum and
maximum that you recorded in step 6.

9. Click OK  to accept the new value and close the Settings window. The new
PCR interval setting should have the following results:

� The indicator above the PMT hierarchy icon should quickly become red
to indicate the presence of PCR interval errors. After that, it may turn
orange in the times between errors. If the indicator remains green, reopen
the Settings window and reduce the interval setting.

� Error messages can be viewed by selecting View Report from the PMT
icon menu, which opens a message view in the Client view.
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10. Open the RTA View menu, click ETR 290 view, and select Detailed. Notice
that setting the PCR probe has changed the information for recommended
tests 2.3 and 2.4 (near the center of the view).

Number of
PCR probes set Red or orange indicator

Green indicator

11. Choose Settings from the Configuration menu and then select the Analysis/
Advanced/Timing/PCR in the Settings window hierarchy to open the PCR
Timing Analysis panel. Notice that the PCR probe appears on the Probes
List  on the right side of the panel.

12. Double-click the PCR probe entry to remove it from the Probes List and
then click OK on the bottom of the Settings window. Doing so removes the
PCR probe. Notice that the ETR 290 view indicators for the PCR parameters
(2.3 and 2.4) are now gray.

13. Click the Client window Close box to close the ETR 290 view. Select the
PCR analysis view (if necessary). Notice that the graphs are no longer
updating because the probe has been removed.

14. Click the Client window pane Close box to close the PCR Analysis view.

15. Open the View menu and select Reset Past Errors (F4 is the F-key
equivalent). The indicator above the PMT icon (from which the probe was
removed) should change from orange to gray.

16. Restore the default PCR interval setting.

a. Choose Settings from the Configuration menu and then select the
Analysis/Advanced/Timing/PCR in the Settings window hierarchy to
open the PCR Timing Analysis panel.

b. Click Restore Default in the PCR Timing Analysis panel, and then click
OK  on the bottom of the Settings window to confirm the default settings
and close the window.
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Perform the following procedure to set PTS/DTS probes:

1. If the RTA is not running, start the program and configure it as described in
Monitoring an Input Stream beginning on page 2–68. Then continue with
step 3, below.

2. If the RTA is running, stop analysis and restore the original settings before
proceeding:

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. If you are using a DVB or ATSC input stream, or are receiving your
input through the ASI connector, open the Configuration menu and
select Settings. Make the appropriate settings on the Hardware and
Analysis configuration panels of the Settings window, and then click
OK  to close the Settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Press F9 to reveal the third level of the hierarchy. You can now see elementa-
ry stream icons under the PMT icons.

Notice that some elementary stream icons have green clock symbols on the
upper-right; those streams contain PCRs. Several elementary stream icons
may have a blue padlock symbol on the lower-left; the lock symbol indicates
that the stream is scrambled.

4. Find an icon that represents an unscrambled audio or video stream. The icon
error indicator should be gray. Make a note of the stream PID. (The item PID
appears immediately to the right of all hierarchy icons.)

Setting PTS/DTS Probes
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5. Set a PTS/DTS probe on the elementary stream that you identified in step 4
using one of the following two methods:

Method 1

� In the Hierarchic window highlight the icon of the elementary stream
you want to probe. Select PTS/DTS Probe from the icon’s shortcut
menu.

� Set the PTS/DTS interval in the dialog box (if you want to change the
default 700 ms value), and then click OK .

The ETR 290 error condition is an interval of more than 700 ms between
consecutive PES packets that contain a presentation time stamp. You can
change the PTS/DTS error interval, but doing so may violate ETR 290
recommendations.

Method 2

� Choose Settings from the Configuration menu and then select the
Analysis/Advanced/Timing/PTS/DTS in the Settings window
hierarchy to open the PTS/DTS Timing Analysis panel (shown below).

� Select the program that the elementary stream is in from the Program
number pull-down menu. Select the elementary stream from the With
referenced elementary stream PID pull-down menu.
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� Set the PTS/DTS interval (if you want to change the default 700 ms
value), and then click OK .

The ETR 290 error condition is an interval of more than 700 ms between
consecutive PES packets that contain a presentation time stamp. You can
change the PTS/DTS error interval, but doing so may violate ETR 290
recommendations.

� Click the Add box to add the probe to the Table Identity list box. Click
OK  on the bottom of the Settings window to set the probe and close the
window.

The hierarchy icon error indicator immediately changes from gray to either
green or red.

6. Select ETR 290 View Detailed from the View menu. The PTS_error
indicator (parameter 2.5), like the icon error indicator, is green, red, or
orange, depending on the contents of your input stream.

7. In the Hierarchic view, select the icon that represents the elementary stream
that you are probing and then right-click to open the shortcut menu.
PTS/DTS Probe is selected (noted by a check mark) because you set the
probe through the Configuration menu.

8. Select View PTS/DTS Analysis. A PTS/DTS analysis view (shown below)
opens in the Client view.
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The PTS/DTS analysis view consists of two graphs. The left graph is a
PTS/DTS interval plot. If the RTA detects PTS/DTS errors, the readout text
becomes red and the interval plot line changes from blue to red in regions
that correspond to the errors. You can change the scale of the plot using the
Interval Scale Settings control box. The second graph is a histogram. You
can change the scale of the histogram using the Interval Histogram Scale
Settings control box.

9. To view error messages related to the PTS/DTS analysis, select View Report
from the shortcut menu associated with the elementary stream icon you are
probing. A message view opens in the Client view.

10. Select the hierarchy icon of the elementary stream that you are probing;
right-click to open the shortcut menu and then click PTS/DTS Probe. Doing
so removes the probe (the check mark disappears). Notice that, because the
probe is removed, the PTS/DTS analysis view no longer updates.

11. Close the PTS/DTS analysis view (click the Client view close box, not the
RTA close box). Closing the PTS/DTS analysis view reveals the ETR 290
view. Notice that the PTS_Error indicator (parameter 2.5) is now gray.

12. Open the Configuration menu and select Settings. The PTS/DTS Timing
Analysis panel should still be selected. Notice that the PTS/DTS probe is no
longer listed in the Table Identity box.

13. Close the Settings window.

The InterSI probe checks for errors within and between DVB-SI tables. Continue
with this tutorial only if your input stream contains SI tables (for example, EIT,
BAT, and SDT).

1. If the RTA is not running, start the program and configure it as described in
Monitoring an Input Stream beginning on page 2–68. Then continue with
step 3, below.

2. If the RTA is running, stop analysis and restore the original settings before
proceeding:

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. Because you must use a DVB input stream to enable the InterSI probe,
open the Configuration menu and select Settings. Make the appropriate
settings on the Hardware and Analysis configuration panels of the
Settings window, and then click OK  to close the Settings window.

c. Click the green stoplight toolbar button to restart analysis.

3. Press F7 to hide all but the top hierarchy level.

Setting the InterSI Probe
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4. Select the NIT icon in the Hierarchic view and open the shortcut menu
(right-click). Select InterSI Probe.

If not previously red or orange because of errors detected by basic or
automatic analysis, the error indicators of the BAT, EIT, NIT, and SDT icons
now change from gray to signify that the InterSI probe is set.

After a few moments, depending on the contents of your input stream, one or
more of the indicators may become red and then perhaps orange to signal
InterSI errors. You can view InterSI error messages by selecting View
Report from the icon’s shortcut menu, or by double-clicking on the icon in
the Hierarchic view. InterSI information, warning, and error messages also
appear in the Report view. Refer to Using the InterSI Analysis Probe on
page 3–14 for more information.

5. Select the icon of an SDT or an EIT in the Hierarchic view and open the
shortcut menu. Notice that InterSI Probe is selected.

You can set and remove the InterSI probe through any SI table icon or
through the Multiplex Analysis panel of the Settings window.
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6. Select Settings from the Configuration menu, and then select Analysis/Ad-
vanced/Multiplex from the Settings window hierarchy. Inter SI consistency
is shown on the probes list.

7. Select the InterSI entry in the Probe List box and the click Remove (or
simply double-click the list entry). Click OK  to confirm the change and
close the Settings window.

8. If any of the SI table icon error indicators remain orange, press F4 to reset
past errors. The indicators change to gray unless the automatic analyses
detect other SI table errors.
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Capturing Input Streams (MTS 215 only)
If you have an MTS 215, you can easily capture and store a portion of the input
stream on the Data Store disks for deferred-time analysis or other use of the data.

1. Use the shielded cable (Tektronix part number 174-3799-XX) provided with
the MTS 215 Real-Time Analyzer to connect the 25-pin RTA output to the
25-pin Data Store (parallel/serial ECL) input.

Install RTA-to-Data
Store board cable

RTA I/OData Store I/O

NOTE. You must use a shielded cable to maintain EMC compliance.

2. Start the Data Store Administrator application by double-clicking the Data
Store Administrator icon (shown below) in the Tektronix MPEG Test
System window.

Hardware Setup
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3. Confirm that there is a Single shot partition and that it is large enough hold
the data you intend to store. Repartition the disks if necessary; refer to the
MPEG Test System User Manual for instructions.

NOTE. Repartitioning the Data Store disks erases all existing files. Before
proceeding, confirm that the Data Store disks do not contain important and
irreplaceable data.

4. Check the File information  list and confirm that no file on the single shot
partition is named Rta.trp; if such a file does exist, delete the file and then
compress the disks (if necessary) to completely remove the file from the
partition.

5. Minimize the Data Store Administrator window.

6. If the RTA is not running, start the program and configure it as described in
Monitoring an Input Stream beginning on page 2–68. Then continue with
step 8, below.

7. If the RTA is running, stop analysis and restore the original settings before
proceeding:

a. Click the red stoplight toolbar button and then select Restore standard
from the Configuration menu.

b. If you are using a DVB input stream or are receiving your input through
the ASI connector, open the Configuration menu and select Settings.
Make the appropriate settings on the Hardware Configuration and
General settings tabs and then click OK  to close the settings window.

c. Click the green stoplight toolbar button to restart analysis.

8. Choose Settings from the Configuration menu, and then select Hardware in
the Settings window hierarchy. Set the Output Level to Modified ECL  if
necessary.

RTA Software Setup



RTA Operating Tutorials

2–98 MTS 200 Series Real-Time Analyzer User Manual

9. Select Output Filtering  in the Settings window hierarchy. Notice that you
can select PID based filtering and specify the tables, programs, or
elementary streams that you wish to capture and store. Refer to Output
Filtering Panel on page 3–94 for instructions. For this tutorial, select No
PID filtered  to capture all packets contained in the input stream.

NOTE. PID-based filtering can result in a relatively low data output rate. If you
intend to capture filtered output, be sure to consider the data rate when you
specify (in the following step) the amount of the stream to capture. It can take
several minutes, for example, to capture 5 Mbytes of output that contains only SI
table sections.

10. Select Data Storage in the Settings window hierarchy. Through this panel
you can specify one or more Stop Conditions, such as an external trigger or
an ETR 290 error. Manual stop is always selected. You can also specify how
much of the input stream (or filtered output) is to be captured.

Refer to Data Storage Panel on page 3–86 for a full discussion of the Data
Storage Settings panel.

11. Click Reset All (immediately below the Stop Conditions list) to ensure that
only Manual stop is selected.

12. In the After Event area, click Seconds and then enter 15 in the text box.
Then click Bytes to see the size of the file to be stored. The number of bytes
depends on the transmission rate of your input stream; the example below is
for a 30 Mbit/s input stream.

13. Click OK  to confirm all settings changes and close the Settings window.
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14. Click the Start the acquisition toolbar button.

15. Immediately click the Stop the acquisition button.

NOTE. If you attempt to stop acquisition before the test system receives enough
input to satisfy the Before event setting, the following message appears:

If you click Yes, acquisition stops and no file is saved. If you click No, acquisi-
tion continues; you can stop it later, after enough input has been received.

Stream Capture
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16. A message appears at the left end of the RTA status bar to show the time
remaining for the data capture.

At the same time, “REC” and a cassette tape icon alternate at the right end of
the status bar. Shortly after the capture period is over, a flashing red WAIT
symbol replaces REC to indicate that the RTA is creating a file on the Data
Store disks. The entire process for this tutorial example takes approximately
30 seconds.

When the WAIT symbol stops flashing, a “Data are stored...” message
appears in the Report view.

NOTE. During data storage, the test system must first acquire the event trace
data and then rewrite that data to a contiguous file at the beginning of the free
space on the data store disks.2 As a result, the time required to save an event
trace file—from stop condition detection to the end of the acquisition—can be
up to twice the time required to acquire the event trace data. In extreme
circumstances, such as saving 16 Gbytes of input immediately following a stop
condition, data storage through the RTA can take over one hour.

Be aware of this limitation when configuring the RTA to store a large event trace
file, as you cannot run the Data Store Administrator, Deferred-Time Analyzer, or
Multiplexer applications during RTA data storage.

17. Maximize the Data Store Administrator window.

18. Select FAT Read from the File menu (or press F5) and then confirm that the
file MnStop00.trp is on the Single Shot partition.

NOTE. In a standard MTS200 Series test system, the saved file size must be an
exact multiple of 96256 bytes. Therefore, the resulting file can be up to 96255
bytes smaller than the total size specified in the Before Event and After Event
size fields.

19. Minimize the Data Store Administrator application window.

If you repeat steps 14 through 18, you will see that another file,
MnStop01.trp, is added to the single shot Data Store partition. The number
at the end of the file name increments to permit saving stream data before
and/or after several similar data storage stop events.

2 Refer to the MTS200 Series MPEG-2 DVB/ATSC System Analyzer User Manual, Tektronix part number 071-0532-XX, for
additional information about file management on the data store disks.
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You can also configure the RTA to monitor a stream and automatically save a
number of “event trace” files of data immediately before and/or after similar
ETR 290 errors.

20. Select Settings from the Configuration menu, and then select Data Storage
in the Settings window hierarchy.

21. In the Stop Conditions list, click the “+” box to the left of the “ETR 290
tests: Level 1” item to expand the hierarchy below that item.

22. Click the hard disk icon of the “1.1 TS_sync_loss” stop condition; a green
check mark appears to indicate that the Stop condition is enabled.

23. Select Continuous acquisition to enable the capture of several
DVB11nn.trp event trace files.

At this time, the Stop conditions portion of the Data Storage panel
resembles the following illustration.

Step 22

Step 23

24. Click OK  to confirm your selections and close the Settings window.

25. Click the Start the acquisition toolbar button to begin monitoring the input
stream for sync loss error events.

26. After approximately two seconds, disconnect the cable from the RTA input
connector on the rear panel of the MTS 215. Doing so will cause a sync loss
error. When an error is detected, the Stop the acquisition toolbar button is
grayed.

Continuous Acquisition
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27. Reconnect the input cable. After a few seconds, the message “Data are stored
in CARB file: carb0\mono\DVB1100.trp” appears at the bottom of the
general message window.

28. Repeat steps 26 and 27 twice to capture two more error trace files.

29. After “Data are stored in CARB file: carb0\mono\DVB1102.trp” appears at
the bottom of the general message window, click the Stop the acquisition
toolbar button.

30. When the “Data are stored in CARB file: carb0\mono\MnStopnn.trp”
message appears, maximize the Data Store Administrator application
window.

31. Select FAT Read from the Data Store Administrator File menu (or press F5)
and then confirm that several DVB11nn.trp files are on the Single shot
partition and that the last file listed is MnStop0n.trp.

This tutorial example shows how you can use data storage to capture data
immediately preceding or following infrequent errors. You can configure the
RTA to monitor a stream for a number of different ETR 290 errors for an
extended period without user input. You can later analyze any resulting event
trace files with the MPEG System (Deferred-Time) Analyzer to diagnose the
cause or effects of the error event.

32. When you are finished experimenting with data storage, delete the
MnStopnn.trp and DVB11nn.trp files from the Data Store disks and exit the
Data Store Administrator.

33. Stop analysis and restore the standard configuration to ensure that the
settings used in this tutorial do not cause unexpected results when you again
use the Real-Time Analyzer.

This ends the data storage tutorial.
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Remote Control Using SNMP

SNMP is a communication protocol built on the top of TCP/UDP. It implements
a set of commands consisting of operations and variables. Equipment or
applications (such as the RTA) that support SNMP present a set of variables that
you can modify or consult as well as a set of notifications. All of these parame-
ters are grouped into a Management Information Base (MIB).

MIBs are specifications containing definitions of management information so
that network systems can be remotely monitored, configured, and controlled.

Accessing the RTA MIB
To remotely control the RTA application using any SNMP MIB browser, you
only need to load the RTA MIB file. This file is located in the following
directory on your MTS 200 test system:

C:\Mib\rta.mib

To display the RTA MIB file and its components, open the following file:

C:\Mib\RTA.html

The RTA.html file contains the RTA MIB file with hyperlinks added to help you
become familiarized with the file.

SNMP Operations
The operations in SNMP are limited to retrieving the value of management
information, modifying the value of management information, and reporting an
event.

The most common type of retrieval operation requires that the identities are
those that exactly match the identity of returned variables. This retrieval
operation is called GET.

For instance, from a DOS prompt window you can run the following command
to get the analysis state of the RTA:

getone –v2c MTS100 public rtaStartStop.0

Retrieval
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There is one modification operation, which is called SET. The operand for SET
is a list of pairs. Each pair consists of the identity of a variable and its desired
value. Use this operation to configure and control a managed system.

For instance, from a DOS prompt window you can run the following command
to start analysis on the RTA:

setany –v2c MTS100 public rtaStartStop.0 -i start

The event reporting operation is called TRAP. It specifies an event and a list of
pairs. A pair consists of the identity of a variable and its values. This operation is
used to report the occurrence of events on a managed system to a list of
managers configured to receive events. To send traps to a specific monitoring
station, perform the following steps:

1. Make sure the RTA application is closed.

2. Run the following commands in a DOS prompt window:

� Snmpdm –stop

� Msnsaagt –stop

3. Edit the following file: C:\Etc\srconf\agt\snmpd.cnf.

� Change MACHINE_NAME to the name of your MTS machine.

� Change every occurrence of SUPERVISOR_MACHINE_NAME to the
name of the monitoring station you want to send traps to.

� Change SUPERVISOR_IP_ADDRESS to the IP address of the
monitoring station you want to send traps to.

� Change SUPERVISOR_NETWORK_MASK to the network mask of the
monitoring system you want to send traps to.

4. Run the following commands in a DOS prompt window:

� Snmpdm –start

� Msnsaagt –start

When you run the RTA application after you have performed these steps, the
RTA will send SNMP traps to the monitoring station.

NOTE. The event reporting (TRAP) operation can be very CPU-intensive. To
disable the TRAP operation, repeat the steps above, replacing the values you
entered with MACHINE_NAME, SUPERVISOR_MACHINE_NAME, SUPERVI-
SOR_IP_ADDRESS, and SUPERVISOR_NETWORK_MASK.

Modification

Event Reporting
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Analysis

This section explains the Real-Time Analyzer (RTA) analyses in detail and also
describes the options available in the configuration panels of the Settings
window.

The RTA conducts very few full-time analyses on the input stream. These default
analyses are fundamental to RTA operation and cannot be disabled. Refer to
Default Analyses on page 3–2 for a description of the full-time default analyses.

All of the remaining RTA analyses are user-initiated and user-controlled.

NOTE. To differentiate user-controlled analyses from RTA default analyses, this
manual refers to any user-controlled analyses as Probes.

This Reference section contains the following information:

� Default analyses page 3–2

� User controlled analyses (probes) page 3–2

� SIDAT 360 analyses page 3–6

� Program analyses page 3–7

� ETR 290 analyses page 3–8

� Multiplex analyses page 3–9

� Syntax analyses page 3–17

� Timing analyses page 3–29

� Rate analyses page 3–33

� Configuration page 3–41
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Default Analyses
The RTA always checks for synchronization and monitors transport rates to
ETR 290 recommendations.

If the RTA cannot achieve synchronization with the input stream, it reports a
general error in the Report view. This error is the same as ETR 290 error 1.1,
TS_sync_loss.

NOTE. If the RTA cannot achieve synchronization with the input stream, no other
tests or analyses can be conducted by the RTA.

In transport rate analysis, the RTA calculates the average bit rate of each PID in
the input stream and displays the results in the Program Allocation, PID
Allocation, and Type Allocation panels of the Statistic View. The analysis is
completely automatic and cannot be disabled.

Use the Transport Rate Analysis panel of the Settings window to set probes on
selected stream PIDs for transport rates that fall below or exceed limits of your
choosing. Refer to Analysis:Advanced:Rate:Transport Panel on page 3–72 for
information about using the Transport Rate Analysis panel.

Refer to Transport Rate Analysis on page 3–33 for more information about RTA
transport rate analysis.

User Controlled Analyses (Probes)
All of the RTA analyses, other than the default analyses listed above, are
user-controlled and are referred to in this manual as probes. While you can set,
configure, and remove several types of probes through the RTA Hierarchic and
Statistic views, you can control all RTA probes using the configuration panels
available in the Settings window. To open the Settings window, select Settings
from the Configuration menu.

The next few pages will give you an overview of how to use the configuration
panels in the Settings window to set RTA probes. Refer to Configuration on
page 3–41 for detailed descriptions of each configuration panel.

Synchronization

Transport Rate
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Use the Analysis panel of the Settings window (shown below) to select the
analysis type and various analysis options. Refer to Analysis Panel on page 3–50
for detailed information about the Analysis panel settings.

NOTE. Before configuring or initiating any additional RTA analyses or probes
beyond the default analyses listed on page 3–2, always select the appropriate
analysis type and analysis options using the Analysis panel of the Settings
window. Your selections on the Analysis panel determine which RTA analyses
are available on other configuration panels.

Analysis Type. The Analysis Type setting determines which standard the RTA
uses to monitor the input stream. You can select from MPEG-2 (the default),
DVB, and ATSC analysis types.

Analysis Options. The Ghost scanning and Smoothing time options are
available for all three analysis type settings. The remaining analysis options are
available only when you select the DVB analysis type.

Select DVB-T  to enable Mega Frame analysis. Three of the Settings pan-
els—Mega Frame Syntax, Mega Frame Timing, and Mega Frame Rate—are
available only when you select the DVB analysis type and the DVB-T analysis
option.

Select SIDAT 360 Profiles to enable SIDAT 360 analysis and to enable the two
SIDAT 360 options Multiprotocol Encapsulation and Data Carousel.

Refer to SIDAT 360 Analyses on page 3–6 for more information.

Analysis Types and
Options
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Please make note of the following general information regarding user-controlled
RTA analyses (probes):

� User-controlled analyses (probes) are not part of the default RTA analyses.
To restore RTA operation to only the default analyses, stop any active
analysis and then select Restore Standard from the Configuration menu.

� You can set (initiate), configure, and remove (end) all probes using the
configuration panels in the Settings window. Select Settings from the
Configuration menu to open the Settings window.

� You can also control several probes through the Hierarchic view or the
Statistic view. Refer to Using the Hierarchic View, on page 2–11, and
Statistic View, on page 2–42, for more information.

� The RTA stores probe settings and uses those settings whenever it is
analyzing an input stream. If a probe is set when you stop analysis and
power the computer down, it is also set the next time you use the RTA.

� To maximize RTA performance (especially with input streams that contain
many errors), limit the number of probes set at any one time.

Setting Probes. The following procedure uses the Multiplex Analysis panel as an
example. You can set probes on other configuration panels using the same
functional steps.

1. Select Settings from the Configuration menu to open the Settings window.
Select the desired configuration panel from the Settings window hierarchy.
The following example uses the Multiplex Analysis panel.

2. Select (highlight) the desired probe in the Probe Type list of the Multiplex
Analysis panel (shown below).

Probe Operating
Conventions
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3. Make any additional selections required for the particular probe. Additional
configuration settings for the selected probe appear below the Probe Type
list when you select the probe, as shown in the following illustration.

a. In this example, when you select Absence of referenced PID, the In
box appears that allows you to select the absence table to analyze. When
you select an item in the In box, a For box appears that allows you to
select the table.

b. When you select an item in the For box, a With PID  or With program
number box appears that allows you to select PIDs or program numbers
for PMTs. A Delay box appears that allows you to set the delay (1 to
10s).

4. Click Add to add the probe to the Probe List.

5. Click Apply  to activate the probe (and all other settings changes made since
you opened the Settings window or last clicked Apply ) or click OK  to
activate the probe (and all new settings) and close the Settings window.

Removing Probes. The following procedure uses the Multiplex Analysis panel as
an example. You can remove probes on other configuration panels using the
same functional steps.

1. Remove the probe or probes from the Probe List.

� To remove a single probe from the list, highlight the probe in the Probe
List  and then click Remove. (You can also remove a probe by double-
clicking the Probe List entry.)

� To remove several probes from the list at one time, highlight each probe
name in the Probes List and then click Remove. To highlight several
contiguous names, click the first name and then hold the SHIFT  key down
while selecting the last name; to highlight non-contiguous names, hold
the CTRL  key down while making your selections.

� To remove all probes from the Probes List, click either Remove All or
Restore Default.

2. To confirm your selections, deactivate the probes, and close the Settings
window, click OK ; to confirm your selections and deactivate the probes
while leaving the Settings window open, click Apply.

NOTE. Removing a probe from the Probe List only does not end the probe/analy-
sis; you must also click Apply or OK.
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Changing Current Probe Settings. The following procedure uses the Multiplex
Analysis panel as an example. You can change current probe limits on other
configuration panels without removing and resetting the probe using the same
functional steps.

1. Select (highlight) the probe in the Probe List.

2. Change the limit settings as desired.

3. Click Add. The error limit change appears in the Probe List.

4. Click Apply  to change the probe error limits, or click OK  to change the
limits and to close the Settings window.

NOTE. You must click Apply or OK to put the changed probe limits into effect.

SIDAT 360 Analyses
SIDAT 360 is a set of analyses that allow you to analyze the following two main
types of standard DVB Data Broadcasting streams: Multiprotocol Encapsulation
and Data Carousel.

Multiprotocol Encapsulation streams usually carry IP packets and Data Carousel
streams may carry application-specific data modules that are broadcast cyclically,
such as teletext pages.

Selecting the SIDAT 360 data broadcasting analysis option on the Analysis
configuration panel of the Settings window sets a probe, which controls the
validity and consistency of the related data_broadcast_descriptor that is carried
in the SDT or the EIT. The three different types of tables carried on those
streams have the same probing facilities as standard DVB tables, except for
defining the maximum and minimum allowed rates.

Additionally, when you select the Multiprotocol Encapsulation option, you can
use the IP Monitoring view to monitor the IP traffic on the input stream. Refer to
IP Monitoring View on page 2–65 for more information about the view.
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Program Analyses
The Program configuration panel of the Settings window (shown below) allows
you to set and configure probes for each program contained in the input stream.

Refer to Analysis:Program Panel on page 3–52 for information about using the
Program panel.
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ETR 290 Analyses
The ETR 290 configuration panel of the Settings window (shown below) allows
you to set and configure ETR 290 probes.

Refer to Analysis:ETR 290 Panel on page 3–54 for information about using the
ETR 290 panel.

Refer to Appendix A:ETR 290 Measurements for additional information about
ETR 290 analyses.
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Multiplex Analyses

This section discusses each of the multiplex analyses in the order that they are
listed in the Multiplex Analysis panel in the Settings window (shown below).
Refer to Analysis:Advanced:Multiplex Panel on page 3–55 for information about
using the configuration panel.

This section contains the following information:

� Multiplex analysis probe descriptions page 3–11

� Using the InterSI analysis probe page 3–14
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Table 3–1 lists all of the multiplex analyses, the associated ETR 290 recommen-
dation, the required analysis type setting (refer to Analysis Panel on page 3–50),
and the starting page number for each analysis error description.

Table 3–1: Multiplex analyses 

Analysis probe ETR 290 Analysis type

Absence of referenced PID 1.6 All

Program not defined in PAT — All

Same PID in elementary stream and in PMT — All

Scrambling without CAT 2.6.1 All

Ghosts packet 3.4 All

Unsynchronized packet 1.2 All

Table ID PAT
CAT
NIT
TSDT
SDT
EIT
RST
TDT
TOT
MGT
TVCT
CVCT
STT
RRT

1.3.2
2.6.2
3.1.1
—
3.5.2
3.6.2
3.7
3.8.2
—
—
—
—
—
—

All
All
All
All
DVB only
DVB only
DVB only
DVB only
DVB only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only

Inter SI consistency — DVB and DVB-T

Mega Frame size — DVB-T only

Terrestrial descriptor consistency — DVB-T only

Program paradigm — ATSC/PSIP only

Scrambled ES without CA descriptor — ATSC/PSIP only

Absence of mandatory EIT — ATSC/PSIP only
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Multiplex Analysis Probe Descriptions
The following pages contain descriptions of the errors detected by each of the
multiplex analyses.

Error Condition: Reports an error if the time interval between a PID reference in a
PAT, CAT, or PMT and the appearance of that PID in the stream exceeds the
user-specified period of delay (1 to 10 seconds).

Associated ETR 290 recommendation: PID_error, 1.6.

How/where an error is reported: In the ETR 290 view and as a general error
message in the Report view.

Error Condition: Reports an error if a PMT program number is not defined in the
PAT.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Error Condition: Reports an error if a PMT and an elementary stream are
identified with the same PID.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Error Condition: Reports an error if packets with non 00 transport_scram-
bling_control exist in the stream but no section with table_id 0x01 (a CAT) is
found.

Associated ETR 290 recommendation: CAT_error, 2.6.1.

How/where an error is reported: In the ETR 290 view and as a general error
message in the Report view.

Error Condition: Reports an error if a PID (other than one of the defined or
reserved values) appears in the stream but is not referenced in a PMT within 0.5
seconds.

Associated ETR 290 recommendation: Unreferenced_PID, 3.4.

How/where an error is reported: In the ETR 290 view, as a general error message
in the Report view, as a Ghost icon in the Hierarchic view, and as a Ghost
service/program in several Statistic view panels.

Absence of Referenced
PID Probe

Program Not Defined in
PAT Probe

Same PID in Elementary
Stream and in PMT Probe

Scrambling without CAT
Probe

Ghosts Packet Probe
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Error Condition: Reports an error if the transport packet header Sync_byte is
not 0x47.

NOTE. If synchronization is lost, no other RTA analyses are possible.

Associated ETR 290 recommendation: Sync_byte_error, 1.2.

How/where an error is reported: As a general error message in the Report view,
the UNP indicator on the application window status bar, the Unsynchro Packets
panel of the Statistic View, and the ETR 290 level 1.2 indicator.

Error Condition: Reports an error if the Table ID of the PSI/SI selected is not
corrected.

Associated ETR 290 recommendation: See the table below.

Table ID analysis error ETR 290 recommendation

PAT error: PAT 0 with table_id different to 0x0 1.3.2

CAT error: PID 0x1 with table_id other than 0x1 2.6.2

NIT error: PID 0x10 with table_id other than 0x40, 0x41,
or 0x72 (ST)

3.1.1

SDT error: PID with 0x11 table_id other than 0x42, 0x46,
0x4A (BAT), or 0x72 (ST)

3.5.2

EIT error: PID with 0x12 table_id other than 0x4E – 0x6F
or 0x72 (ST)

3.6.2

RST error: PID with 0x13 table_id other than 0x71 or 0x72 (ST) 3.7

TDT error: PID with 0x14 table_id other than 0x71 or 0x72 (ST)
or 0x73 (TOT)

3.8.2

How/where an error is reported: As an error message in the Report view, the
ETR 290 LV1, LV2, and LV3 indicators on the application window status bar,
and the ETR 290 views of the Statistic View.

This analysis probe appears only when the analysis type setting is set to DVB
(refer to Analysis Panel on page 3–50). Refer to InterSI Analysis on page 3–14
for more information about the InterSI probe.

Error Condition: Reports an error if the RTA detects problems between PSI and
SI tables.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Unsynchronized Packet
Probe

Table ID Probe

Inter SI Consistency
Probe

(DVB only)



Multiplex Analyses

MTS 200 Series Real-Time Analyzer User Manual 3–13

This analysis probe appears only when the analysis type setting is set to DVB
and DVB-T is selected (refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the Mega Frame Size probe detects inconsis-
tency between the indicated size of the Mega Frames in the MIP and the
measured size (calculated from the packet rate and the PIA time stamps.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

This analysis probe appears only when the analysis type setting is set to DVB
and DVB-T is selected (refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the parameters carried in the MIP match those
carried in the terrestrial delivery system descriptor (if present in the NIT).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects problems of consistency with
the method specified by the program paradigm. Refer to Appendix B: ATSC
Program Paradigm for more information.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view
and as a specific report of the ES or table concerned. The messages are logged in
the multiplex folder.

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the CA descriptor is not found where
expected for an ES PID.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view
and in the specific report of the stream in the Hierarchic window.

Mega Frame Size Probe
(DVB-T only)

Terrestrial Descriptor
Consistency Probe

(DVB-T only)

Program Paradigm Probe
(ATSC only)

Scrambled ES Without CA
Descriptor Probe

(ATSC only)



Multiplex Analyses

3–14 MTS 200 Series Real-Time Analyzer User Manual

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the mandatory EIT (0, 1, 2, 3) are not all
present.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.
The messages are logged in the multiplex folder.

Using the InterSI Analysis Probe
Setting the InterSI probe activates two types of analysis :

� Intra analysis, which detects problems within PSI or SI tables.

� Inter analysis, which detects problems of coherence between SI tables.

You can use either of the following two methods to set or remove the InterSI
probe:

� Select InterSI consistency in the Multiplex Analysis panel. Refer to
Analysis:Advanced:Multiplex Panel on page 3–55.

� Select an icon in the Hierarchic window that represents an SI table
(NIT, EIT, SDT), right-click to open the shortcut menu, and then select
InterSI Probe from the menu. When the probe is selected, a check mark
appears in front of InterSI Probe in the menu.

Absence of Mandatory EIT
Probe

(ATSC only)

Setting and Removing the
InterSI Probe
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When the InterSI probe is set, the RTA checks the PMT, NIT, BAT, EIT and SDT
for the presence of mandatory descriptors and checks all descriptors for
compliance with DVB standards.

The RTA also checks the following specific characteristics of the NIT and EIT:

� In the NIT, the transport_stream_id and the network_id must be unique for a
given network_id.

� In the EIT, the field event_id must be unique for a given service_id,
transport_stream_id, and original_network_id.

� If an EIT is of type “schedule,” then the running_status field must be set to
“undefined.”

� If EIT is of type “following,” then the running_status field shall not be set to
“running.”

When the InterSI probe is set, the RTA monitors the NIT, SDT, EIT, and BAT for
inter-table compatibility and reports errors if the tables do not satisfy the
following conditions:

� The transport_stream_id and original_network_id fields of the NIT should be
referenced in an SDT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the NIT must be present in an SDT.

� The transport_stream_id, and original_network_id fields of the EIT must be
declared in the NIT.

� Each transport_stream_id, original_network_id, service_list_descriptor, and
service_id of the BAT must be present in an SDT.

� There should be an EIT referencing the service_id, transport_stream_id, and
original_network_id fields of the SDT.

� If the EIT_schedule_flag field of the SDT is set to 1, then an EIT schedule
for service_id, transport_stream_id, and original_network_id must be
present.

� If the EIT_schedule_flag of the SDT is set to 0, then an EIT schedule should
not be present for service_id, transport_stream_id, or original_network_id.

� If the EIT_present_following_flag of the SDT is set to 1, then an EIT
present/following for service_id, transport_stream_id, and original_net-
work_id must be present.

� If the EIT_present_following_flag of the SDT is set to 0, then an EIT
present/following should not be present for service_id, transport_stream_id,
or original_network_id.

Analyses Within Tables

Analyses Between Tables
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InterSI probe information and Error messages are displayed in the Report view
as shown in the following illustration. If the InterSI probe detects errors within a
table, the indicator above the hierarchy icon of the affected table becomes red;
the associated error message(s) also appear in the Message view of that table (if
you double-click the table icon to open such a view in the Client window).

InterSI Error Reporting
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Syntax Analyses

The RTA provides the following levels of syntax analyses.

� Syntax analysis page 3–17

� Transport syntax analyses page 3–18

� Section syntax analyses page 3–24

� Mega Frame syntax analyses (DVB-T only) page 3–26

Refer to Appendix C for more information about using the Private Syntax
Interpreter and generating user-defined private syntax definition files.

When the RTA detects a section syntax error, the error indicator above the
Hierarchic view icon turns red and a general error message appears in the Report
view. You can also double-click the Hierarchic view icon to open a Message
view particular to the affected table. The RTA also notes the presence and nature
of each section syntax error in the section analysis view (refer to Section
Analysis View on page 2–56).

Syntax Analysis
The Syntactic Analysis panel of the Settings window (shown below) contains
General Configuration and Private Syntax options that affect private section
interpretation and syntax error reporting.

Syntax Error Reporting
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There are two possible general configuration settings:

� The Maximum number of errors by entity setting allows you set the
maximum number of errors the RTA detects before stopping analysis for one
entity. This limits the number of syntax errors reported by the RTA for each
entity. This option is convenient when you are analyzing non-compliant
streams that contain many errors.

� The Map private section as DVB section option appears only when you
have set the analysis type to DVB through the Analysis panel (refer to
Analysis Panel on page 3–50).

When you select Map private section as DVB section (a check appears in
front of the option), the RTA attempts to interpret all private sections
encountered in the stream as DVB SI sections. The option is not present in
the standard configuration, which has MPEG-2 monitoring selected.

NOTE. The Map private section as DVB section option is cleared when you first
specify DVB monitoring on the Analysis panel; select this option if necessary to
force the RTA to interpret PIDs 0x10 through 0x14 as SI.

You can load user-defined private syntax definition (.cta) files through the
Private Syntax portion of the panel. These files, generated with the Private
Syntax Interpreter application, make it possible to analyze proprietary or
non-standard tables and descriptors contained in the RTA input stream.

Refer to Appendix C for more information about using the Private Syntax
Interpreter and generating user-defined private syntax definition files.

Transport Syntax Analyses
Use the Transport Syntactic Analysis panel of the Settings window (shown on
the following page) to set and remove probes that monitor transport syntax.
Refer to Analysis:Advanced:Syntax:Transport Panel on page 3–59 for informa-
tion about using the Transport Syntactic Analysis panel.

The following pages describe the transport syntax analyses in the order that they
are listed in the Transport Syntactic Analysis panel. Table 3–2 lists the transport
syntax analyses, the associated ETR 290 recommendation, the analysis type
setting on the Analysis panel (refer to Analysis Panel on page 3–50), and the
page on which each analysis error is explained.

General Configuration

Private Syntax
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Table 3–2: Transport syntax analyses 

Analysis probe ETR 290 Analysis type

Null packet with PUSI none All

Reserved PID none All

PID 0x47 none All

Reserved (PAT, CAT, or Null Packet) PID with TSC 1.3.3 All

PMT PID with TSC 1.5.2 All

Continuity counter 1.4 All

PCR/OPCR flags none All

Null packet with ADF none All

ADF flags none All

Transport error indicator 2.1 All

PAT PID with AFC & DI — ATSC/PSIP only

PMT PID with AFC & DI — ATSC/PSIP only

PSIP tables PID with TSC — ATSC/PSIP only

PSIP tables PID with ADF — ATSC/PSIP only

MGT PID with PUSI & pointer field — ATSC/PSIP only
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Error Condition: Reports an error if a null packet (PID 0x1FFF) is received with
the bit PUSI (payload_unit_start_indicator) set to “1.” If the PUSI bit is set to 1,
it indicates that the payload of this transport stream packet will commence.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Error Condition: Reports an error if any PID value is not equal to the following:
0x0000 (PAT), 0x0001 (CAT), 0x0002 (TSDT), or in the interval
0x0010–0x1FFF (user-defined).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Error Condition: Reports an error if a packet with PID 0x47 is received.

NOTE. The PID 0x47 error is not a violation of the MPEG-2 standard. However,
you may want to detect PID 0x47 since it can lead to troubles during decoding if
the decoder incorrectly interprets the PID as a sync byte.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports an error if a PID 0x0000 (PAT), 0x0001 (CAT), or
0x1FFF (null/stuffing) packet has a transport_scrambling_control field that does
not equal 00.

Associated ETR 290 recommendation: PAT_error, 1.3.3.

How/where an error is reported: In the ETR 290 view, as a general error message
in the Report view, and in the item Message view, if any.

Error Condition: Reports an error if a PMT PID (described by the PAT) has a
transport_scrambling_control field that does not equal 00. MPEG standards do
not allow scrambled PMT.

Associated ETR 290 recommendation: PMT_error, 1.5.2.

How/where an error is reported: In the ETR 290 view, as a general error message
in the Report view, and in the PMT Message view (if it is open in the Client
view).

Null Packet with PUSI
Probe

Reserved PID Probe

PID 0x47 Probe

Reserved (PAT, CAT, and
Null Packet) PID with

TSC Probe

PMT PID with TSC Probe
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Error Condition: Reports an error if the RTA detects an incorrectly incremented
transport packet continuity_counter. Except for null packets and in cases of
duplicate packets or discontinuities, the continuity counter of each successive
payload-carrying packet of the same PID must increment by one, from 0x0 to
0xF (module 16).

Associated ETR 290 recommendation: Continuity_count_error, 1.4.

How/where an error is reported: The ETR 290 view, the Continuity Counter panel
of the Statistic view (shown below), and the appropriate Message view(s).

NOTE. The Continuity Counter panel displays detected errors on a per-service
basis. Refer to Continuity Counter Panel on page 2–50 for more information
about this panel.

Error Condition: Reports an error if the RTA detects a transport packet adaptation
field PCR_flag set to 0, and if the OPCR_flag is set to 1 (cannot have an OPCR
without a PCR).

Associated ETR 290 recommendation: None.

How/where an error is reported: An error message in the appropriate Message
view(s).

Continuity Counter Probe

PCR/OPCR Flags Probe
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Error Condition: Reports an error if the RTA detects a null packet that has an
adaptation field.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a general error message in the Report view.

Error Condition: Reports an error if the RTA detects no coherence between the
adaptation field control and the adaptation field length. The RTA detects three
error conditions:

� The adaptation_field_control is 00.

� The adaptation_field_control is 10, but the adaptation_field_length is not
equal to 183.

� The adaptation_field_control is 11, but the adaptation_field_length is not in
the range of 0 through 182.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports an error if the RTA detects a transport_error_indicator
field (of a transport packet header) is equal to 1, which indicates that at least one
uncorrectable bit error exists in the associated transport packet.

Associated ETR 290 recommendation: Transport_error, 2.1.

How/where an error is reported: The ETR 290 view, the TEI indicator on the RTA
status bar (refer to Status Bar on page 2–9), and the TP Error Indicator panel of
the Statistic View (refer to TP Error Indicator Panel on page 2–52).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects no coherence between the
adaptation field control and the discontinuity indicator (if the AFC = 10 or 11,
the DI must be set to 1) within the PAT.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Null Packet with ADF
Probe

ADF Flags Probe

Transport Error Indicator
Probe

PAT PID with AFC & DI
Probe

(ATSC only)
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This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects no coherence between the
adaptation field control and the discontinuity indicator (if the AFC = 10 or 11,
the DI must be set to 1) within a PMT.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects PSIP table packet PID with a
transport_scrambling_control field that does not equal 00.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects PSIP table packet PID that
has an adaptation field.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

This analysis probe appears only when the analysis type setting is set to ATSC
(refer to Analysis Panel on page 3–50).

Error Condition: Reports an error if the RTA detects no coherence between the
payload_unit_start_indicator and the pointer field (if the PUSI is 1 then the
pointer field must be set to 0).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

PMT PID with AFC & DI
Probe

(ATSC only)

PSIP Tables PID with TSC
Probe

(ATSC only)

PSIP tables PID with ADF
Probe

(ATSC only)

MGT PID with PUSI &
Pointer Field Probe

(ATSC only)
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Section Syntax Analyses
Use the Section Syntactic Analysis panel of the Settings window (shown below)
to set and remove probes that monitor section syntax. Refer to Analysis:Ad-
vanced:Syntax:Section Panel on page 3–61 for information about using the
Section Syntactic Analysis panel.

The following pages describe the section syntax analyses in the order that they
are listed in the Section Syntactic Analysis panel. Table 3–3 lists the section
syntax analyses, the associated ETR 290 recommendation, the analysis type
setting on the Analysis panel (refer to Analysis Panel on page 3–50), and the
page on which each analysis error is explained.

The RTA notes the presence and nature of each section syntax error in the section
analysis view. Refer to Section Analysis View on page 2–56 for information
about the section analysis view.

Table 3–3: Section syntax analyses 

Analysis probe ETR 290 Analysis type

Section number or version number — All

CRC 2.2 All

Section syntax — All
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Error Condition: Reports an error if one or more of the following section and
version numbering errors are found in a PSI, SI, or PSIP table section:

� Sections received out of order; for example section number 1 arrives before
section number 0

� All sections with the same version number do not have the same last section
number

� The version number is improperly incremented

� The version number increments before the last section of the previous
version number has been received

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports an error if the RTA detects a CRC error in a PSI, SI, or
PSIP table.

Associated ETR 290 recommendation: CRC_error, 2.2.

How/where an error is reported: In the ETR 290 view, and as a syntax error in the
appropriate Message view(s).

Section syntax probes perform a complete analysis of every field in all sections
of the selected table type.

Error Condition: Reports an error if the section syntax of the PSI/SI/PSIP selected
is not corrected.

Associated ETR 290 recommendation: None.

How/where an error is reported: As coloration of the associated Hierarchic view
icon error indicator(s), and as a syntax error in the appropriate Message view(s).

The RTA also notes the presence and nature of each section syntax error in the
section analysis view. Refer to Section Analysis View on page 2–56 for informa-
tion about the section analysis view.

Section Number or
Version Number Probe

CRC Probe

Section Syntax Probe
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Mega Frame Syntax Analyses (DVB-T Only)

NOTE. To access the Mega Frame syntax analyses, you must select the DVB
analysis type with the DVB-T analysis option using the Analysis panel of the
Settings window. Refer to Analysis Panel on page 3–50 for information about
using the Analysis panel.

Use the Mega Frame Syntactic Analysis panel of the Settings window (shown
below) to set and remove probes that monitor Mega Frame syntax. Refer to
Analysis:Advanced:Syntax:Mega Frame Panel on page 3–63 for information
about using the Mega Frame Syntactic Analysis panel.

The following pages describe the Mega Frame syntax analyses in the order that
they are listed in the Mega Frame Syntactic Analysis panel.
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Error Condition: Reports an error if the computed Mega Frame CRC and the
Mega Frame CRC carried in the MIP do not match.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports an error if every field of Mega Frame syntax is not
valid.

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports warnings if the value carried in the time offset function
of a transmitter exceeds the user-defined limits. Three parameters are required for
the probe: transmitter ID (entered in hex), and the minimum and maximum
values (entered in 100 nanosecond units).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports warnings if the value carried in the frequency offset
function of a transmitter exceeds the user-defined limits. Three parameters are
required for the probe: transmitter ID (entered in hex), and the minimum and
maximum values (entered in Hertz).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

Error Condition: Reports warnings if the value carried in the power function of a
transmitter exceeds the user-defined limits. Three parameters are required for the
probe: transmitter ID (entered in hex), and the minimum and maximum values
(entered in 0.1 dBm units).

Associated ETR 290 recommendation: None.

How/where an error is reported: As a syntax error in the appropriate Message
view(s).

CRC Probe

Syntax Probe

Time Offset Probe

Frequency Offset Probe

Power Probe
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Timing Analyses

The RTA provides the following levels of timing analyses.

� PCR timing analyses page 3–29

� PTS/DTS timing analyses page 3–31

� Mega Frame timing analysis (DVB-T only) page 3–32

PCR Timing Analyses
PCR probes monitor the clock references of a selected program for regularity and
precision. When you set a PCR probe in the standard configuration, the RTA
reports a PCR error if one of the following conditions is detected:

� The interval between consecutive PCR packets is greater than 100 ms in
MPEG-2 mode or greater than 40 ms in DVB mode

� The PCR inaccuracy is greater than +/–500 ns

NOTE. The default PCR error limits used by the RTA are consistent with
ETR 290 recommendations. You can change the error limits, if necessary, using
the PCR Timing Analysis configuration panel in the Settings window (refer to
Analysis:Advanced:Timing:PCR Panel on page 3–65).

You can use either of the following methods to set PCR probes:

� Select a PMT icon in the Hierarchic view, right-click to open the shortcut
menu, and then select PCR Probe or View PCR Analysis. To remove the
PCR probe, select PCR Probe a second time from the selected PMT
shortcut menu in the Hierarchic view.

When you select View PCR Analysis, a PCR Analysis view opens in the
Client view and the PCR probe is enabled. Refer to PCR Analysis View on
page 2–61 for information about using the PCR Analysis view.

� Use the PCR Timing Analysis panel of the Settings window (shown on
page 3–30) to configure and set PCR probes one program at a time and, if
desired, use unique error limits for each individual program. You can also set
PCR probes on all stream programs at once, but you must then use the same
measurement error limits for all programs.

Setting PCR Probes
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Refer to Analysis:Advanced:Timing:PCR Panel on page 3–65 for informa-
tion about using the PCR Timing Analysis panel to set PCR probes.

RTA hardware considerations limit the accuracy of PCR analysis. Table 3–4
summarizes the accuracy possible for jitter parameters displayed in the PCR
Analysis view.

NOTE. The RTA uses an internal Settling Filter to improve the accuracy of PCR
jitter analysis. The Settling Filter must have at least 60 seconds of data before
before the RTA can detect and report PCR jitter errors. Wait 60 seconds after
setting a PCR probe to judge the PCR jitter performance or compliance.

Table 3–4: PCR analysis accuracy 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Description

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Frequency Offset readout ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Accuracy ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
�3.0 ppm

ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Drift, typical ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
�1 ppm per year

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Jitter readout and graphical display accuracy, typicalÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Parallel input
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
�30 ns peak

ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ASI input
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�60 ns peak

PCR Analysis Accuracy
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PCR Error Reporting. When a PCR error occurs, the colored indicator above the
affected Hierarchic view PMT icon turns red and a general error message appears
in the Report view. The message also appears on the PMT Message view if it is
open in the Client window.

The RTA also indicates PCR errors in the ETR 290 view (refer to Using the
ETR 290 View on page 2–53) and the PCR Analysis view (refer to PCR Analysis
View on page 2–61).

PTS/DTS Timing Analyses
PTS/DTS probes monitor the time stamps of selected elementary streams for
compliance with the ETR 290 recommended interval of no more than 700 ms
(default setting; you can set a different value) between consecutive PES packets
with non-zero PTS/DTS flags.

NOTE. You can set PTS/DTS probes only on unscrambled elementary streams.

Refer to Analysis:Advanced:Timing:PTS/DTS Panel on page 3–69 for informa-
tion about using the PTS/DTS Timing Analysis panel.
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Setting PTS/DTS Probes. You can use either of the following two methods to set
PTS/DTS probes:

� Select an audio or video elementary stream icon in the Hierarchic view,
right-click to open the shortcut menu, and then select PTS/DTS Probe or
View PTS/DTS Analysis. To remove the PTS/DTS probe, select PTS/DTS
Probe a second time from the selected icon shortcut menu in the Hierarchic
view.

When you select View PTS/DTS Analysis, a PTS/DTS Analysis view opens
in the Client view and the PTS/DTS probe is enabled. Refer to PTS/DTS
Analysis View on page 2–59 for information about using the PCR Analysis
view.

� Use the PTS/DTS Timing Analysis panel of the Settings window (shown on
the previous page) to configure and set PTS/DTS probes one program at a
time and, if desired, use unique error limits for each individual elementary
stream. You can also set PTS/DTS probes on all elementary streams at once,
but you must then use the same measurement error limits for all programs.

Refer to Analysis:Advanced:Timing:PTS/DTS Panel on page 3–69 for
information about using the PTS/DTS Timing Analysis panel.

PTS/DTS Error Reporting. When a PTS/DTS error occurs, the colored indicator
above the affected Hierarchic view elementary stream icon turns red and a
general error message appears in the Report view. The message also appears on
the elementary stream Message view if it is open in the Client window.

The RTA also indicates PTS/DTS errors in the ETR 290 view (refer to ETR 290
View on page 2–53) and the PTS/DTS Analysis view (refer to PTS/DTS Analysis
View on page 2–59).

Mega Frame Timing Analysis (DVB-T Only)
The only specific timing analysis performed on DVB-T streams (in addition to
the regular MPEG-2/DVB rate analyses) is the STS interval check.

Use the STS interval probe to check that the difference between two consecutive
Synchronization Time Stamps carried in the MIP remains within a user-defined
interval, and to report warnings every time the limits are exceeded.

The STS interval probe has two parameters: the Min:  and Max:  values allowed
(expressed in 100 nanosecond units). Typically the STS interval should remain
within the (0.5, 0.61) seconds interval.

Set the STS interval probe using the Mega Frame Timing Analysis configuration
panel in the Settings window (refer Analysis:Advanced:Timing:Mega Frame
Panel on page 3–63).
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Rate Analyses

The RTA provides the following levels of rate analyses.

� Transport rate analysis page 3–33

� Section rate analysis page 3–37

� Mega Frame rate analysis (DVB-T only) page 3–40

Transport Rate Analysis
In transport rate analysis, the RTA calculates the average bit rate of each PID in
the input stream. Transport rate analysis is automatic and cannot be disabled.

The RTA calculates transport rates every 500 ms, but uses a smoothing period for
transport rate averaging. In the default configuration, the RTA averages the
reported transport rate over one second, or two 500 ms sample periods. You can
increase the smoothing period up to 10 seconds using the Analysis panel of the
Settings window. Refer to Analysis Panel on page 3–50 for more information.

In addition to calculating transport rates for every PID in the stream, the RTA
can also monitor selected PIDs and alert you when the transport rate of the
selected PID(s) violates user-specified high and low error limits.

The RTA displays the results of transport rate analysis in the Program Allocation,
PID Allocation, and Type Allocation panels of the Statistic View.

Program Allocation Panel. The Program Allocation panel of the Statistic view
(shown at the top of the next page) shows the bandwidth allocation of the input
multiplex. Both the numeric data and the pie chart update every 500 ms to give a
near-instantaneous report of input stream composition. Double-click on a slice of
the pie chart to change to the PID Allocation panel with the corresponding
program already selected.

Refer to Program Allocation Panel on page 2–43 for more information.

Viewing Transport Rate
Analysis Results
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Service or
program name

Portion of the input
stream used by the
service or program

Transport rate
of the service
or program

Minimum allocation
limit

Maximum allocation
limit

Click to reset previously
detected transport rate errors

Click a button to select
a service or program

Information about each component of
the selected service or program

Transport rate statistics of the
selected service or program
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PID Allocation Panel. The PID Allocation panel of the Statistic view (shown at the
bottom of the previous page) provides a more detailed, program-level view of
input stream bandwidth allocation. The panel also indicates whether or not
transport rate error limits are set and shows rate errors when they occur. Click a
button on the left side of the panel to select a service and see the instantaneous,
previous maximum, and previous minimum multiplex rates for every PID in the
service. As in the Program Allocation panel, all values update every 500 ms.

Refer to PID Allocation Panel on page 2–46 for more information.

Type Allocation Panel. The Type Allocation panel of the Statistic view (shown
below) shows the bandwidth allocation of each PID type in a pie chart display.
Each slice of the pie chart represents a PID type (such as audio, video, or data).
The number of PIDs, the allocation percentage, the minimal and maximal rate
and its current value are displayed for each pie chart slice.
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You can use either of the following two methods to set transport rate probes with
user-defined rate limits on selected stream items:

� Use the Transport Rate Analysis panel of the Settings window

� Use the Program Allocation and PID Allocation panels of the Statistic view

Transport Rate Analysis Panel. You can use the Transport Rate Analysis panel of
the Settings window (shown below) to set probes on selected stream PIDs for
transport rates that fall below or exceed limits of your choosing. You must enter
a high- or low-limit value to add a probe.

Refer to Analysis:Advanced:Rate:Transport Panel on page 3–72 for information
about using the Transport Rate Analysis panel to set transport rate probes.

Program Allocation and PID Allocation Panels. You can use the Program Alloca-
tion and PID Allocation panels of the Statistic view (shown on page 3–34) to set
probes on selected stream PIDs for transport rates that fall below or exceed limits
of your choosing. You must enter a high- or low-limit value to add a probe.

Refer to Program Allocation Panel on page 2–43 and PID Allocation Panel on
page 2–46 for information about using these panels to set transport rate probes.

Setting Transport Rate
Probes
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Section Rate Analysis
Use the Section Rate Analysis panel of the Settings window (shown below) to
specify the maximum acceptable interval between consecutive sub-table sections
of each selected table type. 

NOTE. The Intervals settings determine the threshold for errors reported on the
ETR 290 view. The default settings are consistent with ETR 290 recommenda-
tions. Do not change these settings if you plan to use ETR 290 tests to judge
DVB compliance of the input stream.

Refer to Analysis:Advanced:Rate:Section Panel on page 3–74 for information
about using the Section Rate Analysis panel.

To open a dynamic Section Rate analysis view (shown on page 3–38), select a
stream icon in the Hierarchic view, right click to open the shortcut menu, and
then select View Section Rate. The lower Sub-Table Max Interval graph
indicates section rate errors in red.

Refer to Section Rate View on page 2–58 for more information about using the
Section Rate view.
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Table 3–5 lists each of the section rate probes, the associated ETR 290 recom-
mendation for each applicable probe, and the required analysis type setting (refer
to Analysis Panel on page 3–50).

Table 3–5: Section rate analyses 

Analysis probe ETR 290 Analysis type

Maximum interval between consecutive PAT sub-table sections 1.3.1 All

Maximum interval between consecutive CAT sub-table sections — All

Maximum interval between consecutive TSDT sub-table sections — All

Maximum interval between consecutive PMT sub-table sections 1.5.1 All

Maximum interval between consecutive NIT sub-table sections.
Two probes are available: NIT actual and NIT other.

3.1.2 DVB and
DVB-T

Maximum interval between consecutive SDT sub-table sections.
Two probes are available: SDT actual and SDT other.

3.5.1 DVB and
DVB-T

Maximum interval between consecutive EIT sub-table sections.
Four probes are available for DVB and DVB-T analysis: EIT actual
present-following, EIT other present-following, EIT actual
schedule, and EIT other schedule.
One EIT probe is available for ATSC/PSIP analysis.

3.6.1 DVB, DVB-T,
and
ATSC/PSIP

Maximum interval between consecutive BAT sub-table sections — DVB and
DVB-T
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Table 3–5: Section rate analyses (Cont.)

Analysis probe Analysis typeETR 290

Maximum interval between consecutive TDT sub-table sections 3.8.1 DVB and
DVB-T

Maximum interval between consecutive TOT sub-table sections — DVB and
DVB-T

Maximum interval between consecutive MGT sub-table sections 3.5 ATSC/PSIP

Maximum interval between consecutive TVCT sub-table sections 3.6.1 ATSC/PSIP

Maximum interval between consecutive CVCT sub-table sections 3.6.2 ATSC/PSIP

Maximum interval between consecutive STT sub-table sections 3.3 ATSC/PSIP

Maximum interval between consecutive RRT sub-table sections 3.7 ATSC/PSIP

Maximum interval between consecutive EIT sub-table sections — ATSC/PSIP

Minimum interval between consecutive sections with the same
table ID, table ID extension

3.2 All

Error Condition: Reports an error if the maximum interval between consecutive
sub-table sections of the specified stream item exceeds the value set on the
Section Rate Analysis panel of the Settings window. Refer to Table 3–5 for a list
of section rate probes.

Associated ETR 290 recommendation: Refer to Table 3–5 for a list of associated
ETR 290 recommendations for each stream item.

How/where an error is reported: In the ETR 290 view, as a general error message
in the Report view, and in the appropriate Message view(s).

Error Condition: Reports an error if the minimum interval between consecutive
table sections with the same table ID is less than 25 ms.

Associated ETR 290 recommendation: SI_repetition_error, 3.2.

How/where an error is reported: In the ETR 290 view and as an error message in
the appropriate Message views(s).

NOTE. You cannot change the minimum interval setting from the default (25 ms).

Maximum Interval
Between Consecutive

Sub-Tables Probe

Minimum Interval Between
Consecutive Sections

Probe
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Mega Frame Rate Analysis (DVB-T only)
The only specific rate analysis performed on DVB-T streams (in addition to the
regular MPEG-2/DVB rate analyses) is the measurement of the intervals between
two consecutive MIPs.

Use the MIP interval probe to check that the difference between the PIA time
stamps (the arrival time of the packets) of two consecutive MIPs remains within
a user-defined interval, and to report warnings every time the limits are
exceeded.

The MIP interval probe has two parameters: the Min:  and Max:  values allowed
(expressed in 100 nanosecond units). Typically the MIP interval should remain
within the (0.5, 0.61) seconds interval.

Set the MIP interval probe using the Mega Frame Rate Analysis configuration
panel in the Settings window (refer Analysis:Advanced: Rate:Mega Frame Panel
on page 3–76).
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Configuration

The term “Configuration,” as used in the RTA interface, has the following two
meanings:

1. Configuration is the process of changing one or more of the instrument
settings.

2. A Configuration is also the collection of all hardware and software settings
at any given time; that is, the way the RTA is configured.

The Configuration menu has commands for changing the settings and for saving
and restoring instrument configurations. This section discusses the use of
Configuration menu commands and explains the instrument settings in detail.

� Changing the RTA configuration page 3–42

� Saving and restoring RTA configurations page 3–43

� Configuration panel settings page 3–46

NOTE. RTA settings are saved to the Windows NT registry and automatically
persist from session to session, even if you exit the program and power down the
computer.1 To return all settings to their original states, select Restore Standard
from the Configuration menu.

If your use of the RTA requires many deviations from the “standard” settings,
consider saving a baseline configuration profile that contains the settings that
work for your unique situation. Restoring a baseline can be a convenient
alternative to restoring the standard configuration and then making the
necessary configuration changes.

1 You must log in as the same user. RTA settings made by the user “MTS100” and those made by the administrator are
saved in separate registries. For consistent results, always log in as MTS100. The administrator can create additional

users to permit several people to use the RTA without settings conflicts. To save and restore configuration profiles, a user
must be a member of either the “Backup Operators” group or the “Administrators” group; refer to the Windows NT docu-
mentation for additional information.
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Changing the RTA Configuration
To change the current RTA configuration, perform the following procedure:

1. Select Settings in the Configuration menu. The resulting Settings window
(shown below) has several panels that contain measurement settings and
options for the various RTA functions and views.

2. Select the appropriate configuration category from the Settings window
hierarchy. Each hierarchy item has its own associated configuration panel.

3. Change configuration settings using standard Windows techniques such as
the following:

� Click the appropriate round option button to select among options

� Select or clear a square check box

� Select from a pull-down list of several alternatives

� Enter a new value in a text box

NOTE. Most of the configuration panels have a Restore Default button that you
can click to return all settings on the displayed panel to the settings used in the
RTA standard configuration.

Select hierarchy
items to open

different
configuration

panels
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4. When you have changed all the appropriate settings on one or more
configuration panels, perform one of the following actions:

� Click Apply  on the bottom of the Settings window to confirm and apply
all configuration changes

� Click OK  to confirm and apply all configuration changes and close the
Settings window

� Click Cancel to close the window and cancel all settings changes made
since you opened the window or last clicked Apply

Refer to Configuration Panel Settings, beginning on page 3–46, for complete
information about all options on the Settings window configuration panels.

Saving and Restoring RTA Configurations
Through the Configuration menu, you can perform the following functions:

� Save all of the current RTA configuration settings as a named profile in the
Windows NT registry

� Load a registry profile to restore a previously saved configuration

� Restore the standard, default RTA configuration

To save the current RTA configuration in the Windows NT registry, perform the
following procedure:

1. Select Save as from the Configuration menu to open the Save Configura-
tion window (shown below).

Saving the Current
Configuration
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2. Save the current configuration using one of the following methods:

� Enter a unique name in the Profile name box and click Save to create a
new configuration profile

� Highlight a name on the List of existing profiles and click Save to
overwrite an existing named profile with the current RTA settings

To restore an RTA configuration that has been saved in the current user’s
Windows NT registry, perform the following procedure:

NOTE. RTA analysis must be stopped before you can load a saved configuration.

1. Select Load from the Configuration menu to open the Load Configuration
window (shown below).

2. Highlight the name of the profile that you want to restore (by clicking on the
name in the Profiles list) and then click Load.

NOTE. If a newly loaded configuration calls for a change in the hierarchy icon
size, that change will not occur until you exit and restart the RTA application;
otherwise, there is no need to exit the application.

To restore the standard (default) configuration, stop RTA analysis and select
Restore Standard from the Configuration menu.

NOTE. The Restore Standard command is not available when the RTA is
analyzing an input stream. You must stop analysis before you can restore the
default configuration.

Loading a Saved
Configuration

Restoring the Standard
Configuration
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Perform the following procedure, using the Registry Editor program,
Regedt32.exe, to delete a configuration profile.

1. Open the Windows NT Start menu and select Run. The Run window (shown
below) opens.

2. Type regedt32 in the Open text box and click OK .

3. Select the HKEY_LOCAL_MACHINE on Local Machine  window and
double-click the folder icons to open the path to the RTA profile keys,
HKEY_LOCAL_MACHINE/Software/Tektronix/RTA/2.0/Profiles . The
two named profiles in the following example are “DVB_1” and
“MPEG-2_1.”

4. Highlight the name of the configuration profile to delete and press DEL  (or
select Delete from the Registry Editor Edit menu). A warning message
appears; click Yes to confirm the deletion.

5. Exit the Registry Editor.

Deleting a Saved
Configuration
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Configuration Panel Settings
This section describes and explains the RTA settings on the various configuration
panels available in the Settings window. Each hierarchy item in the Settings
window opens a different configuration panel. Illustrated below is a fully
expanded Settings window hierarchy with page numbers where the associated
configuration panel is described.

page 3–48

page 3–50

page 3–52

page 3–54

page 3–55

page 3–57

page 3–59

page 3–61

page 3–632

page 3–65

page 3–69

page 3–712

page 3–72

page 3–74

page 3–762

page 3–77

page 3–78

page 3–81

page 3–83

page 3–85

page 3–86 (MTS 215 only)

page 3–94

2 This selection is present only when the RTA is in DVB-T analysis mode (refer to Analysis Panel on page 3–50).
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The following elements are always present on the configuration panels in the
Settings window:

Profile. If you have loaded a saved configuration profile (through the Load
command on the Configuration menu), the name of that profile appears in this
box. The background is gray because the profile cannot be changed through the
Settings window.

Hexa Display. Select the Hexa display option to cause the RTA to display most
numeric values in hexadecimal base. Deselect this option to display values in
decimal base. You can also toggle this setting during normal operation by
pressing the F2 function key.

Apply. Click Apply to confirm and apply all configuration changes made since
you opened the Settings window or last clicked Apply. The selected configura-
tion window remains open.

OK. Click OK to confirm and apply all configuration changes and also close the
Settings window.

Cancel. Click Cancel to close the window and cancel all settings changes made
since you opened the window or last clicked Apply.

Common Elements in the
Settings Window
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Select Hardware in the Settings window to open the Hardware configuration
panel (shown below).

The Hardware panel contains the following options for configuring the RTA
input and output:

Input Type. Select either DVB-PI SPI (LVDS //) or ECL//  (parallel) or DVB-PI
ASI (asynchronous serial; the default) to match the type of your input stream.

Select Use DEN signal (available only when parallel input type is selected) to
limit analysis to only those packets that have the Data Enable signal asserted.
This option is disabled in the standard configuration.

Trigger Configuration. The trigger configuration settings apply only if your
instrument contains a Data Store system and you intend to use an external,
TTL-level (0 V to +5 V) signal to start/stop data storage on the RTA Trigger
input. Choose to trigger on either the Rising edge or the Falling edge of the
trigger signal. This trigger setting is noted on the Data Storage configuration
panel. Refer to Data Storage Panel on page 3–86.

Output Level. Select either LVDS or Modified ECL  (the default). Modified ECL
output is nominally 400 mVpp; standard ECL is approximately 700 mVpp.

Hardware Panel
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Number of correct consecutive synchronization bytes to test before indicating that
the synchronization has been found. The choices are 3, 5, 7, or 9 correct
synchronization bytes; the default value is 5 bytes. Click the arrow to the right of
the current value and select the desired value from the resulting list.

Number of bad consecutive synchronization bytes to test before indicating that the
synchronization has been lost. The choices are 1, 3, 5, or 7 correct synchroniza-
tion bytes; the default value is 3 bytes. Click the arrow to the right of the current
value and select the desired value from the resulting list.

Restore Default. Click Restore Default to restore all standard hardware configura-
tion settings.
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Select Analysis in the Settings window hierarchy to open the Analysis configu-
ration panel (shown below).

The Analysis panel contains the following configuration options:

Analysis Type. The Analysis Type setting determines which standard the RTA
uses to monitor the input stream.

� Select MPEG-2 (the default) if the stream you are analyzing complies with
the MPEG standard but not DVB or ATSC.

� Select DVB to analyze stream compliance with DVB standards.

Two of the analysis options, DVB-T  and SIDAT 360, are available only
when you select the DVB analysis type. Three of the Settings panels—Mega
Frame Syntax, Mega Frame Timing, and Mega Frame Rate—are available
only when you select the DVB analysis type and the DVB-T analysis option.

� Select ATSC to analyze the stream with regard to the ATSC standards.

Analysis Panel



Configuration

MTS 200 Series Real-Time Analyzer User Manual 3–51

Analysis Options. The first two analysis options are available for all three
analysis types.

� Select Ghost scanning to cause the RTA to attempt to define all ghost
packets3 found in the stream. For example, if the RTA identifies a ghost
packet as a PMT, the RTA positions the icon under the PAT as shown in the
following illustration. You can then perform on the ghost sections all the
analyses allowed on PMT sections, such as Section syntax analysis and PCR
analysis.

A PMT Ghost

� Select Smoothing time to adjust the period over which the RTA averages the
transport rates reported in the Statistic view Program Allocation, PID
Allocation, and Type Allocation panels. The default value is one second; you
can enter any integer value from 1 to 10. In most cases, selecting a longer
smoothing time reduces the range over which reported transport rates vary.

The following analysis options are available only when you select DVB analysis
(in the Analysis type portion of this settings panel).

� Select DVB-T  to enable Mega Frame analysis. Three of the Settings
panels—Mega Frame Syntax, Mega Frame Timing, and Mega Frame
Rate—are available only when you select the DVB analysis type and the
DVB-T analysis option.

� Select SIDAT 360 data broadcasting analysis to enable SIDAT analysis
and the two SIDAT 360 Profiles options:

� The following two SIDAT 360 Profiles are available only after you select
the SIDAT 360 data broadcasting analysis option. You can enable both
options simultaneously. Refer to SIDAT 360 Analyses on page 3–6 for more
information.

Select Multiprotocol Encapsulation to enable protocol encapsulation
testing for SIDAT 360 analysis. Select Data Carousel to enable RTA
monitoring of data carousel presence.

Restore Default. Click Restore Default to restore all standard Analysis panel
configuration settings.

3 One or more packets found in the transport stream but not referenced in any appropriate table.
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Select Analysis:Program in the Settings window hierarchy to open the Program
Analysis configuration panel (shown below).

NOTE. Programs in the Probed Programs list and their monitoring parameters
can appear in italics on this panel. If a Probed Program is listed in italics, then
at least one probe of the corresponding program is not set. This can happen if
you have already set specific probes for this program using the Advanced
configuration panels in the Settings window. If a probe parameter is in italics,
that indicates that the probe is partially set. Use this panel to activate all probes
and set all monitoring parameters for a selected program.

The Program Analysis panel contains the following configuration options:

Program. The Program box contains a list of all programs in the input stream. If
your stream contains many programs, use the scroll bar to view all programs.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Probed Programs. The Probed Programs box contains a list of probed programs
along with the program name. Refer to Probe Operating Conventions on
page 3–4 for instructions on setting, changing, and removing probes.

Analysis:Program Panel
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Absence of Referenced PID Delay. This box allows you to enter a delay value
between 1 and 10 seconds.

NOTE. The PCR Interval and the PCR Jitter Max and Min settings determine
thresholds for errors reported on the ETR 290 view. The default settings are
consistent with ETR 290 recommendations. Do not change these settings if you
plan to use ETR 290 tests to judge DVB compliance of the input stream.

PCR Interval. These settings specify the maximum permissible interval between
consecutive PCRs. When a PCR probe is active, the RTA reports an error when
the interval between two consecutive PCRs for the monitored program exceeds
the applicable (DVB or MPEG-2) value. The default for DVB mode is 40 ms;
the default for MPEG-2 and ATSC modes is 100 ms.

PCR Jitter. The Max and Min settings specify the maximum permissible
deviation from the expected PCR value. When a PCR probe is active, the RTA
reports an error when the deviation falls outside of the Max and Min  values. The
default for all analysis modes is +500 ns/–500 ns.

The Frequency offset setting determines the threshold for frequency offset
errors. The default for all analysis modes is 30 ppm.

The Drift rate max  setting determines the threshold for frequency drift rate
errors. The default for all analysis modes is 10 ppm/hr.

NOTE. The PTS/DTS Interval and the PMT Section Rates Interval settings
determine thresholds for errors reported on the ETR 290 view. The default
settings are consistent with ETR 290 recommendations. Do not change these
settings if you plan to use ETR 290 tests to judge DVB compliance of the input
stream.

PTS/DTS Interval. This box allows you to change the PTS/DTS interval if
necessary. The default value is 700 ms.

PMT Section Rates Interval. This box allows you to change the maximum interval
for PMT section rates if necessary. The default value is 500 ms.
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Select Analysis:ETR 290 in the Settings window hierarchy to open the ETR 290
configuration panel (shown below).

NOTE. ETR 290 probes in the Probes List box can appear in italics on this panel.
If an ETR 290 probe is listed in italics in the Probe List, then at least one probe
of the corresponding ETR 290 recommendation is not set. This can happen if you
have already set specific probes for the ETR 290 recommendation using the
Advanced configuration panels in the Settings window. Use this panel to activate
all probes for a selected ETR 290 recommendation.

The ETR 290 panel contains the following configuration options:

Probe Type. The Probe Type box contains a list of the available ETR 290 probes.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Probes List. The Probes List box contains a list of the selected ETR 290 probes.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Analysis:ETR 290 Panel
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Select Analysis:Advanced:Multiplex in the Settings window hierarchy to open
the Multiplex Analysis configuration panel (shown below).

NOTE. The Multiplex Analysis panel is one of several panels used for setting and
configuring RTA probes. The probes available on this panel apply to the entire
input stream multiplex and are appropriate to the current Analysis settings panel
selections.

The Multiplex Analysis panel contains the following configuration options:

Probe Type. The Probe Type box contains a list of the available multiplex probes.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Probes List. The Probes List box contains a list of the selected multiplex probes.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Analysis:Advanced:
Multiplex Panel
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Available Multiplex Probes. Table 3–6 lists all of the probes that you can control
through the Multiplex Analysis panel. Some probes are only available for certain
analysis types.

Table 3–6: Multiplex analysis probes 

Probe title Analysis type ETR 290 level

Absence of referenced PID All 1.6

Program not defined in PAT All —

Same PID in elementary stream and in PMT All —

Scrambling without CAT All 2.6.1

Ghost packet All 3.4

Unsynchronized packet All 1.2

Table ID PAT
CAT
NIT
TSDT
SDT
EIT
RST
TDT
TOT
MGT
TVCT
CVCT
STT
RRT

All
All
All
All
DVB only
DVB only
DVB only
DVB only
DVB only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only
ATSC/PSIP only

1.3.2
2.6.2
3.1.1
—
3.5.2
3.6.2
3.7
3.8.2
—
—
—
—
—
—

Inter SI consistency DVB and DVB-T —

Mega Frame Size DVB-T only —

Terrestrial descriptor consistency DVB-T only —

Program paradigm ATSC/PSIP only —

Scrambled ES without CA descriptor ATSC/PSIP only —

Absence of mandatory EIT ATSC/PSIP only —

Refer to Multiplex Analyses beginning on page 3–9 for detailed information
about the Multiplex Analysis probes.
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Select Analysis:Advanced:Syntax in the Settings window hierarchy to open the
Syntactic Analysis configuration panel (shown below). The Syntactic Analysis
panel contains options that affect private section interpretation and syntax error
reporting.

Analysis:Advanced:
Syntax Panel



Configuration

3–58 MTS 200 Series Real-Time Analyzer User Manual

The Syntactic Analysis panel contains the following configuration options:

General Configuration. There are two possible general configuration settings:

� The Maximum number of errors by entity setting allows you to set the
maximum number of errors the RTA detects before stopping analysis for one
entity. This limits the number of syntax errors reported by the RTA for each
entity. This option is convenient when you are analyzing non-compliant
streams that contain many errors.

� The Map private section as DVB section option appears only when you
have set the analysis type to DVB through the Analysis panel (refer to
Analysis Panel on page 3–50).

When you select Map private section as DVB section (a check appears in
front of the option), the RTA attempts to interpret all private sections
encountered in the stream as DVB SI sections. The option is not present in
the standard configuration, which has MPEG-2 monitoring selected.

NOTE. The Map private section as DVB section option is cleared when you first
specify DVB monitoring on the Analysis panel; select this option if necessary to
force the RTA to interpret PIDs 0x10 through 0x14 as SI.

Private Syntax. You can load user-defined private syntax definition (.cta) files
through the Private Syntax portion of the panel. These files, generated with the
Private Syntax Interpreter application, make it possible to analyze proprietary or
non-standard tables and descriptors contained in the RTA input stream.

Refer to Appendix C for more information about using the Private Syntax
Interpreter and generating user-defined private syntax definition files.
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Select Analysis:Advanced:Syntax:Transport in the Settings window hierarchy
to open the Transport Syntactic Analysis configuration panel (shown below). Use
this configuration panel to set and configure RTA transport syntax probes.

The Transport Syntactic Analysis panel contains the following configuration
options:

Probe Type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Probe List. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Analysis:Advanced:
Syntax:Transport Panel
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Available Transport Syntax Probes. Table 3–7 lists all of the probes that you can
control through the Transport Syntactic Analysis panel. Some probes are only
available for certain analysis types. Refer to Setting Probes on page 3–4 and
Removing Probes on page 3–5 for instructions on setting and removing probes.

Table 3–7: Transport syntax probes 

Probe title Analysis type ETR 290 level

Null packet with PUSI All —

Reserved PID All —

PID 0x47 All —

Reserved (PAT, CAT, and Null packet) PID with TSC All 1.3.3

PMT PID with TSC All 1.5.2

Continuity counter indicator All 1.4

PCR/OPCR flags All —

Null packet with ADF All —

ADF flags All —

Transport error indicator All 2.1

PAT PID with AFC & DI ATSC/PSIP only —

PMT PID with AFC & DI ATSC/PSIP only —

PSIP tables PID with TSC ATSC/PSIP only —

PSIP tables PID with ADF ATSC/PSIP only —

MGT PID with PUSI & pointer field ATSC/PSIP only —

Refer to Transport Syntax Analyses beginning on page 3–18 for detailed
information about any of the transport syntax probes.
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Select Analysis:Advanced:Syntax:Section in the Settings window hierarchy to
open the Section Syntactic Analysis configuration panel (shown below). Use this
configuration panel to set and configure RTA section syntax probes.

The Section Syntactic Analysis panel contains the following configuration
options:

Probe Type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Probe List. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Analysis:Advanced:
Syntax:Section Panel
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Available Section Syntax Probes. Table 3–8 lists all of the probes that you can
control through the Section Syntactic Analysis panel. Some probes are only
available for certain analysis types. Refer to Setting Probes on page 3–4 and
Removing Probes on page 3–5 for instructions on setting and removing probes.

Table 3–8: Section syntax probes 

Probe title Analysis type ETR 290 level

Section number or version number All —

CRC All 2.2

Section syntax All —

Refer to Section Syntax Analysis beginning on page 3–24 for detailed informa-
tion about any of the section syntax probes.
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Select Analysis:Advanced:Syntax:Mega Frame in the Settings window
hierarchy to open the Mega Frame Syntactic Analysis configuration panel
(shown below). Use this configuration panel to set and configure RTA mega
frame syntax probes.

NOTE. The Mega Frame Syntactic Analysis panel is available only when you
have specified DVB-T analysis on the Analysis settings panel (refer to Analysis
Panel on page 3–50).

The Mega Frame Syntactic Analysis panel contains the following configuration
options:

Probe Type. The Probe Type box contains a list of the available probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Probe List. The Probe List box contains a list of the selected probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Analysis:Advanced:
Syntax:Mega Frame Panel
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Available Mega Frame Syntax Probes. Table 3–9 lists all of the probes that you
can control through the Mega Frame Syntactic Analysis panel. Some probes are
only available for certain analysis types. Refer to Setting Probes on page 3–4 and
Removing Probes on page 3–5 for instructions on setting and removing probes.

Table 3–9: Mega Frame syntax probes 

Probe title Analysis type ETR 290 level

CRC DVB-T only —

Syntax DVB-T only —

Time offset DVB-T only —

Frequency offset DVB-T only —

Power DVB-T only —

Refer to Mega Frame Syntax Analyses beginning on page 3–26 for information
about any of the Mega Frame syntax probes.
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Select Analysis:Advanced:Timing:PCR in the Settings window hierarchy to
open the PCR Timing Analysis configuration panel (shown below). Use the PCR
Timing Analysis panel to configure and set PCR probes one program at a time
and, if desired, use unique error limits for each individual program. You can also
set probes on all stream programs at once, but you must then use the same
measurement error limits for all programs.

PCR Analysis Accuracy. RTA hardware considerations limit the accuracy of PCR
analysis. Table 3–10 summarizes the accuracy possible for jitter parameters
displayed in the PCR Analysis view.

NOTE. The RTA uses an internal Settling Filter to improve the accuracy of PCR
jitter analysis. The Settling Filter must have at least 60 seconds of data before
before the RTA can detect and report PCR jitter errors. Wait 60 seconds after
setting a PCR probe to judge the PCR jitter performance or compliance.

Analysis:Advanced:
Timing:PCR Panel
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Table 3–10: PCR analysis accuracy 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Characteristic ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Description
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Frequency Offset readout ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Accuracy
Drift, typical

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�3.0 ppm
�1 ppm per year

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Jitter readout and graphical display accuracy, typicalÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Parallel input
ASI input

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

�30 ns peak
�60 ns peak

The PCR Timing Analysis panel contains the following configuration options:

Program Number. Use the Program Number box to select individual programs or
all programs to probe. Refer to page 3–67 for instructions on setting, changing,
and removing PCR probes.

Table Identity. The Table Identity box contains a list of the selected programs.
Refer to page 3–67 for instructions on setting, changing, and removing PCR
probes.

NOTE. The PCR Interval and the PCR Jitter Max and Min settings determine
thresholds for errors reported on the ETR 290 view. The default settings are
consistent with ETR 290 recommendations. Do not change these settings if you
plan to use ETR 290 tests to judge DVB compliance of the input stream.

PCR Interval. These settings specify the maximum permissible interval between
consecutive PCRs. When a PCR probe is active, the RTA reports an error when
the interval between two consecutive PCRs for the monitored program exceeds
the applicable (DVB or MPEG-2) value. The default for DVB mode is 40 ms;
the default for MPEG-2 is 100 ms.

PCR Jitter. The Max and Min settings specify the maximum permissible
deviation from the expected PCR value. When a PCR probe is active, the RTA
reports an error when the deviation falls outside of the Max and Min  values. The
default for all analysis modes is +500 ns/–500 ns.

The Frequency offset setting determines the threshold for frequency offset
errors. The default for all analysis modes is 30 ppm.

The Drift rate max  setting determines the threshold for frequency drift rate
errors. The default for all analysis modes is 10 ppm/hr.
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Mask Discontinuities. Under normal circumstances, the RTA uses every PCR
value in the stream to build the accuracy model that is used to judge the jitter of
each newly decoded PCR. Occasional discontinuities (large PCR errors due to
looped input, for example) can prevent creation of a valid model and hinder PCR
analysis. Select Mask discontinuities to ignore very inaccurate4 PCRs, both for
error reporting and for calculating the PCR jitter model.

Refer to PCR Timing Analysis on page 3–29 for more information about PCR
analysis and PCR probes.

Restore Default. Click Restore Default to restore all standard PCR analysis
configuration settings. New settings take effect when you click OK  to close the
Settings window.

Setting PCR Probes on Programs. To set PCR Probes on programs, perform the
following procedure:

1. Select individual programs or all programs using the Program number box.

a. To select individual programs, perform the following:

� Be sure to use the current numeric base; for example, you would
enter the hexadecimal number 0x64 when Hexa display is selected,
but 100 (the decimal equivalent) when the Hexa display check box
is cleared.

� When analysis is ongoing, you can select a program number from
the drop-down list box by first clicking the down arrow symbol.

b. To select all programs, select the ALL  check box (to the right of the
Program number box).

2. Change the PCR Interval and PCR Jitter settings as necessary. The
changes will apply to the selected program(s) only. Refer to PCR Interval
and PCR Jitter on page 3–66 for additional information.

NOTE. The PCR Interval and the PCR Jitter Min and Max settings determine
thresholds for errors reported on the ETR 290 view. The default settings are
consistent with ETR 290 recommendations. Do not change these settings if you
plan to use ETR 290 tests to judge DVB compliance of the input stream.

3. Click Add to enter the program(s) and error limits in the Table identity list.

4. If you are selecting individual programs, repeat steps 1 through 3 for all the
programs you intend to monitor.

4 The difference between the expected PCR value (interpolated from previous values) and the decoded PCR value is greater
than 1.0 ms.
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5. When the correct program information appears in the Table identity list,
click Apply  to confirm the settings and activate the PCR probes; click OK  if
you also want to close the Settings window.

NOTE. Adding a probe to the Table identity list does not start the probe/analysis;
you must also click Apply or OK.

Changing PCR Probe Settings. Perform the following procedure to change PCR
probe error limits without removing and resetting the probe.

1. Select (highlight) the probe in the Table identity list.

2. Change the PCR Interval and  PCR Jitter settings as desired.

3. Click Add. The error limit change appears in the Table identity list.

4. Click Apply  to change the PCR probe error limits; click OK  if you also
want to close the Settings window.

Removing PCR Probes. Use the following procedure to remove one or more PCR
probes through the PCR Timing Analysis panel:

1. Remove the probe(s) from the Table identity list.

� To remove a single probe from the list, highlight the probe in the Table
identity  list and then click Remove. (You can also remove a probe by
double-clicking the Table identity entry.)

� To remove several probes from the list at one time, highlight each probe
name in the Table identity list and then click Remove. To highlight
several contiguous names, click the first name and then hold the SHIFT

key down while selecting the last name; to highlight non-contiguous
names, hold the CTRL  key down while making your selections.

� To remove all probes from the list, click either Remove all or Restore
default.

2. To confirm your selections, deactivate the probes, close the Settings window,
and click OK ; to confirm your selections and deactivate the probes while
leaving the Settings window open, click Apply.

NOTE. Removing a probe from the Table identity list does not end the probe/
analysis; you must also click Apply or OK.
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Select Analysis:Advanced:Timing:PTS/DTS in the Settings window hierarchy
to open the PTS/DTS Timing Analysis configuration panel (shown below). Use
the PTS/DTS Timing Analysis settings panel to set and configure PTS/DTS
probes on one or more of the unscrambled video and audio elementary streams in
the multiplex.

The PTS/DTS Timing Analysis panel contains the following configuration
options:

Program Number. Use the Program Number box to select individual programs or
all programs to probe. Selecting a program number activates the With referenced
elementary stream PID box. Refer to Probe Operating Conventions on page 3–4
for instructions on setting, changing, and removing probes.

Table Identity. The Table Identity box contains a list of the selected programs.
Refer to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

With Referenced Elementary Stream PID. This box is activated when you select a
program in the Program number box. Use this box to select elementary stream
PIDs to reference with the selected program.

Analysis:Advanced:
Timing:PTS/DTS Panel
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NOTE. The PTS/DTS Interval setting determines thresholds for errors reported
on the ETR 290 view. The default settings are consistent with ETR 290 recom-
mendations. Do not change these settings if you plan to use ETR 290 tests to
judge DVB compliance of the input stream.

PTS/DTS Interval. This box allows you to change the PTS/DTS interval if
necessary. The default value is 700 ms.
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Select Analysis:Advanced:Timing:Mega Frame in the Settings window
hierarchy to open the Mega Frame Timing Analysis configuration panel (shown
below). Use this panel to set the STS interval probe.

NOTE. The Mega Frame Timing Analysis panel is available only when you have
specified DVB-T analysis on the Analysis settings panel (refer to Analysis Panel
on page 3–50).

Use the STS interval probe is to check that the difference between two consecu-
tive Synchronization Time Stamps carried in the MIP remains within a user-
defined interval, and to report warnings every time the limits are exceeded.

The STS interval probe has two parameters: the Min:  and Max:  values allowed
(expressed in 100 nanosecond units). Typically the STS interval should remain
within the (0.5, 0.61) seconds interval.

You must enter a Min:  and/or Max:  value to add the STS interval probe. Refer
to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Analysis:Advanced:
Timing:Mega Frame Panel
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Select Analysis:Advanced:Rate:Transport in the Settings window hierarchy to
open the Transport Rate Analysis configuration panel (shown below).

NOTE. The RTA automatically performs transport rate analysis whenever you
analyze an input stream. Transport rate analysis results appear in the Program
Allocation, PID Allocation, and Type Allocation panels of the Statistic view.

Use this Transport Rate Analysis panel to set probes on selected stream items for
transport rates that fall below or exceed limits of your choosing. You must enter
a limit value to add a probe.

You can also set and remove transport rate probes through the Hierarchic view
and the Statistic view. Refer to Transport Rate Analysis on page 3–33 for more
information.

The Transport Rate Analysis panel contains the following configuration options:

Rate Interval Check In. This box contains the list of stream object types available
for you probe.

Probe List. This box contains the list of user-defined transport rate probes.

Analysis:Advanced:
Rate:Transport Panel
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Rate Interval Check. Use the Low limit and High limit boxes to set user-defined
transport rate interval values. You must enter a limit value to add a probe.

Setting User-Defined Transport Rate Probes. To set user-defined transport rate
probes through the Transport Rate Analysis panel, perform the following steps:

1. In the Rate Interval Check In list, select (highlight) the type of stream
object that you want to monitor. When appropriate, an additional With PID
or With program number drop-down list box appears below the Rate
Interval Check In list as shown below.

2. If necessary, select a PID or Program from the new list box or click All  to
select all items in the list.

3. Enter the desired error threshold(s) in the Low Limit  and High Limit  fields.
If you do not want to set either a low or high limit, leave that field blank.
You must enter at least one limit to add a probe.

4. Click Add to enter the stream item and limits in the Probe List.

5. Repeat steps 1 through 4 for all items that you want to check for user-defined
low or high transport rate errors.

6. To begin monitoring the selected items for transport rate errors, click Apply ;
to begin monitoring and also close the Settings window, click OK .

Changing a User-Defined Transport Rate Probe. Perform these steps to change one
or both of the user-defined error thresholds for a stream item:

1. Click on (highlight) the item entry in the Probes List. The existing limits for
the selected probe appear in the Low Limit  and High Limit  fields.

2. Change the Low Limit  and High Limit  as desired. To remove a threshold
(the list entry becomes “Not defined”), double-click in the field and then
press DELETE .

3. Click Add to enter the new limits in the Probe List.

4. To begin monitoring with the new transport rate error limits, click Apply ; to
begin monitoring and also close the Settings window, click OK .
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Removing a User-Defined Transport Rate Probe. To remove user-defined transport
rate probes using the Transport Rate Analysis panel, perform the following steps:

1. To remove one user-defined transport rate probe, click on (highlight) the
item in the Probe List that you want to remove, and then click Remove or
double-click the item.

2. To remove all user-defined transport rate probes, click Remove All.

3. To begin monitoring with the new transport rate error limits, click Apply ; to
begin monitoring and also close the Settings window, click OK .

Select Analysis:Advanced:Rate:Section in the Settings window hierarchy to
open the Section Rate Analysis configuration panel (shown below). Use this
panel to specify the maximum acceptable interval between consecutive sub-table
sections of each table type and the minimum interval between consecutive
sections. User-defined intervals appear on the ETR 290 Detailed view. Refer to
ETR 290 Detailed View on page 2–54 for more information.

NOTE. The Analysis Type setting in the Analysis configuration panel controls
which stream items appear in the Probe Type list. Refer to Analysis Panel on
page 3–50.

Analysis:Advanced:
Rate:Section Panel
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The Section Rate Analysis panel contains the following configuration options:

Probe Type. This box contains the list of available section rate probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

Probe List. This box contains the list of user-defined section rate probes. Refer to
Probe Operating Conventions on page 3–4 for instructions on setting, changing,
and removing probes.

NOTE. The two Intervals settings listed below determine the threshold for errors
reported on the ETR 290 view. The default settings are consistent with ETR 290
recommendations. Do not change these settings if you plan to use ETR 290 tests
to judge DVB compliance of the input stream.

Intervals. The Intervals box contains the following two available options:

� When you select a section rate probe from the Probe Type list, the ETR 290
recommended value for the Maximum interval between consecutive
sub-tables is displayed. You can enter a user-defined value if necessary.

� The Minimum interval between consecutive sections with the same table
ID, table ID extension box displays that 25 ms is the minimum permissible
interval between consecutive sections. This interval value cannot be changed
by the user.

Restore Default. Click Restore Default to restore all standard section rate
analysis interval values.
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Select Analysis:Advanced:Rate:Mega Frame in the Settings window hierarchy
to open the Mega Frame Rate Analysis configuration panel (shown below). Use
this panel to set the MIP interval probe.

NOTE. The Mega Frame Rate Analysis panel is available only when you have
specified DVB-T analysis on the Analysis settings panel (refer to Analysis Panel
on page 3–50).

Use the MIP interval probe to check that the difference between the PIA time
stamps (the arrival time of the packets) of two consecutive MIPs remains within
a user-defined interval, and to report warnings every time the limits are
exceeded.

The MIP interval probe has two parameters: the Min:  and Max:  values allowed
(expressed in 100 nanosecond units). Typically the MIP interval should remain
within the (0.5, 0.61) seconds interval.

You must enter a Min:  and/or Max:  value to add the MIP interval probe. Refer
to Probe Operating Conventions on page 3–4 for instructions on setting,
changing, and removing probes.

Analysis:Advanced:
Rate:Mega Frame Panel
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Select View in the Settings window hierarchy to open the View configuration
panel (shown below). Use this view to turn the RTA Report window on or off
when you start the RTA application.

The View panel contains the following configuration options:

Default View On Start. Select or deselect the Report view to be visible when the
RTA application is started. When cleared, this option causes only the Hierarchy
and Client windows to occupy the RTA application window when you start the
RTA application.

Restore Default. Click Restore Default to restore the standard view selection.

View Panel
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Select View:Report in the Settings window hierarchy to open the Report View
configuration panel (shown below). Use this view to set options that apply to all
Message views.

The Report View panel contains the following configuration options:

Log Messages. Select the Log messages in event viewer option to log all events
detected by the RTA to the Windows NT Event Viewer. Clear the option to
prevent RTA error and message logging. Event Viewer is selected in the default
configuration.

NOTE. The Event Viewer is set during software installation to overwrite
application log events as needed. This can result in lost information when
monitoring an input stream that contains many errors. However, selecting
another Event Viewer log wrapping option can result in buffer overflow and can
freeze the RTA. You can increase the size of the Event Viewer application log but
do not change the log wrapping setting without good reason.

For further information about the Event Viewer, refer to Messages and the Event
Viewer on page 2–37. Also consult the Windows NT documentation and the
Event Viewer online Help.

View:Report
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Display. The Display portion of the panel gives you the opportunity to limit the
types of messages displayed and logged to the Event Viewer (if Event Viewer is
selected).

� Selected by default, Information messages alert you to input stream events
that are not considered errors, but may be important to your stream analysis.
These events include as PSI and SI table updates, the presence of ghost
(unreferenced) packets, and error disappearance. Clear the Information
messages check box to prevent the display and logging of these information
events.

� Error messages, also selected by default, inform you of all errors detected in
the input stream. The number and types of errors detected by the RTA
depend, in part, on your selections in the various configuration panels of the
Settings window.

� TDT and TOT Update message is not selected in the standard configura-
tion. Select this option to see and log information messages that report TDT
(time and date table) and TOT (time offset table) updates.

� STT update messages is only valid when ATSC/PSIP mode is selected in
the Analysis configuration panel (refer Analysis Panel on page 3–50).

� DSMCC Multiprotocol Update messages is valid only when SIDAT 360
mode is selected in the Analysis configuration panel (refer Analysis Panel on
page 3–50). Select this option to inform you of errors and events detected in
a SIDAT 360 stream. Deselect this option when the message rate is too high.

� Data Carousel Module Update messages is valid only when SIDAT 360
mode is selected in the Analysis configuration panel (refer Analysis Panel on
page 3–50). Select this option to inform you of errors and events detected in
a SIDAT 360 stream. Deselect this option when the message rate is too high.

� EMM Update message. This option is also cleared in the standard
configuration. Select EMM Update message to see and log information
messages that report EMM (Entitlement Management Message) updates.
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Messages. The Messages portion of the panel contains display and logging
options that affect all messages.

� The Maximum number of configurations option sets the maximum
number of configurations the Report window displays. The default number
of configurations is 10. Select Put all messages in the same configuration
to limit the number of Report window configurations to one.

� The Maximum number of messages by sub-part of the report view
option allows you to limit the number of messages that any Message view
can contain. The maximum includes those messages that have scrolled off
the top of the current message window or window pane; use the vertical
scroll bar to see the messages that will not fit in the display window (you
may have to press F3 to pause view updates when monitoring a stream with
many errors). When a Message view reaches the specified maximum, the
oldest message is discarded as each new message appears. The default
maximum is 50 messages.

This setting does not affect the capacity of the Windows NT Event Viewer
application log.

� Select Only one message with the same event id in Event Viewer to limit
the amount of message detail logged to the Event Viewer.

The RTA posts only one general message for each event ID in the Message
views. In reality, a Message view entry can represent many error or
information messages. In the standard configuration, all information or error
detail represented by the general message is logged to the Event Viewer.

Double-clicking on the message opens a window that provides access to the
event details. If the Only one message with the same event id in Event
Viewer Only option is selected, only one message would appear in the
Event viewer messages window for each event ID.

NOTE. When you monitor a stream that contains many items with many errors,
logging all details can delay the appearance of messages in the Message views
and quickly fill the Event Viewer application log. To log only general messages
in the Event viewer, select the Only one message with the same event id in
Event Viewer option.
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Select View:Hierarchical  in the Settings window hierarchy to open the
Hierarchical View configuration panel (shown below). Use this view to set
options that apply only to the Hierarchic view.

The Hierarchical View panel contains the following configuration options:

Tree Options. Tree options provide two hierarchical display options:

� Select Big Icons (the default setting) to cause the RTA to use the larger of
the two available icon sizes in the Hierarchic view. See the following screen
captures for a comparison of the two icon sizes.

Clear the Big Icons selection to use small icons. This setting change will not
take effect until you exit and restart the RTA application.

Big hierarchy icons Small hierarchy icons

View:Hierarchical Panel
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� Select More information  to control the Hierarchic view display of
additional information to the right of the standard icon information. During
normal operation, you can press F6 to toggle this selection. The More
information  option is not selected in the standard configuration.

The standard configuration:

With More information selected:

Number of Levels to Display. This option controls how many hierarchy levels are
shown in the Hierarchic view. Click the arrow to reveal the choices; each choice
includes the keyboard F-key equivalent, which you can use to expand or collapse
the hierarchy during normal operation. The default selection is 1 F7, which
displays only the top level of the hierarchy. See the following examples.

Select 1  F7 or press F7 to hide all
but the top-level hierarchy items.

Select 2  F8 or press F8 to show
only the top two hierarchy levels.

Select 4  F10 or press F10 to
show all items in the hierarchy.

Restore Default. Click Restore Default to restore the standard selections.
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Select View:Graphics in the Settings window hierarchy to open the Graphics
View configuration panel (shown below). Use this view to set options that
determine how the RTA updates the various analysis graphs.

In the standard configuration, scrolling is disabled for all graph types.

View:Graphics Panel
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The Graphics View panel contains the following configuration options:

Scrolling Option. When scrolling is disabled for a graph, the passage of time is
indicated with a moving cursor that moves from left to right. The most recent
data are immediately to the left of the cursor; the oldest data are immediately to
the right of the cursor.

Newest
data

Oldest
data

Scrolling disabled

Newest
data

Oldest
data

Scrolling enabled

When scrolling is enabled for a graph, the cursor disappears after the first sweep
and the data itself then moves from right to left on the graph as if the right border
of the graph has become the cursor. The most recent data are at the right end of
the graph; the oldest data continually scroll off the left end.

Background Graduation Option. Select this option to enable or disable Statistic
view background gradation.

Restore Default. Click Restore Default to restore the standard selections.
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Select View:PID Allocation  in the Settings window hierarchy to open the
PID Allocation View configuration panel (shown below). Use this panel to select
which PIDs are displayed in the PID Allocation panel when Selection is selected
(refer to PID Allocation Panel on page 2–46). You will free RTA resources by
limiting the number of displayed PIDs.

When you click the Selection button in the PID Allocation panel, the PIDs
referenced in this PID Allocation View panel are displayed. You can add and
remove PIDs from the PID Allocation panel by performing a drag-and-drop
action on stream icons between the Hierarchic view and the PID Allocation panel
in the Client view. Doing so will automatically update this configuration panel.

The PID Allocation View panel contains the following configuration options:

Pick PID to Display with the Selection Option of the PID Allocation View. 

� Select Display all PID to display all PIDs

� Select Display selected PID to enable the lower portion of the panel where
you select which PIDs to display

Only the Following Selected PIDs are Displayed. This portion of the panel becomes
active only after you have selected Display selected PID in the above option.
You can then select an individual PID number from the top list box or you can
select a group of PIDs from the bottom list box.

Restore Default. Click Restore Default to restore the standard selections.

View:PID Allocation Panel
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Select Data Storage in the Settings window hierarchy to open the Data Storage
configuration panel (shown below). This panel is present only in the MTS 215,
which contains both the RTA and the Data Store system. Use the Data Storage
settings to select the method of initiating data storage, the conditions that will
stop data storage, and how much of the input stream is to be captured.

Refer to Capturing Input Streams (MTS 215 only) on page 2–96 for complete
instructions on how to capture input streams.

The Data Storage panel contains the following configuration options:

Start Condition. A Data Storage Start condition initiates RTA data acquisition
mode. When the RTA is in acquisition mode, the specified portion of the input
stream preceding, following, or including the first-encountered Stop condition
(or “storage event”) is saved to a file.

The Manual Start condition is always active. In the default RTA configuration,
you must initiate data acquisition by selecting Start from the Data Storage menu
or by clicking the Start acquisition toolbar button.

Select Use Trigger (Rising/Falling edge) to also make it possible to initiate
acquisition with a rising or falling TTL-level signal applied to the RTA Trigger
input. The selection between a rising- or falling-edge trigger signal is set using
the Hardware configuration panel and its setting appears after Use Trigger. Refer
to Hardware Panel on page 3–48 for additional information.

Data Storage Panel
(MTS 215 Only)
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Stop Conditions. Select one or more Stop conditions that, when detected or
encountered during data acquisition, will cause the input data to be stored in an
event trace file.

You can select one or more of the following Stop conditions:

� External TTL-level trigger

� All level 1 ETR 290 tests

� Individual level 1 ETR 290 tests

� All level 2 ETR 290 tests

� Individual level 2 ETR 290 tests

� All level 3 ETR 290 tests conducted by the RTA

� Individual level 3 ETR 290 tests

NOTE. A selected Stop condition must be detected by the RTA to cause data
storage. Always confirm that the related analysis or probe is enabled before
beginning data acquisition. To confirm that a ETR 290 test is enabled, open the
ETR 290 view and verify that the test indicator is colored green, orange, or red
(not gray).

The Manual Stop condition cannot be disabled, so you can always select Stop
from the RTA Data Storage menu or click the Stop acquisition toolbar button to
end data acquisition mode. No other Stop conditions are enabled in the default
configuration.

Continuous Acquisition. Data acquisition ends in the default configuration when
the RTA saves the event trace file. However, a Stop condition event does not end
data acquisition when you select Continuous acquisition. Instead, the RTA
continues to monitor the input stream in data acquisition mode and attempts to
save an event trace file for every Stop condition encountered. You must manually
stop acquisition when continuous acquisition is enabled.
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To select Stop conditions,

1. If necessary, click the appropriate “+” box to expand the hierarchy and then
click the hard disk icon of the desired Stop condition. You can click the
“ETR 290 tests: Level n” icon to select all ETR 290 tests in the level.

NOTE. You can move the highlight within the Stop Condition hierarchy with the
keyboard arrow keys. You can also expand one level of the hierarchy with the
“+” numeric keypad key, open the entire hierarchy with the “*” keypad key, and
close the hierarchy with the “–” keypad key. The exact effect of these keystrokes
depends on the context; experiment and practice to become proficient at
keyboard hierarchy navigation.

A green check mark appears on the disk icon to show that the Stop condition
is selected. A gray check mark appears on the parent “ETR 290 tests: Level
n” disk icon to show that one of the tests in that level is selected.

You can also select Stop conditions by selecting Enable event trace when
the desired test is highlighted in the Stop conditions hierarchy.

By default, the event trace data are stored on the Single shot Data Store
partition. The file is specified in the File name text box. You can enter an
alternate file name and you can click Browse to save the data onto the
system disk. Refer to File Name on page 3–89 for additional information.

2. Once you have selected a Stop condition, specify the desired amount of input
stream to capture before and after the data storage event. By default, the
event trace data are the 5 000 048 Bytes of input received before the Stop
condition occurs. Refer to Specifying Trace Size Before and After the Event
on page 3–90 for more information.
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3. Repeat steps 1 and 2 for each Stop condition that you want to detect and
trace.

4. Select Continuous acquisition, if appropriate, to save event trace files for
more than one Stop condition event.

5. Click OK  at the bottom of the Settings window to confirm all Data Storage
settings and close the window.

File Name. The event trace file can contain input data received before the Stop
condition event, after the event, or both before and after the event. If the Stop
condition is an ETR 290 error, you can later examine the event trace file with the
Deferred Time Analyzer application to determine the causes or effects of the
error.

� An event trace file name is automatically assigned when you select a Stop
condition. For example, the file name for an ETR 290 1.1 (TS_sync_loss)
error trace is ETR11nn.trp, where “nn” is a hexadecimal number assigned
when the file is created. When the first ETR 290 1.1 error is detected, the
RTA saves ETR1100.trp. File names increment (ETR1101.trp,
ETR1102.trp, etc.) for each subsequent data capture. To force the file names
to begin again at 00, you must delete all Data Store event trace files with the
same root name (ETR11*.trp, for example) and then, through the RTA
Configuration menu, restore the standard configuration or load another
configuration that was saved when the counters were 00.

� By default, event trace files are saved to the Single Shot partition of the Data
Store disks, which is also visible in Windows NT as C:\Carb0\Mono. You
can choose instead to save event trace files to the system disk. To save data
to the C:\Mts200\Cfg-trp directory, for example, click Browse (to the right
of the File name field) and then click the Open button in the resulting Open
window. The path then appears in the file name field.

� You can enter an alternate name for the event trace file; the RTA automatical-
ly uses the first six characters of the name and appends the appropriate
sequence number (nn = 00, 01, 02, ...) when it saves the file. For best results,
always delete all previous trace files that pertain to the same event and restart
the RTA application before saving under a new name. Use only alphanumer-
ic characters or an underscore in the file name. The data store system cannot
transfer files to other disks if the file name contains characters such as “–”
(hyphen), “ ” (space), “.” (period), or “+” (plus).

Enable Event Trace. When you click Enable event trace, the selection status
(selected or not selected) of the currently highlighted Stop condition toggles.
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Ask Before Saving. Select Ask before saving to display the following window
when the stop condition is encountered.

Specifying Trace Size Before and After the Event. The default event trace file
contains the five Mbytes of input received immediately before the event. You can
configure the RTA to save as much or as little data before and after the event as
you like, limited only by the size of the Single Shot partition. You can change
the Before Event and After Event file sizes with the following techniques:

� Select the most convenient units (Seconds, Bytes, or Packets) and then enter
the quantity. Notice that changing the selection from Bytes to Packets or to
Seconds converts the quantity into the correct units. You can select Seconds
only when analysis is occurring; you cannot select Seconds when PID based
filtering is selected on the Output Filtering configuration panel (refer to
Output Filtering on page 3–94).

� Click Max to enter the entire Single Shot Data Store partition.

� Click Center Trace to enter half of the Single Shot partition size in the
Before Event field and half of the partition size in the After Event field.

� Click Reset to deselect the error condition and clear Enable event trace,
restore the default file name, and restore the default event trace sizes.

NOTE. When the RTA detects a stop condition, it must communicate with the data
store system to initiate the actual saving of an event trace file. Under normal
circumstances, this communication takes approximately 0.5 seconds. Therefore,
if you want to save the packet that contains a triggering ETR 290 error, do not
set the Before Event value to less than 0.5 seconds of input data. The default
value, 5 Mbytes, is adequate for most input streams.
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Data Storage Examples. The following numbered examples assume that the RTA
is analyzing an input stream.

1. To capture a set portion of the input stream:

a. On the Output Filtering settings panel, select No PID filtered.

b. On the Data Storage settings panel, click Reset All, change the Manual
Stop Before Event value to 0 (zero), and the After Event value to the
desired duration (seconds) or size (bytes).

c. Click OK  to confirm the settings and close the Settings window.

d. Through the Data Storage menu (or with the corresponding command
button), start data storage.

e. To trigger data storage, select Stop from the Data Storage menu or click
the corresponding toolbar button. The RTA saves the specified portion of
the input stream to the file MnStopnn.trp on the single shot partition of
the data store disks (nn is a hexadecimal number that increments as
succeeding manual stop files are saved). A message appears in the
General message view when the entire MnStopnn.trp file is saved.

NOTE. During RTA data storage, the test system must first acquire the event
trace data and then rewrite that data to a contiguous file at the beginning of the
free space on the data store disks.5 As a result, the time required to save an event
trace file—from stop condition detection to the appearance of the “Data are
stored...” message—can be up to twice the time required to acquire the event
trace data.

Remember, you can configure the RTA to pass input directly through to the
parallel output, and you can capture that data directly with the Data Store
Administrator application. Capturing a large file (that does not begin or end
with a particular ETR 290 error) directly with the Data Store Administrator can
require much less time than using RTA data storage to capture the same file.
Because the Data Store Administrator and RTA can run simultaneously, you can
still monitor and analyze the input with the RTA as you are capturing it on the
data store disks.

2. To capture the 5 Mbytes of data immediately preceding the first level 1
ETR 290 error in the stream:

a. Select ETR 290 view from the View menu and then click Detailed.
Confirm that all Priority 1 tests are active (no indicators are gray).

b. On the Output Filtering settings panel, select No PID filtered.

5 Refer to the MTS200 Series MPEG-2 DVB/ATSC System Analyzer User Manual, Tektronix part number 071-0532-XX, for
additional information about file management on the data store disks.
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c. On the Data Storage settings panel, click Reset All and then click the
“ETR 290 tests: Level 1” disk icon. A green check mark appears on the
icon to indicate that all level 1 tests are designated as stop conditions.

d. Click OK  to confirm the settings and close the Settings window.

e. Select Start from the Data Storage menu (or click the Start acquisition
toolbar button).

When the next Priority 1 ETR 290 error is detected, the RTA stops data
acquisition and saves the 5 Mbytes of input that immediately preceded the
error. The event trace file is ETRLv1nn.trp on the Single shot Data Store
partition.

3. To monitor the input for an extended period and capture only the PSI and SI
tables immediately preceding and following an NIT_error (ETR 290 3.1.1),
an SDT_error (ETR 290 3.5.2), or an EIT_error (ETR 290 3.6.2):

a. Select ETR 290 view from the View menu and then click Detailed.
Confirm that NIT_error (ETR 290 3.1.1), SDT_error (ETR 290 3.5.2),
and EIT_error (ETR 290 3.6.2) tests are active.

b. On the Output Filtering settings panel, select PID based filtering; if
necessary, click Remove All to clear the Selected PIDs list; highlight
PSI in the left-hand list and click the Add button; highlight SI in the
left-hand list and again click Add.

c. On the Data Storage panel, click Reset All; then, in the Stop conditions
list, click the “+” box next to the “ETR 290 tests: Level 3” disk icon.

d. Click the “3.1.1 NIT_error: ...” Stop condition (hard disk) icon; a green
check mark appears on the icon. Then change the Before Event and
After Event values to 20 Packets. (First click the Packets button, then
enter 20 in the text box.)

e. Repeat step d for both the “3.5.2 SDT_error: ...” and the “3.6.2
EIT_error: ...” Stop conditions.
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f. Select Continuous acquisition and then click OK  on the bottom of the
Settings window to confirm all your settings and close the window.

g. Select Start from the Data Storage menu (or click the Start acquisition
toolbar button).

If you let the RTA monitor the input stream for an extended period
(overnight, for example), it will capture and store only PSI and SI table
sections received immediately before and after any of the selected errors.

� Event trace files for a ETR 290 3.1.1 error are stored on the Single
shot partition of the Data Store disks as ETR311nn.trp.

� Files for ETR 290 3.5.2 errors are named ETR352nn.trp.

� Files for ETR 290 3.6.2 errors are named ETR362nn.trp.

In each of the above file names, “nn” is a hexadecimal number that is 00
for the first file saved and increments for each subsequent file with the
same root name (ETR352, for example).

h. To stop acquisition, select Stop from the Data Storage menu (or click the
Stop acquisition toolbar button).

i. The RTA saves the last 5 Mbytes of acquisition to MnStopnn.trp, also on
the Single shot Data Store partition.
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Select Output Filtering  in the Settings window hierarchy to open the Output
Filtering configuration panel (shown below). Use this panel to enable PID-based
filtering, in which only selected PIDs are passed to the parallel output. On an
MTS 215, you can use these settings to select and limit the portion of the input
stream that is captured to the Data Store disks during data storage.

The Output Filtering panel contains the following configuration options:

No PID Filtered. Select the default option, No PID filtered, to pass the entire
input stream to the parallel output during analysis and to capture all input stream
items during data storage.

PID Based Filtering. When you select PID based filtering, only the transport
packets whose PIDs you have added to the Selected PIDs list are passed to the
parallel output or captured.

Output Filtering Panel
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Adding PIDs. There are several ways to add PIDs to the Selected PIDs list:

� Enter a PID directly into the upper list box and click the adjacent (up-
per)Add button. Numeric entry must be hexadecimal (for example, 0x10)
unless you have cleared the Hexa display check box. If you clear the check
box, you must enter the decimal value of the PID (16, for example, instead
of 0x10).

� Select an individual PSI or SI PID from the upper list box and click the
upper Add button. The choices are 0x0 (PAT), 0x1 (CAT), 0x10 (NIT), 0x11
(SDT), 0x12 (EIT), 0x13 (RST), and 0x14 (TDT).

� Select a program from the lower list box and click the adjacent (lower)Add
button. The RTA automatically adds the PIDs of the program-defining PMT
and all elementary streams and ECM sections in the program to the Selected
PIDs list.

� Select PSI or SI from the lower list box and click the lower Add button. The
RTA automatically adds the PIDs of all PSI or SI tables in the stream to the
Selected PIDs list.

Removing PIDs. To remove a single PID from the Selected PIDs list, either
highlight the PID and click Remove or simply double-click the PID. To remove
all PIDs from the list, click Remove All.

Restore Default. Click Restore Default to restore the standard selections.
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Appendix A: ETR 290 Measurements

The DVB Measurement Guidelines (ETR 290) have been issued by the
DVB-MG group. This document provides guidelines for measurement in Digital
Video Broadcasting (DVB) satellite, cable and terrestrial and related digital
television systems. The document is designed to define a number of measure-
ment techniques, such that the results obtained are comparable when the
measurements are carried out in compliance with the appropriate definition.

Chapter 5 of ETR 290 recommends and defines tests at the Transport Stream
level. The recommendations are grouped into three categories of importance:

� First priority: necessary for decodability (basic monitoring)

� Second priority: recommended for continuous or periodic monitoring

� Third priority: application-dependent monitoring

The Real-Time Analyzer (RTA) performs most first, second, and third priority
ETR 290 measurements at user request. Table A–1 lists the measurements
recommended in ETR 290 and indicates how the RTA performs each one.

Table A–1: ETR 290 tests in the RTA 
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Table A–1: ETR 290 tests in the RTA (Cont.)

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

Not
performed

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

User-
requested

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

Automatic

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Test name

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Test number
ÁÁÁÁÁ
ÁÁÁÁÁ

3.4 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Unreferenced PID ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

�
ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁ
3.5 ÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁ
SDT error ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

�
ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁ
3.6

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

EIT error
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

�

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁ3.7
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁRST error

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ�

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

3.8
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

TDT error
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

�

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁ
3.9 ÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁ
Empty buffer error ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

�

ÁÁÁÁÁ
ÁÁÁÁÁ

3.10 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Data delay error ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

�

Tests 3.3, 3.9, and 3.10 concern the T-STD (the hypothetical Transport Stream
System Target Decoder) and are too computation-intensive to be performed by
the Real-Time Analyzer. You can perform T-STD analysis with the deferred-time
analyzer that is part of the MTS 215 if you first capture part of the input stream
to the Data Store disks. Refer to the MTS200 Series MPEG-2 System Analyzer
User Manual for more information.

First Priority Measurements
The DVB-MG has identified the ETR 290 first priority parameters as .necessary
for decodability.

Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte (SyncByte), whose
content is always the hexadecimal value 0x47. In the MPEG-2 decoder, the
SyncByte serves for synchronization with the packetized transport stream. DVB
recommendations define synchronism such that a sequence of at least five
SyncBytes has to be detected by the MPEG-2 decoder. Synchronism is lost if the
SyncBytes in a sequence of at least three TS packets are not detected according
to the DVB recommendations. This status is referred to as TS_Sync_Loss.

TS_Sync_Loss is the only ETR 290 parameter that is always monitored by the
Real-Time Analyzer.

TS_Sync_Loss (1.1)
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Error Precondition. In the DVB Measurement Guidelines (ETR290), the
preconditions for a TS_Sync_Loss message is as follows:

Indicator Precondition Reference
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hysteresis parameters
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ISO/IEC 13818-1:
Sub clause 2.4.3.3 /
annex G.01

Each packet of the transport stream is preceded by a header consisting of four
bytes. The first byte of the header is the synchronization byte (SyncByte), whose
content is always the hexadecimal value 0x47. In the MPEG-2 decoder the
SyncByte serves for synchronization with the packetized transport stream. If the
SyncByte is missing or contains errors too often, the decoder will not be able to
synchronize to the transport stream. The MPEG test decoder checks the Sync
Byte of every packet in the transport stream for correct contents.

Error Precondition. The precondition for a Sync_Byte_Error message is defined
in ETR 290 as follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
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ISO/IEC 13818-1:
Sub clause 2.4.3.3

RTA Configuration. To configure the RTA to monitor for Sync_byte errors,
activate the following probe:

ETR 290 Probe name Settings window panel

1.2 Unsynchronized Packet Error Analysis:Multiplex

The Program Association Table (PAT) contains a list of all programs and PIDs
contained in the transport stream and of associated PMTs (Program Map Tables),
which contain detailed program descriptions. The PAT is of key importance for
decoding TV and audio programs. If the PAT is not available or contains an
error, the MPEG-2 decoder will not be able to select and decode a program from
the transport stream multiplex.

The syntactic structure of a PAT is comprehensively defined in MPEG-2 systems
(ISO/IEC 13818–1). The PAT is exclusively transmitted in packets with PID
0x0000. The table may be divided into a maximum of 256 sections with the table
index (table_id) of each section being 0x00.

Sync_byte_error (1.2)

PAT_error (1.3)
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Error Precondition. The preconditions for a PAT_Error message are defined in
ETR 290 as follows:

Indicator Precondition Reference
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PID 0x0000 does not occur at least every 0.5
seconds

A PID 0x0000 does not contain a table_id
0x00 (that is, a PAT)

Scrambling_control_field is not 00 for PID
0x0000
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ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4

RTA Configuration. To configure the RTA to monitor for PAT errors, activate the
following probes:

ETR 290 Probe name Settings window panel

1.3.1 Maximum Interval Between Consecutive PAT
Sections

Analysis:Rate:Section

1.3.2 Table ID Error (PAT) Analysis:Syntax:Section

1.3.3 Reserved PID with TSC Error Analysis:Syntax:Transport

Each packet of the transport stream is preceded by a header consisting of four
bytes. The fourth byte of the header contains the count of a four-bit continuity
counter. The count must be increased by one for every packet of the transport
stream that has the same PID. The count may consist of values ranging from 0 to
15; beyond 15, it will start from 0 again (modulo-16 counter). The continuity
counter serves to recognize packets of a video or audio program that are either
missing or repeated more than once.

The MPEG-2 standard also tolerates counter discontinuity, provided this is
indicated by a discontinuity indicator in the optional adaptation field (AF) of the
same packet. This method is used primarily for the suppression of error messages
when changing programs preceded by remultiplexing of the transport stream.

In the case of null packets (packets that do not contain any useful data but have a
PID of 0x1FFF), continuity is not checked, since the value of the continuity
counter in zero packets is not defined in the MPEG-2 standard.

Continuity_count_error
(1.4)
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Error Precondition. The preconditions for a Continuity_Count_Error_Error
message are defined in ETR 290 as follows:

Indicator Precondition Reference
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Incorrect packet order

A packet occurs more than twice

Lost packet
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ISO/IEC 13818-1:
Sub clauses 2.4.3.2,
2.4.3.3

RTA Configuration. To configure the RTA to monitor for continuity count errors,
activate the following probe:

ETR 290 Probe name Settings window panel

1.4 Continuity Counter Error Analysis:Syntax:Transport

The PMT (Program Map Table) is a table for detailed program descriptions
referenced in the PAT. As essential information for the MPEG-2 decoder, it
contains the PIDs of all packets of the individual TV, audio, and data streams
(elementary-stream PIDs) as well as the PIDs of packets serving for the
transmission of PCR values associated with the program. Like the PAT, the PMT
is of key importance for decoding TV and audio programs. If PMT is not
available or contains an error, the MPEG-2 decoder will not be able to select and
decode a program from the transport stream multiplex.

The syntactic structure of a PMT is defined in MPEG-2 systems (ISO/IEC
13818-1). In contrast to the PAT, the PIDs of the individual PMTs are variable;
MPEG-2 permits values ranging from 0x0010 to 0x1 FFE (compare to DVB
ETS 300468: 0x0020 to 0x1 FFE). The table may be divided into a maximum of
256 sections with one section for each program. The table index (table_id) of
each section must be 0x02.

Error Precondition. ETR290 states the preconditions for a PMT_Error message as
follows:

Indicator Precondition Reference
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Sections with table_id 0x02, (that is, a PMT),
do not occur at least every 0.5 sec on the
PID, which is referred to in the PAT

Scrambling_control_field is not 00 for all
PIDs containing sections with table_id 0x02
(i.e. a PMT)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
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ISO/IEC 13818-1:
Sub clauses 2.4.3.3,
2.4.4.4, 2.4.4.8

PMT_error (1.5)



Appendix A: ETR 290 Measurements

A–6 MTS 200 Series Real-Time Analyzer User Manual

RTA Configuration. To configure the RTA to monitor for PMT errors, activate the
following probes:

Probe name Settings window panel

Maximum Interval Between Consecutive PMT Sections Analysis:Rate:Section

PMT PID with TSC Error Analysis:Syntax:Transport

The PMT (Program Map Table) entries reveal the elementary-stream PIDs that
are contained in the transport-stream multiplex. To decode a program with the
corresponding PID, these packets must be contained in the transport stream, and
for the MPEG-2 decoder to function error-free these packets also need to be
transmitted at certain intervals. The DVB Measurement Guidelines speak of a
user-specified period, which means that it can be freely selected by the user. The
default value used by the RTA is 1 second; you can change this value when you
set the “Absence of reference PID” probe through the Multiplex Analysis
configuration panel of the Settings window (refer to Analysis:Advanced:Multi-
plex Panel on page 3–55).

Error Precondition. ETR 290 states the precondition for a PID_Error message as
follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PID_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Referred PID does not occur for a user-spe-
cified period

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ISO/IEC 13818-1:
Sub clause 2.4.3.8

RTA Configuration. To configure the RTA to monitor for PID errors, activate the
following probe:

ETR 290 Probe name Settings window panel

1.6 Absence of Referenced PID Error Analysis:Multiplex

Second Priority Measurements
The DVB-MG recommends “continuous or periodic” monitoring of second
priority ETR 290 parameters.

The second byte of every packet header in the transport stream contains the
transport_error_indicator, which is a flag that serves to indicate bit errors in the
following packet. This flag is generated and inserted by the Viterbi or Reed-Sol-
omon decoder at the receiver end if the decoder is no longer capable of correct-
ing all bit and byte errors in the transport stream.

PID_error (1.6)

Transport_error (2.1)
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Because it is not possible in the case of a set transport_error_indicator to predict
which bit or byte contains an error, this packet must not be evaluated by an
MPEG-2 decoder. For this reason, the MPEG test decoder only indicates the
Transport_Error, which means that the packet is not checked for further transport
stream errors.

Error Precondition. ETR 290 states the precondition for a Transport_error
message as follows:

Indicator Precondition ReferenceÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Transport_error
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Transport_error_indicator in the TS-Header
is set to ’1’.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clauses 2.4.3.2 /
2.4.3.3

RTA Configuration. To configure the RTA to monitor for non-zero Transport_Er-
ror_indicator fields, activate the following probe:

ETR 290 Probe name Settings window panel

2.1 Transport Error Indicator Analysis:Syntax:Transport

If program-specific information (PSI tables such as PAT, CAT, PMT, NIT, EIT,
SDT, BAT, and TOT) is transmitted, a value for checking the check sum of this
section is inserted at the end of each table section. The CRC (Cyclic Redundancy
Check) is used for calculating the check sum at the transmitter and receiver end.
Combined with the additionally transmitted CRC value, the check sum for each
table section must be zero.

If the resulting check sum does not equal zero, the MPEG-2 decoder must reject
the information contained in this table.

If a CRC_error is detected, it cannot be predicted which part of the information
contained in the table is not correct. In this case, the MPEG test decoder signals
the CRC_error, but the transport stream is not checked for further errors, which
are derived from the faulty content of this table (for example, a search for PMT
PIDs from a PAT or ES PIDs from a PMT).

CRC_error (2.2)
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Error Precondition. ETR 290 states the precondition for a CRC_Error message as
follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

CRC_error ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC error occurred in CAT, PAT, PMT, NIT,
EIT, BAT, SDT or TOT table

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.4 /
annex B

ETS 300 468:
Sub clause 5.2

RTA Configuration. To configure the RTA to monitor for CRC errors, activate the
following probe:

ETR 290 Probe name Settings window panel

2.2 CRC Error Analysis:Syntax:Section

In every transport stream, coded time values derived from the system time clock
are transmitted so that the MPEG-2 decoder can link its own timing to the coder
system timing in order to decode the input stream. Each program contained in
the transport stream may have its own independent program system timing. The
Program Map Table (PMT) identifies the PID of the transport packets that
contain the PCR (Program Clock Reference) values used by the particular
program.

The specified packets contain the optional Adaptation Field in which 42 bit PCR
values are transmitted. The 42 bits contain two parts: a 33 bit PCR base and a
9-bit PCR extension. The following formulas hold for the bit structure:

PCR base (i) = (system clock frequency × t(i) DIV 300 ) % 233

PCR extension (i) = (system clock frequency × t(i) DIV 1 ) % 300

PCR (i) = (PCR base (i) × 300 ) + PCR extension (i)

A 42-bit PCR value coded this way starts again from count 0 after the elapse of
233 × 300 clocks (corresponding to a time period of approximately 26.5 hours at
27 MHz).

The MPEG-2 standard also tolerates discontinuity of PCR values following one
another, provided this is indicated by the discontinuity indicator in the optional
adaptation field (AF) of the same packet. This method is primarily used for the
suppression of PCR error messages when changing programs preceded by
remultiplexing of the transport stream.

PCR_error (2.3)
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Error Precondition. ETR 290 states the preconditions for a PCR_Error message as
follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
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PCR_error ÁÁÁÁÁÁÁÁÁÁÁÁ
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PCR discontinuity of more than 100 ms
occurring without specific indication

Time interval between two consecutive PCR
values more than 40 ms

ÁÁÁÁÁÁÁ
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ISO/IEC 13818-1:
Sub clauses 2.4.3.4 /
2.4.3.5

ISO/IEC 13818-4:
Sub clause 9.11.3

ETR 154: Sub clause
4.5.4

The specified intervals are the default values of the RTA. You can change the
intervals, however, on the PCR Analysis tab of the Settings window, available
through the Settings command of the RTA Configuration menu.

RTA Configuration. To configure the RTA to monitor for PCR errors, activate the
following probe:

ETR 290 Probe name Settings window panel

2.3 PCR Timing Analysis1 Analysis:Timing:PCR2

1 This probe also monitors the selected program(s) for PCR_accuracy errors.
2 Can also activate through Hierarchic view PMT shortcut menus.

The DVB Measurement Guidelines also recommend additional monitoring of the
accuracy of the PCR values transmitted. Accuracy of PCR values may be
impaired by inaccurate calculation of the 42-bit PCR word width or by errors
during modification of PCR values in a remultiplex.

NOTE. The term accuracy in this case does not refer to absolute frequency
accuracy of the 27 MHz system timing, but to the fluctuation width of the PCR
values of a program, which is caused by the above mentioned errors.

Error Precondition. ETR 290 states the precondition for a PCR_accuracy_Error
message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PCR_accuracy_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PCR accuracy of selected program is not
within ±500 ns

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.2.2

PCR_accuracy_error (2.4)
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RTA Configuration. To configure the RTA to monitor for PCR_accuracy errors,
activate the following probe:

ETR 290 Probe name Settings window panel

2.4 PCR Timing Analysis1 Analysis:Timing:PCR2

1 This probe also monitors the selected program(s) for PCR errors.
2 Can also activate through Hierarchic view PMT shortcut menus.

Presentation Time Stamps (PTS values) in the PES headers are transmitted by
transport stream packets of a program. They enable the MPEG-2 decoder to
identify the exact time that a transmitted data block (picture for video streams
and beginning of an audio sequence for audio streams) is to be presented. The
time stamps are transmitted with a word width of 33 bits and relate to the
27 MHz system timing sequence transmitted in the transport stream together
with the PCR values.

Error Precondition. ETR 290 states the precondition for a PTS_Error message as
follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
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PTS_error
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PTS repetition period more than 700 ms
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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ISO/IEC 13818-1:
Sub clauses 2.4.3.6 /
2.4.3.7 / 2.7.4

RTA Configuration. To configure the RTA to monitor for PTS errors, activate the
following probe:

ETR 290 Probe name Settings window panel

2.5 PTS/DTS Timing Analysis Analysis:Timing:PTS/DTS1

1 Can also activate through Hierarchic view Audio and Video stream shortcut menus.

If encrypted data are contained in a packet of the transport stream, this must be
indicated in the packet header (2nd byte) within the field that is two bits wide
and is labeled transport_scrambling_control. The individual values indicate the
following:

Value (binary) Description

00 No encrypted data contained in the
packet

01, 10, 11 Defined by user

PTS_error (2.5)

CAT_error (2.6)
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If encrypted data are to be transmitted, the MPEG-2 standard recommends the
additional transmission of the tables containing the encryption data (Conditional
Access Table, CAT) in separate packets with (0x0001) as PID and 0x01 as table
index.

The MPEG-2 standard prescribes that packet header including the optional
adaptation fields must not be transmitted in encrypted form. According to DVB
specifications (ETS 300 468), the same applies to tables containing service
information (SI tables PAT, PMT, NIT, EIT, BAT, TDT, TOT, and SDT). The
only exception to this rule is the EIT (Event Information Table) when program
overviews are transmitted.

Error Precondition. ETR 290 states the preconditions for a CAT_Error message as
follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
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CAT_error
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Packets with transport_scrambling_control
not 00 present, but no section with table_id =
0x01 (that is, a CAT) present

Section with table_id other than 0x01 (that
is, not a CAT) found on PID 0x0001

ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁ

ISO/IEC 13818-1:
Sub clause 2.4.4

RTA Configuration. To configure the RTA to monitor for CAT errors, activate the
following probes:

ETR 290 Probe name Settings window panel

2.6.1 Scrambling without CAT Error Analysis:Multiplex

2.6.2 CAT Table ID Error Analysis:Syntax:Section
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Third Priority Measurements
The RTA continuously monitors the following third priority parameters. You can
check the three remaining third priority parameters with the MTS 215 Deferred-
Time Analyzer application.

These types of service information (SI) are also inserted into the transport stream
as additional data (multiplex) and contain items such as the current date, time,
and description of the TV program. Each of these tables is transmitted in the
form of packets with a given packet number (PID) and must be contained in the
transport stream at certain intervals according to the DVB specification.
However, not every SI has a different PID; packets for TDT and TOT as well as
SDT and BAT have identical PIDs. These tables are differentiated by an entry in
the table header, the so-called table index (table_id). This table_id enables an
MPEG-2 decoder working in compliance with the DVB standard to identify the
type of service information with which it is dealing.

Table A–2 is an overview of the service information according to ETS 300 468.
In the standard configuration, the RTA uses these values. You can change the
maximum interval for each table type using the Section Rate Analysis configura-
tion panel of the Settings window (refer to Analysis:Advanced:Rate:Section
Panel on page 3–74). Do not change any Maximum interval settings, however, if
you plan to use ETR 290 tests to judge DVB compliance of the input stream.

Table A–2: Overview of service information defined in ETS 300 468 

Service Information PID [hex] Table_id [hex] Max. interval [sec]

NIT 0x0010 0x40, 0x41, 0x42 10

SDT 0x0011 0x42, 0x46 2

BAT 0x0011 0x4A 101

EIT 0x0012 0x4E to 0x4F,
0x50 to 0x6F

22

RST 0x0013 0x71 —

TDT 0x0014 0x70 30

TOT 0x0014 0x73 30

Stuffing Table 0x0010 to 0x0013 0x72 —
1 Only if present.
2 For the current transport stream multiplexer.

NIT_error (3.1)
SDT_error (3.5)
EIT_error (3.6)

RST_error (3.7)
TDT_error (3.8)
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Error Precondition. ETR 290 states the preconditions for NIT_error, SDT_error,
EIT_error, RST_error, or TDT_error messages as follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
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NIT_error ÁÁÁÁÁÁÁÁÁÁÁÁ
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Section with table_id other than 0x40 or
0x41 or 0x72 (that is, not an NIT or ST)
found on PID 0x0010

No section with table_id 0x40 or 0x41 (for
example an NIT) in PID value 0x0010 for
more than 10 sec

ÁÁÁÁÁÁÁ
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ETS 300 468:
Sub clause 5.2.1

ETR 211: Sub clauses
4.1, 4.4
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Sections with table_id = 0x42 (SDT, actual
TS) not present on PID 0x0011 for more than
2 sec

Sections with table_ids other than 0x42,
0x46, 0x4A or 0x72 found on PID 0x0011
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ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4
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EIT_error
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Sections with table_id = 0x4E (EIT-P/F,
actual TS) not present on PID 0x0012 for
more than 2 sec

Sections with table_ids other than in the
range 0x4E - 0x6F or 0x72 found on PID
0x0012
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ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4
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RST_error ÁÁÁÁÁÁÁÁÁÁÁÁ
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Sections with table_id other than 0x71 or
0x72 found on PID 0x0013
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ETS 300 468:
Sub clause 5.1.3ÁÁÁÁÁÁÁ
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TDT_error
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Sections with table_id = 0x70 (TDT) not
present on PID 0x0014 for more than 30 sec

Sections with table_id other than 0x70, 0x72
(ST) or 0x73 (TOT) found on PID 0x0014

ÁÁÁÁÁÁÁ
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ETS 300 468:
Sub clause 5.1.3

ETR 211: Sub clauses
4.1, 4.4

RTA Configuration. To configure the RTA to monitor for SI Table ID errors,
activate the following probes:

ETR 290 Probe name Settings window panel

3.1.1 NIT Table ID Error Analysis:Syntax:Section

3.5.2 SDT Table ID Error Analysis:Syntax:Section

3.6.2 EIT Table ID Error Analysis:Syntax:Section

3.7 RST Table ID Error Analysis:Syntax:Section

3.8.2 TDT Table ID Error Analysis:Syntax:Section
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To configure the RTA to monitor for NIT, SDT, EIT, RST, and TDT Repetition
errors, activate the following probes:

ETR 290 Probe name Settings window panel

3.1.2 All NIT section rate probes Analysis:Rate:Section

3.5.1 All SDT section rate probes Analysis:Rate:Section

3.6.2 All EIT section rate probes Analysis:Rate:Section

3.8.1 All TDT section rate probes Analysis:Rate:Section

The ETR211 standard prescribes minimum and maximum intervals for the
repetition of individual packets; Table A–3 lists the values for service informa-
tion (SI). The RTA uses these values in the standard configuration. You can
change the maximum interval for each table type using the Section Rate Analysis
panel of the Settings window (refer to Analysis:Advanced:Rate:Section Panel on
page 3–74). Do not change any Maximum interval settings, however, if you plan
to use ETR 290 tests to judge DVB compliance of the input stream.

Table A–3: SI repetition rates according to DVB 

Service information
Maximum interval
(complete table)

Minimum interval
(individual sections)

PAT 0.5 s 25 ms

CAT 0.5 s1 25 ms1

PMT 0.5 s 25 ms

NIT 10 s 25 ms

SDT 2 s2 25 ms

BAT 10 s1 25 ms1

EIT 2 s2 25 ms

RST — 25 ms

TDT 30 s 25 ms

TOT 30 s 25 ms
1 If present.
2 For current transport stream multiplex.

SI_repetition_error (3.2)
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Error Precondition. ETR 290 states the precondition for an SI_repetition_Error
message as follows:

Indicator Precondition Reference

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

SI_repetition_error ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Repetition rate of SI tables outside of
specified limits

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.4

ETR 211: Sub clause
4.4

RTA Configuration. To configure the RTA to monitor for SI Repetition errors,
activate the following probes:

ETR 290 Probe name Settings window panel

3.2 Max/Min Interval Between Consecutive SI Sections
(All SI tables, all PIDs)

Analysis:Rate:Section
(Select Add all)

The transport stream multiplex is permitted to contain only packets with
program-specific information (PSI and SI tables), packets with certain PIDs that
are reserved in the MPEG-2 standard, and packets that are identified in a
Program Map Table (PMT).

Error Precondition. ETR 290 states the precondition for an Unreferenced_PID
message as follows:

Indicator Precondition Reference
ÁÁÁÁÁÁÁ
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Unreferenced_PID ÁÁÁÁÁÁÁÁÁÁÁÁ
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PID (other than PAT, CAT, CAT_PIDs,
PMT_PIDs, NIT_PID, SDT_PID, TDT_PID,
EIT_PID, RST_PID, reserved_for_fu-
ture_use PIDs, or PIDs user defined as
private data streams) not referred to by a
PMT within [0.5] seconds

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ETS 300 468:
Sub clause 5.1.3

Notice that according to the DVB Measurement Guidelines, if a program is
changed (a new PMT), an unreferenced PID may appear in the transport stream
during a transition period of no more than 0.5 s.

RTA Configuration. To configure the RTA to monitor for Unreferenced PID errors,
activate the following probe:

ETR 290 Probe name Settings window panel

3.4 Ghost Packets Error Analysis:Multiplex

Unreferenced PID (3.4)
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Appendix B: ATSC Program Paradigm

The ATSC program paradigm specifies the method to be used for allocating the
values of the Packet Identifier (PID) field of the transport packet header in a
systematic manner. Within one transport multiplex, television programs that
follow the ATSC program paradigm are assigned a program number ranging
from 1 to 255. The binary value of the program number is used to form b11
through b4 of the PID. Programs adhering to the paradigm shall have b12 equal to
‘0’. Programs not adhering to the paradigm shall have b12 equal to ‘1’.

Additionally: base_PID = program number <<4, where the program number
refers to each program within one transport multiplex and corresponds to the
16-bit program_number identified in the PAT and PMT. The b0 through b3 of the
PID are assigned according to Table B–1.

The paradigm to identify the transport bit streams containing certain elements of
the program is defined in Table B–1.

Table B–1: PID assignment for the elementary streams of a program 

Name PID definition Description

PMT_PID base_PID+0x0000 PID for the bit stream containing the pro-
gram_map_table for the program.

Video_PID base_PID+0x0001 PID for the bit stream containing the video for the
program.

PCR_PID base_PID+0x0001 Implies the video bit stream also carries the PCR
values for the program.

Audio_PID base_PID+0x0004 PID for the bit stream containing the primary audio for
the program. The primary audio shall be a complete
main audio service (CM) as defined by ATSC Standard
A/52 and shall contain the complete primary audio of
the program including all required voice-overs and
emergency messages.

Data_PID base_PID+0x000A PID for the bit stream containing the data for the
program.

The program_map_table must be decoded to obtain the PIDs for services not
defined by the paradigm but included within the program (such as a second data
channel). According to the program paradigm, every 16th PID is a PMT_PID
and may be assigned to a program. If a PMT_PID is assigned to a program by
the program paradigm, the next 15 PIDs after that PMT_PID are reserved for
elements of that program and shall not be otherwise assigned.



Appendix B: ATSC Program Paradigm

B–2 MTS 200 Series Real-Time Analyzer User Manual

Table B–2 lists the program paradigm errors for programs adhering to the
program paradigm b12=0.

Table B–2: Program paradigm errors 

Error Requirement
A/53 Annex C
Paragraph 5.3

Bad program number assignment program_number shall be ranged from 1 to 255. A_PSI_PRPA_001

Bad PMT_PID assignment PMT_PID shall be equal to ‘base_PID+0x0000.’ A_PSI_PRPA_002

Bad Video_PID assignment If a program contains only one Video ES, this one shall be
assigned to base_PID+0x0001. The PID of the other Video ES
must be in the range [base_PID+0x0002; base_PID+0x000F],
except the values (base_PID+0x0004, base_PID+0x000A).

A_PSI_PRPA_003

Bad PCR_PID assignment If a program contains PCR data, this one shall be assigned to
base_PID+0x0001.

A_PSI_PRPA_004

Bad Audio_PID assignment If a program contains only one Audio ES, this one shall be
assigned to base_PID+0x000f. The PID of the other Audio ES
must be in the range [base_PID+0x0002; base_PID+0x000F],
except the value base_PID+0x000f, base_PID+0x000A).

A_PSI_PRPA_005

Bad Data_PID assignment If a program contains only one Data ES, this one shall be assigned
to base_PID+0x000A. The PID of the other Data ES must be in
the range [base_PID+0x0002; base_PID+0x000F], except the
value (base_PID+0x0004, base_PID+0x000A).

A_PSI_PRPA_006

PID reserved by a program adhering to
the program paradigm

The PID range from 0x0XX0 to 0x0XXF are reserved by programs
adhering to the program paradigm with program_number = XX.
These PIDs cannot be used elsewhere in the multiplex.

A_PSI_PRPA_007
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Appendix C: Using the Private Syntax Interpreter

You can use the Private Syntax Interpreter to create and compile private syntax
definitions for use with the Real-Time Analyzer (RTA). When you load the
compiled definition through the RTA Syntactic Analysis panel of the Settings
window, the RTA uses the definition to monitor and analyze the syntax of the
corresponding private sections or private data descriptors that are contained in
the input stream. Refer to Analysis:Advanced:Syntax Panel on page 3–57 for
more information.

The Private Syntax Interpreter interface makes it possible to construct private
syntax definitions of short private sections (section_syntax_indicator = 0), long
private sections (section_syntax_indicator = 1), and private data descriptors.

These are the basic steps you use to construct and use private syntax definitions:

1. Open the desired private syntax template or existing file

2. Change parameters of existing syntax items (such as fields, loops, and
if-then branches)

3. Add and edit syntax items in the template or existing file as necessary

4. Save the private syntax definition to a text file

5. Compile the text file to create a binary data file for use with the RTA

6. Load the binary data file into the RTA using the Syntactic Analysis panel of
the Settings window

This appendix contains the following information:

� Private syntax interpreter interface page C–2

� Editing private syntax definitions page C–12

� Compiling private syntax definitions page C–21

� Analyzing private syntax with the RTA page C–21

� Private data reference page C–23
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Private Syntax Interpreter Interface
This section provides information describing how to start the Private Syntax
Interpreter application and how to use the elements of the application display.

Once you have logged in to the MTS200 Series system, you can start the Private
Syntax Interpreter application using one of the following two methods:

� Select Private Syntax Interpreter from the Windows NT Start menu

� Double-click the Private Syntax Interpreter icon in the Tektronix MPEG
Test System window

The Private Syntax Interpreter application window is shown below. 

Client
area

Menu bar
Toolbar

Status bar

Title bar

Message
view

Starting the Application

Elements of the
Application Window
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The Private Syntax Interpreter window contains the following elements:

� Title Bar. In addition to identifying the Private Syntax Interpreter application,
the title bar indicates which private syntax text file is open, or if more than
one text file is open, the title bar indicates which text file is currently
selected.

� Menu Bar. The menu bar provides access to the various Private Syntax
Interpreter command menus. Refer to Menu Bar on the following page for
descriptions of the menu functions available within the menu bar.

� Toolbar. The toolbar contains graphical command buttons for many of the
most-used menu commands. Refer to Toolbar on page C–6 for more
information.

� Client Area. The Client area provides the workspace for creating and editing
private syntax table or descriptor definitions.

� Message View. The Message view provides a place for operational messages
to be displayed. This area is not displayed except when appropriate (refer to
Message View on page C–11 for more information). You can manually
display this area by selecting Messages from the View menu.

� Status Bar. The status bar displays first-level help messages about the Private
Syntax Interpreter menus and icons pointed to by the mouse (as shown
below).

Status bar message

Menu command
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Menu Bar. The menu bar contains the Private Syntax Interpreter menus. Listed
below are the functions available in each of the menus.

� File Menu. The File menu contains standard Windows NT file management
commands. Table C–1 describes the menu selections available in the File
menu.

Table C–1: Menu bar File menu 

Menu selection Function

New Create a new table/descriptor text file

Open Open an existing table/descriptor text file

Close Close the active table/descriptor text file

Close all Close all table/descriptor text files

Save Save the active table/descriptor text file

Save as Save the active table/descriptor text file with a new name

Print Print the active document

Print setup Change the printer and printing options

Exit Exit the application; will prompt to save documents

� Edit Menu. The Edit menu is present only when a private syntax editing
window is open. This menu contains commands for editing the various
syntax components and for compiling the syntax definition. Table C–2
describes the menu selections available in the Edit menu.

Table C–2: Menu bar Edit menu 

Menu selection Function

Undo Undo the last action

Add field Add a new field to the active table/descriptor text file

Add condition Add a new condition to the active table/descriptor text file

Add loop Add a new loop to the active table/descriptor text file

Add descriptor Add a new descriptor to the active table/descriptor text file

Compile Compile the active table/descriptor text file

Delete Delete the selection

Copy Copy the selection and put it on the Clipboard

Paste Paste the Clipboard contents
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� View Menu. The View menu contains commands for changing the appearance
of the Private Syntax Interpreter application window. Table C–3 describes
the menu selections available in the View menu.

Table C–3: Menu bar View menu 

Menu selection Function

Toolbar Display or hide the toolbar

Status bar Display or hide the status bar

Messages Display or hide the message view

� Window Menu. The Window menu, present only when one or more syntax
windows are open in the Client area, contains commands for managing the
various syntax windows. Table C–4 describes the menu selections available
in the Window menu.

Table C–4: Menu bar Window menu 

Menu selection Function

Cascade Arrange the Client area windows so that they overlap

Tile Arrange the Client area windows as non-overlapping tiles

Arrange icons Arrange the icons at the bottom of the Client area if you have reduced
the Client area windows to icons

� Help Menu. The Help menu provides access to Private Syntax Interpreter
online help and version information. Table C–5 describes the menu
selections available in the Help menu.

Table C–5: Menu bar Help menu 

Menu selection Function

Help topics Open the Private Syntax Interpreter help window

About Private Syntax
Interpreter

Display program information, version number, and copyright
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Toolbar. The toolbar command buttons are shortcuts to various menu commands.
Table C–6 describes the functions available in the toolbar.

Table C–6: Private Syntax Interpreter toolbar buttons 

ÁÁÁÁ
ÁÁÁÁ

Button ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Equivalent menu command ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Function
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

File menu: New ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Create a new table/descriptor text file

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

File menu: Open ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Open an existing table/descriptor text file
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File menu: Save
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Save the active table/descriptor text file
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Edit menu: Add Field
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Add a new field to the active table/descriptor text
file
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Edit menu: Add Condition ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Add a new condition to the active table/descriptor
text file
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Edit menu: Add Loop ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Add a new loop to the active table/descriptor text
file

ÁÁÁÁÁÁÁÁÁ
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Edit menu: Add Descriptor ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Add a new descriptor to the active table/descriptor
text fileÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
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Edit menu: Compile
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Compile the active table/descriptor text file

The Table/Descriptor window (shown below) is used for assembling and editing
tables or descriptors syntax. The window is divided into two portions: the
Hierarchic view and the Characteristics view. The Characteristics view displays
different panels depending on which Hierarchic view icon is selected.

Table/Descriptor Window
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Hierarchic View. The Hierarchic view displays all the items related to making a
table/descriptor pattern as well as the labels associated to each item. An item can
be the root of the table/descriptor pattern, a field of the private syntax, a loop of
items, a conditional branch of items, or a descriptor space reservation.

Table/descriptor

Fields

Loop

Condition

Descriptor

Table C–7 lists the icon types found in the Hierarchic view and the meaning of
their associated labels.

Table C–7: Hierarchic view icons and label descriptions 

Icon type Description

Table/descriptor This icon gathers the characteristics of the table/descriptor when
located at the top of the tree. The label is then the name of the
table/descriptor.

If not at the top of the tree, the descriptor icon represents a space
reserved for a descriptor and the label indicates the length in bytes.

Field The field icon labels are the unique field ID for the associated field.

Loop The loop icon label indicates the number of iterations of this branch.

Condition The condition icon label indicates the validity of the conditional
branch.

True The true icon indicates the conditional branch in case the previous
condition expression is valid.

False The false icon indicates the conditional branch in case the previous
condition expression is valid.
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Table Panel. The Table panel (shown below) appears in the Characteristics view
when you select the root icon in the Hierarchic view.

After you have defined the type of private syntax by selecting Table or
Descriptor, enter the Id  (decimal) value (table ID or descriptor tag) of the
private syntax you are editing.

NOTE. Table or descriptor ID decimal values cannot exceed 255. In addition,
decimal values cannot be one of the following because they are reserved:
0 (PAT); 1 (CAT); 2 (TSDT); 66 and 70 (SDT); 200 and 201 (VCT).

The General Name, Specific Name, and General Description fields are
optional fields to let you enter more information about the private syntax you are
editing.
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Field Panel. The Field panel (shown at the top of the following page) appears in
the Characteristics view when you select a field icon in the Hierarchic view. This
panel allows you to enter the unique Field Id. The panel provides the Length in
bits of the field. In addition, the Name and Description fields give more
information about the selected field icon.

The Data Type selection determines the interpretation of field data bits
according to their type and order of transmission. Select the appropriate
interpretation from the drop-down list (bslbf, rpchof, tbsv, or uimsbf).

The Valid Condition  field declares the condition under which a field shall be
considered valid or not.

At the bottom of the Field panel appears the list of Interpretations , which is a
list of pairs (expression, interpretation). They are checked following the
top-to-bottom order that they are listed. The interpretations indicate what
descriptor will appear to the right of the item in the Section Analysis view of the
RTA application.
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Expression Panel. The Expression panel (shown below) appears in the Character-
istics view when you select a Condition, Loop, or Descriptor icon not located at
the top of the Hierarchic view.

When you select a Condition icon in the Hierarchic view, the expression field is
the test of the condition. The calculation of this field will determine whether the
condition is true or false.

When you select a Loop icon in the Hierarchic view, the expression field
indicates the number of iterations of the loop.

When you select a Descriptor icon in the Hierarchic view, the expression field
indicates the space in bytes occupied by this item.
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The Message view (as shown below) appears on the bottom of the application
window when you compile the private syntax you are editing.

If any errors occur during compiling, the Message view displays appropriate
error messages. If you double-click on an error message that contains the text:
ERROR LINE <number>, the application highlights the erroneous item in the
Hierarchic view.

Message View
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Editing Private Syntax Definitions
The editing of a private syntax definition consists of creating, modifying, and
saving the pattern of a syntax definition. This pattern is made of syntax fields
organized around loops, conditional branches, and space reservation for
descriptors.

Private syntax definitions reside in text (.txt) files. The application uses standard
Windows NT file management techniques to create, open, and save private
syntax definition files.

To create a new private syntax definition, select New from the File menu or click
the New toolbar button (refer to Toolbar on page C–6). The following New
Table/Descriptor dialog box appears.

Select Table short section to define a new short private section syntax with the
section_syntax_indicator field set to ‘0’.

Select Table long section to define a new long private section syntax with the
section_syntax_indicator field set to ‘1’.

Select Descriptor to define a private syntax descriptor.

Click OK to open a section or descriptor template in the Private Syntax
Interpreter. Client area.

CAUTION. Always save new syntax definitions under a new, unique filename. It is
possible to modify and replace the default template files (InitDr, InitLg, and
InitSt). Do not do so without saving a backup of the original template. Refer to
Saving a Private Syntax File on page C–20 for instructions.

To open an existing private syntax definition, select Open from the File menu or
click the Open toolbar button (refer to Toolbar on page C–6). The standard
Windows NT Open dialog box appears. Enter or select the file name and then
click OK  to open the private syntax definition window in the Client area.

Creating a New Private
Syntax Definition File

Editing an Existing Private
Syntax Definition File
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When you create or open a private syntax definition, a Private Syntax Definition
window appears within the application window. The Private Syntax Definition
window is divided into two portions: the Hierarchic view and the Characteristics
view. The Characteristics view contains the parameters that define the selected
Hierarchic view icon. The Characteristics view displays different definition
panels depending on which Hierarchic view icon is selected.

To completely expand the Hierarchic view, press the numeric keypad asterisk (*)
key. To expand hierarchy items designated with a “+” symbol, click the symbol.
The long private section, short private section, and descriptor template hierar-
chies expand as shown below.

The private syntax hierarchies are consistent with the ISO/IEC presentation of
section syntax (refer to Table C–13 on page C–24). Use standard Windows NT
mouse and cursor-key techniques to navigate within the hierarchies.

Table long section Table short section Descriptor

Private Syntax Definition
Window
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The hierarchy is a collection of syntax fields organized around loops and
conditional branches as well as descriptors. The hierarchy root is a table item and
is the only mandatory hierarchy item.

Section/descriptor

Fields

Loop

Condition

Descriptor

To add a new item to the section or descriptor, select (highlight) the hierarchy
item that is to be the parent of the new item. Then choose Add Field from the
Edit menu or click the Add Field toolbar button (refer to Toolbar on
page C–6). Table C–8 lists the position in the hierarchy that added items appear.

Table C–8: Hierarchy position of added items 

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Selected item ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Position of added item
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Section/descriptor ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Right after the selected item if it is a descriptor; at the end of the hierarchy
if the table is a root item

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Field ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Immediately following the selected field

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Condition ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Immediately following the conditional branch
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

(Condition) True ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Last item of the true conditional branch
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

(Condition) False ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Last item of the false conditional branch
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Loop ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Last item of the loop branch

You can copy or delete existing hierarchy items using the Edit menu Delete,
Copy, and Paste commands. You can also move existing hierarchy items by
performing a drag-and-drop action on the item.

Adding and Editing
Hierarchy Items
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When you add a field hierarchy item, the Field panel appears in the Characteris-
tics view as shown above. The default parameters for added field items are listed
in Table C–9.

Table C–9: Default parameters for added private syntax fields 

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Field parameter ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Default value
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Field ID ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Field <n>1

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Length ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

8 bits

Data type bslbf
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Description
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Field <n>1
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁName

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁField <n>1

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁValid condition

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁTrueÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁInterpretations
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Expression

Interpretation

Default

Undefined
1 The number <n> starts at 0 for the first added field and increments with each new

field insertion.
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Data Types. The four available data types are defined in Table C–10. These are
the different data types supported by digital television standards and the
application.

Table C–10: Private syntax data type definitions 

Data type Definition

bslbf Bit string, left bit first

rpchof Remainder polynomial coefficients, highest order first

tbsv Text bit string value

uimsbf Unsigned integer, most significant bit first

Expressions. An interpretation expression is a Boolean combination of operators
and terminals. Table C–11 defines the operators you can use.

You can express conditional values in either hexadecimal or decimal base; that
is, the following expressions are equivalent:

program_number == 422
program_number == 0x1A6

Table C–11: Private syntax expression operators and terminals 

Type Definition

Operators

<
>
<=
>=
==
!=
+
–
*
/
||
&&
!

less than
greater than
less than or equal
greater than or equal
equal
different
addition
subtraction
multiplication
division
OR
AND
NOT

Terminals

integer
field ID
TRUE
FALSE
API_COMPUTE_CRC_32
API_GET_VALIDITY
Default

Unique identifier of a field

Computed value of the CRC32 for the section
True if CRC32 is OK
For always applicable interpretation
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Table C–12 lists examples of interpretation expressions with their definitions.

Table C–12: Private syntax example interpretation expressions 

Expression Definition

CRC_32==API_COMPUTE_CRC_32 Value of field CRC_32 is equal to the computed
CRC32 value of the section

private_section_length<=4093 private_section_length field value is less than or
equal to 4093

(section_length–9)/4 Number equal to the section_length field value
minus 9, all divided by 4

Adding Interpretations. The RTA checks the conditions in this list to determine
the interpretation text to display on the Section Analysis view. To add an entry to
the interpretations list, right-click on the background of the interpretations box
and then choose New from the resulting menu.

A new, default interpretation appears immediately after the selected item.
Because the RTA checks conditions in top-to-bottom order, you may want to
move the new condition/interpretation pair below one or more of the existing
entries.

Default



Appendix C: Using the Private Syntax Interpreter

C–18 MTS 200 Series Real-Time Analyzer User Manual

Changing Interpretation Order. To change the interpretation order within a field,
right-click on the background of the list of interpretations box, and choose
Move Up or Move Down from the menu.

Default

The selected condition/interpretation moves down one position as shown below.
You can reselect the item and repeat the command to move the item to the
bottom of the list.

Default

Editing an Expression/Interpretation. Click once on an expression/interpretation
line to select it. Click on the expression or interpretation portion of the selected
expression/interpretation to position the cursor at the end of the expression or
interpretation and to enable text entry as shown below. You can then double-click
a word to select it.

Once you have selected the expression or interpretation text to edit, you can
right-click to open a shortcut menu. You can use the Cut, Copy, Paste, Delete,
and Select All commands to edit the selected text. The Undo command lets you
undo the previous text-editing action.
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Adding a New Conditional Branch. To add a new conditional branch, select
Add Condition from the Edit menu or click the Add Condition toolbar button
(refer to Toolbar on page C–6). The default Valid condition is TRUE.

Valid condition if:

Adding a New Loop. To add a new loop, select Add Loop from the Edit menu or
click the Add Loop toolbar button (refer to Toolbar on page C–6). The default
Number of iterations is 1 loop.

Number of iterations: Loops
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Adding a New Descriptor. To add a new descriptor, select Add Descriptor from
the Edit menu or click the Add Descriptor button (refer to Toolbar on
page C–6). The default Descriptor Size is 8 bytes.

Changing the Hierarchy. Items or branches of the hierarchy can be moved within
the hierarchy by selecting and dragging the associated icon.

Items or branches of the hierarchy can be copied from one position to another by
holding the CTRL  key down while dragging the selected icon.

To delete selected items or branches from the hierarchy, select Delete from the
Edit menu or press the DEL button on your keyboard.

To save a private syntax definition in text file format, select Save from the File
menu or click the Save toolbar button (refer to Toolbar on page C–6).

When you save a new syntax definition file, the standard Windows NT Save As
dialog box appears. Enter a file name with a .txt extension and then click OK.

To save an existing syntax definition file under a new name, select Save As from
the Edit menu.

NOTE. If you are using an existing syntax definition as a template for a new
definition, it is good practice to always select Save As to create the new file
before you make any changes to the original definition.

Saving a Private Syntax
File
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Compiling Private Syntax Definitions
To compile a private syntax definition, select Compile from the Edit menu or
click the Compile toolbar button (refer to Toolbar on page C–6).

The Message view opens at the bottom of the Private Syntax Interpreter window.
If there is no compiling error, a file containing the private syntax table, with the
extension .cta, is created in the same directory as the table file.

Analyzing Private Syntax with the RTA
Once you have created, saved, and compiled a private syntax definition, use the
following procedure to monitor private data sections or descriptors in the RTA
input stream:

1. With the RTA running but with analysis stopped, select Settings from the
RTA Configuration menu to open the Settings window.

2. Select Analysis:Advanced:Syntax in the Settings window hierarchy to open
the Syntactic Analysis configuration panel (shown below).

3. Click Add. A standard Windows Open window appears, with only .cta files
displayed.
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4. Change the the appropriate directory, if necessary, and then select the desired
binary syntax definition file (either double-click the file name or highlight
the file name and click Open).

5. Repeat steps 3 and 4 for every private syntax definition you want to use.

6. Click Apply  on the bottom of the Syntactic Analysis configuration panel to
confirm your additions; click OK  to confirm the additions and close the
Settings window.

7. Start RTA analysis.

8. Open a section analysis view of the appropriate table. Refer to Section
Analysis View on page 2–56 for instructions.

Red folder icon and
error indicator

Unique interpretation for
item in Name column

You can run the Private Syntax Interpreter and the Real-Time Analyzer applica-
tions simultaneously. You can therefore use the following technique to experi-
ment with the effects of different private syntax definition parameters on known
sections or descriptors:

1. Load the private syntax description in the RTA and begin analysis as
described above. Open a section analysis window to see how the RTA
analyzes and reports the contents of the private section or descriptor.

2. Edit the private syntax text file as necessary.

3. Compile the syntax definition. The new definition overwrites the original
definition.

4. Stop and then restart RTA analysis. When you restart analysis, the RTA reads
the new contents of the binary definition (.cta) file.

5. Open a section analysis window to see how the RTA analyzes and reports the
contents of the private section or descriptor.
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Private Data Reference

The Private Syntax Interpreter application builds tables and descriptors as
defined in ISO/IEC 13818-1, Generic coding of moving pictures and associated
audio information: Systems, July 1996.

Refer to the standard for additional parameter value information. Tektronix
MPEG Test Systems include much of ISO/IEC 13818-1 in Windows Help
format; to open the Help system, double-click the MPEG-2 Help icon in the
Tektronix MPEG Test System program group window or select the correspond-
ing Windows NT Start menu item.

The following information is taken from ITU-T Rec. H.222.0 (ISO/
IEC 13818-1).

The private_section provides a further means to carry private data also in two
forms. This type of elementary stream may be identified under stream_type as
private_data in PSI sections. The short type of private_section() includes only
the first five defined fields, and is followed by private data. For this structure the
section_syntax_indicator shall be set to a value of ’0’. For the long type, the
section_syntax_indicator shall be set to a value of ’1’ and the full syntax up to
and including last_section_number shall be present, followed by pri-
vate_data_bytes and ending with the CRC_32.

When private data is sent in Transport Stream packets with a PID value
designated as a Program Map Table PID in the Program Association Table, the
private_section shall be used. The private_section allows data to be transmitted
with a minimum of structure while enabling a decoder to parse the stream. The
sections may be used in two ways: if the section_syntax_indicator is set to ’1’,
then the whole structure common to all tables shall be used; if the indicator is set
to ’0’, then only the fields ’table_id’ through ’private_section_length’ shall
follow the common structure syntax and semantics and the rest of the pri-
vate_section may take any form the user determines.

A private table may be made of several private_sections, all with the same
table_id (see Table C–13).

Private Section Types

Syntax of the Private
Section
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Table C–13: Private section 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Syntax ÁÁÁÁÁ
ÁÁÁÁÁ

No. of bits ÁÁÁÁ
ÁÁÁÁ

Mnemonic
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_section() { ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
table_id ÁÁÁÁÁ

ÁÁÁÁÁ
8

ÁÁÁÁ
ÁÁÁÁ

uimsbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_syntax_indicator
ÁÁÁÁÁ
ÁÁÁÁÁ

1
ÁÁÁÁ
ÁÁÁÁ

bslbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_indicator
ÁÁÁÁÁ
ÁÁÁÁÁ

1
ÁÁÁÁ
ÁÁÁÁ

bslbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved
ÁÁÁÁÁ
ÁÁÁÁÁ

2
ÁÁÁÁ
ÁÁÁÁ

bslbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_section_length
ÁÁÁÁÁ
ÁÁÁÁÁ

12
ÁÁÁÁ
ÁÁÁÁ

uimsbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (section_syntax_indicator = = ’0’) {
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
for (i = 0; i < N; i++) {

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
private_data_byte

ÁÁÁÁÁ
ÁÁÁÁÁ

8
ÁÁÁÁ
ÁÁÁÁ

bslbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

}
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ}
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁelse {
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtable_id_extension
ÁÁÁÁÁ
ÁÁÁÁÁ16

ÁÁÁÁ
ÁÁÁÁuimsbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved
ÁÁÁÁÁ
ÁÁÁÁÁ2

ÁÁÁÁ
ÁÁÁÁbslbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁversion_number
ÁÁÁÁÁ
ÁÁÁÁÁ5

ÁÁÁÁ
ÁÁÁÁuimsbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁcurrent_next_indicator
ÁÁÁÁÁ
ÁÁÁÁÁ1

ÁÁÁÁ
ÁÁÁÁbslbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁsection_number
ÁÁÁÁÁ
ÁÁÁÁÁ8

ÁÁÁÁ
ÁÁÁÁuimsbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁlast_section_number
ÁÁÁÁÁ
ÁÁÁÁÁ8

ÁÁÁÁ
ÁÁÁÁuimsbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁfor (i = 0; i < private_section_length–9; i++) {
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁprivate_data_byte
ÁÁÁÁÁ
ÁÁÁÁÁ8

ÁÁÁÁ
ÁÁÁÁbslbfÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ}
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁCRC_32
ÁÁÁÁÁ
ÁÁÁÁÁ32

ÁÁÁÁ
ÁÁÁÁrpchofÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

}
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
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The following paragraphs describe the various private section fields.

table_id - This 8-bit field, the value of which identifies the Private Table this
section belongs to. Only values from 0x40 through 0xFE may be used.

section_syntax_indicator - This is a 1-bit indicator. When set to “1”, it indicates
that the private section follows the generic section syntax beyond the pri-
vate_section_length field. When set to “0”, it indicates that the pri-
vate_data_bytes immediately follow the private_section_length field.

private_indicator - This is a 1-bit user definable flag that shall not be specified by
ITU-T | ISO/IEC in the future.

private_section_length - A 12-bit field. It specifies the number of remaining
bytes in the private section immediately following the private_section_length
field up to the end of the private_section. The value in this field shall not exceed
4093 (0xFFD).

private_data_byte - The private_data_byte field is user definable and shall not be
specified by ITU-T | ISO/IEC in the future.

table_id_extension - This is a 16-bit field. Its use and value are defined by the
user.

version_number - This 5-bit field is the version number of the private_section.
The version_number shall be incremented by 1 modulo 32 when a change in the
information carried within the private_section occurs. When the current_next_in-
dicator is set to “0”, then the version_number shall be that of the next applicable
private_section with the same table_id and section_number.

current_next_indicator - A 1-bit field, which when set to “1” indicates that the
private_section sent is currently applicable. When the current_next_indicator is
set to “1”, then the version_number shall be that of the currently applicable
private_section. When the bit is set to “0”, it indicates that the private_section
sent is not yet applicable and shall be the next private_section with the same
section_number and table_id to become valid.

section_number - This 8-bit field gives the number of the private_section. The
section_number of the first section in a private table shall be 0x00. The
section_number shall be incremented by 1 with each additional section in this
private table.

last_section_number - This 8-bit field specifies the number of the last section
(that is, the section with the highest section_number) of the private table of
which this section is a part.

CRC_32 - This is a 32-bit field that contains the CRC value that gives a zero
output of the registers in the CRC decoder defined in ITU-T Rec. H.222.0
Annex A after processing the entire private section.

Semantic Definition of
Private Section Fields
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Descriptors exist within Program Streams and Transport Streams. A range of
private descriptors may be defined by the user (see Table C–14). These descrip-
tors shall commence with descriptor_tag and descriptor_length fields. For private
descriptors, the value of descriptor_tag may take the values 64–255. These
descriptors may be placed within a program_stream_map(), a CA_section(), a
TS_program_map_section(), and in any private section(). Specifically pri-
vate_data_bytes also appear in the CA_descriptor().

Table C–14: Private descriptor 

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Syntax ÁÁÁÁÁ
ÁÁÁÁÁ

No. of bits ÁÁÁÁ
ÁÁÁÁ

Mnemonic
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_descriptor() {
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
descriptor_tag

ÁÁÁÁÁ
ÁÁÁÁÁ

8
ÁÁÁÁ
ÁÁÁÁ

uimsbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length
ÁÁÁÁÁ
ÁÁÁÁÁ

8
ÁÁÁÁ
ÁÁÁÁ

uimsbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

for (i = 0; i < descriptor_length; i++) {
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
private_data_byte

ÁÁÁÁÁ
ÁÁÁÁÁ

8
ÁÁÁÁ
ÁÁÁÁ

uimsbf
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

}
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
}

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

descriptor_tag - This 8-bit field identifies the private descriptor. Values from
64–255 (0x40 through 0xFF) may be used.

descriptor_length - An 8-bit field. It specifies the number of remaining bytes in
the descriptor immediately following the descriptor_length field.

Private Descriptors
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Appendix D: Software Repair

There are two parts to this appendix. The first part explains how to create and
use an Emergency Repair Disk. The second part tells you how to reload the test
system software if the installed copy becomes corrupted.

Creating and Using an Emergency Repair Disk
An emergency repair disk, specific to the system, is supplied with each Tektronix
MPEG Test System. Whenever you upgrade the software or change your
password, it is strongly recommended that you also create a new emergency
repair disk. This will minimize the chances that you will need to completely
reload the operating software for a minor problem.

Use the emergency repair disk to restore your system to its initial setup state if
your system files become corrupt and you are unable to recover the previous start
up configuration (Last Known Good — the Windows NT startup screen option).
If you don’t have the emergency repair disk, you will have to reinstall Windows
NT. Please see the Windows NT System Guide, provided with your back-up
copy of Windows NT, for the procedure required to restore your system.

You may also need the emergency repair disk to restore user passwords if they
are forgotten. Be sure to update the emergency repair disk each time you add a
user or change a password.

CAUTION.  The files on the Emergency Repair Disk are test system-specific; that
is, the disk shipped with your test system is the ONLY  disk that will work with
your system. Do not lose this disk. If you lose the Emergency Repair Disk
provided with your test system, create a new one as described below.
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To create an emergency repair disk, clearly mark a high density 3.5-inch floppy
disk as the emergency repair disk for your test system, serial number <B0xxxxx>
(be sure to write the serial number exactly as it appears on the rear panel); then
perform the following steps.

NOTE. The emergency repair disk is test system specific. Make sure that the
emergency repair disk is clearly marked with its serial number. The serial
number of your Real-Time Analyzer appears on the original emergency repair
disk and on the server rear panel, near the power input connector.

1. Choose Run from the Windows NT Start menu.

2. Type rdisk  in the Run dialog box. The Repair Disk Utility  dialog box
opens.

3. Click Update Repair Info to save your current configuration. A message
appears to remind you that earlier repair information is overwritten. Click
Yes to continue.

4. When the process is complete, a message appears to ask if you wish to create
an Emergency Repair Disk. Click Yes. You are then prompted to insert a
diskette into drive A.

5. Insert a 3.5-inch disk in drive A and click OK . Rdisk formats the disk and
copies the configuration files onto it.

6. When the operation is complete, click Exit  in the Repair Disk Utility dialog
box. Remove the disk from drive A and keep it in a safe place.

Creating an
Emergency Repair Disk
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Always refer to the Windows NT documentation if you need more information.

1. Verify that you have a source of setup information available (the Win-
dows NT back up software package).

2. Insert the Windows NT Setup disk.

3. Restart the Test System.

4. When the Windows NT Setup Screen appears, press R (repair).

5. When prompted, insert the emergency repair disk.

6. The emergency repair disk performs the following tasks:

� Runs CHKDSK.EXE on the WINNT and SYSTEM partitions.

� Verifies each file in the installation and replaces any that are missing or
corrupt.

� Replaces the System, Security, and Security Accounts Manager hives in
the registry.

� Reinstalls the Boot Loader (the boot sector, BOOT.INI, etc.).

Reinstalling the RTA Software
Use the procedures below to reinstall your test system software if it is accidently
deleted or becomes corrupted. Software has been supplied on CD ROM.

NOTE. The following instructions are for reinstalling MPEG Test System
software on a machine running Windows NT Workstation 4.0 only; procedures
for upgrading your software could be different. If you are installing a software
upgrade, follow the instructions provided with the upgrade kit.

Reinstalling software involves three procedures:

� Uninstalling the software

� Copying the program files

� Entering passwords for your licensed applications

Using the Emergency
Repair Disk
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For best results, uninstall the software using unInstallShield application.

1. Restart Windows NT and log in as the administrator (Username = adminis-
trator; password = MPEG2). You must log in as the administrator to install
the RTA applications.

2. Quit any applications that automatically started at login.

3. Double-click the Uninstall MTS V3.0 icon in the Tektronix MPEG Test
System program group window.

4. When the dialog box asks you to confirm file deletion, click Yes.

5. When uninstall is complete, Click OK to close the Remove Programs
From Your Computer  window.

1. Double-click the My Computer icon on your Windows NT desktop and, in
the resulting My Computer window, select the (C:) disk icon. Check the
window status bar to verify that the system disk has at least 100 MB of free
space. The program will not install if the system disk has less than 100 MB
of free space.

2. Place the MPEG Test System Version 2.5 Installation Software CD ROM
into the CD ROM drive.

3. Select Run... from the Windows NT Start menu. Then enter d:\Setup.exe in
the resulting window and click OK .

4. In a few seconds, the Tektronix MTS200 Series window appears on the
computer screen.

Uninstalling the Software

Copying the Program Files
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5. Read the window text and then click Next to proceed to the Choose
Destination Directory window.

6. The default destination folder is C:\Mts200\. Click Next to accept the default
folder. The applications may not function correctly if you specify another
target folder.

NOTE. It is strongly recommended that you use the default destination folder.

7. The Setup Type window opens. If your test system has only real-time
analysis hardware and software, select MTS205 System software with
hardware; if your system also contains a Data Store (CARB) system, select
MTS215 System software with hardware.

8. Click Next. The Select MTS2nn Platform window opens.

9. Select the option that applies to your test system and then click Next.

CAUTION. Selecting the wrong platform will prevent use of the Real-Time
Analyzer and the Data Store system, if it is installed. Be sure to identify your
computer platform and select the appropriate option.

10. The Select Program Folder window opens. Click Next to accept the default
folder name (Tektronix MPEG Test System) and continue. The Selection
Summary window opens.
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11. Review the Destination Directory, System Product, and Start Menu Folder
selections; if all are correct, click Next to proceed with installation.

The setup program begins installing the RTA software. The activity and
progress gauges appear to show that installation is progressing. Installation
proceeds without your input (and sometimes with no apparent activity) for
approximately 21⁄2 minutes, depending on your platform.

12. After the program group and submenu are set up, an information dialog box
reminds you to verify that the Dongle (Software Key) is installed. Verify that
the Software Key is installed on the parallel port; then click OK  to continue.

13. The Setup Complete window opens; click Finish to continue.

14. A Notepad window opens to display the Readme file. Scan the text for
important information, then select Exit  from the File menu to close the
window.

15. Another Setup Complete window opens. For best results, accept the “Yes, I
want to restart my computer now” option, remove the MPEG Test System
disc from the CD ROM drive, and click Finish to complete setup and reboot
the system.

16. Log on as MTS100. No password is required.
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17. Locate the Tektronix MPEG Test System folder on the Windows NT
desktop and double-click the folder to open the program group window.

NOTE. The Data Store Administrator icon will not be present after MTS 205
installation. Neither the Data Store Administrator icon nor the Real-Time
Analyzer icon are present after software-only installation.

Perform the remaining steps to reenter the general password that corresponds to
the attached Software Key.

1. Double-click the License Manager icon in the Tektronix MPEG Test
System window to start the application. The Tektronix Software Protection
window appears.

2. Consult the list of passwords supplied with your most recent system upgrade
and identify the General password. Use the original password supplied with
your system only if you have not upgraded the system or added any options.

3. Enter the three 6-character Hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields
(lowercase characters are acceptable) and then click OK . A License message
window appears.

4. If the password is correct, click OK  to acknowledge the message. If you
made an error entering the password, click OK  and return to step 1.

When you enter the correct password, software reinstallation is complete.

Entering the General
License Password
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Glossary

ACTS (Advanced Communications Technologies and Services)
A set of telecommunication research projects financed by the European
Union.

ASI
Asynchronous Serial Interface, the DVB serial data protocol.

BAT (Bouquet Association Table)
One of the tables defined by DVB-SI, the BAT provides information
regarding bouquets (collections of services marketed as a single entity).
DVB only.

CARB (Carte d’Acquisition / Restitution Binaire)
(French for Binary Acquisition/Restitution Board) The MTS 215 Data Store
system, which can capture, store, and output MPEG-2 compliant transport
streams.

CAT (Conditional Access Table)
One of the PSI tables described by the MPEG-2 standard, the CAT provides
the association between one or more CA systems, their EMM (Entitlement
Management Message) streams, and any special parameters associated with
them.

Configuration
In the Real-Time Analyzer report view, a collection of all analysis results
gathered between the establishment of synchronization to the subsequent loss
of synchronization.

CRC (Cyclic Redundancy Check)
One of the fields described in the MPEG-2 standard, used to verify the
correctness of data in PSI and SI tables.

DSM-CC
Digital Storage Media Command and Control, defined in ISO/IEC 13818
part 6.

DVB (Digital Video Broadcast)
A project group of the European Broadcasting Union (EBU).

DVB-MG
Digital Video Broadcasting - Measurement Guidelines.
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DVB-SI (Digital Video Broadcast Service Information)
The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG-2.)

DVB-T
Terrestrial Digital Video Broadcasting.

DTS (Decoding Time-Stamp)
One of the fields described in the MPEG-2 standard, may be present in a
PES packet header that indicates the time that an access unit is decoded in
the T-STD.

ECM  (Entitlement Control Message)
Private conditional access information that specifies control words and
possibly other, typically stream-specific, scrambling, and/or control
parameters.

EISA (Extended Industry Standard Architecture)
The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)
One of the tables defined by DVB-SI, the EIT contains data concerning
events (a grouping of elementary broadcast data streams with a defined start
and end time belonging to a common service) and programs (a concatenation
of one or more events under the control of a broadcaster, such as event name,
start time, and duration).

EMM (Entitlement Management Message)
Private conditional access information that identifies the authorization levels
or the services of specific decoders.

ETS (European Telecommunication Standard)
One of the types of documents released by ETSI.

ETSI
European Telecommunications Standards Institute.

ETR (ETSI Technical Report)
One of the types of documents released by ETSI.

Ghost
One or more packets found in the transport stream but not referenced in any
appropriate table. For example, a packet identified as a Program Map Table
(PMT, table_id = 0x02) but not referred to by PID in the Program Allocation
Table (PAT).
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IRD (Integrated Receiver / Decoder)
A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

ISO (International Standard Organization)
Organization responsible for establishing standards at the world-wide level.

NIT (Network Information Table)
One of the PSI tables described by the MPEG-2 standard and also one of the
tables defined by DVB-SI. The NIT conveys information relating to the
physical organization of the multiplex; that is, transport streams carried via a
given network and the characteristics of the network itself. Transport streams
are identified by the combination of an original network ID and a transport
stream ID in the NIT.

OPCR (Original Program Clock Reference)
Optional transport packet field defined in the MPEG-2 standard that contains
a coded time stamp used in the reconstruction of a single program transport
stream from another transport stream. The OPCR field shall be coded only in
transport stream packets in which the PCR field is present.

PAT (Program Association Table)
One of the PSI tables described in the MPEG-2 standard, the PAT gives
information about the structure of  a transport stream.

PCR (Program Clock Reference)
One of the fields defined in the MPEG-2 standard, a time stamp in the
transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)
A structure defined in the MPEG-2 standard used to carry elementary stream
data.

PIA (Processing Interface Adapter)
The Real-Time Analyzer circuit board that filters, decodes, and analyzes the
compliance at low level of an MPEG-2 transport stream.

PID (Packet IDentifier)
One of the fields described in the MPEG-2 standard, a unique integer value
used to identify elementary streams of a program in a single or multipro-
gram TS.

PMT (Program Map Table)
One of the PSI tables described by the MPEG-2 standard, the PMT identifies
and indicates the locations of the streams that make up each service and the
location of the Program Clock Reference (PCR) fields for a service. This
table is transmitted in sections.

Probe
A user-initiated analysis.
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PSI (Program Specific Information)
A set of tables described by the MPEG-2 standard, the PSI contains all the
tables that define the MPEG-2 transport stream. It consists of the PAT, PMT,
CAT, and NIT tables. (NIT is also used for DVB-SI.)

PTS (Presentation Time Stamp)
One of the fields described in the MPEG-2 standard, the PTS may be present
in a PES packet header that indicates the time that a presentation unit is
presented in the T-STD.

QUOVADIS (QUality Of Video and Audio for DIgital Television Services)
One of the ACTS projects in which MATRA COMMUNICATION is
involved, QUOVADIS deals with the definition of parameters for quality of
service in digital television systems.

RTA
Real-time Analyzer.

RST (Running Status Table)
One of the tables defined by DVB-SI, the RST gives a quick updating
mechanism for the status information carried in the EIT.

SDT (Service Description Table)
One of the tables defined by DVB-SI, the SDT contains data describing the
services in the system. Examples include: names of services and the service
provider.

SI (Service Information)
Set of tables defined by DVB-SI, SI provides information on services and
events carried by different Multiplexes, and even other networks. SI is
structured as six tables (PAT, NIT, CAT, SDT, EIT, and BAT). The applica-
tions are only concerned with NIT, BAT, SDT, and EIT.

SIDAT 360
Also known as SI-DAT 360, the DVB specification for data broadcasting.
Equivalent to the ETSI standard EN 301 192.

ST (Stuffing Table)
One of the tables defined by DVB-SI, the ST provides stuffing sections.

TDT (Time & Date Table)
One of the tables defined by DVB-SI, the TDT carries the current time and
date information.

TOT (Time Offset Table)
One of the tables defined by DVB-SI, the TOT gives information about a
local time offset in a given area.
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TS (Transport Stream)
A bit stream that contains 0 or more elementary streams combined in a
manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)
Described by the MPEG-2 standard, the T-STD is a hypothetical reference
model of a decoding process used to define the semantics of a TS.
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Index
A
Absence of mandatory EIT, 3–14
Absence of referenced PID error analysis, 3–11
Active view menu, 2–7
adaptation field, A–4, A–8, A–11
ADF flags error analysis, 3–22
Analysis

transport rate, 3–2, 3–33, 3–72
Analysis menu, 2–6
Analysis modes, 3–3
Application window, 2–1
Apply, 3–47
Ask before saving, 3–90
Automatic analysis, 3–9
Automatic trace sequencing, 2–101

B
BAT, A–7, A–12
Buffer filling, 1–6

C
Capturing input streams, 2–96
CAT, A–7, A–11
CAT_error, A–10
changing programs, A–4, A–8
Client window pane, 2–39
Clock symbol, 2–16
Conditional Access Table, A–11
Configuration

delete, 3–45
Load (restore saved), 3–44
Restore standard, 3–44
Save, 3–43

Configuration (report view), 2–24
Configuration menu, 2–5
Configuration settings, 3–46
Continuity Counter (Statistic view), 2–50
Continuity counter error analysis, 3–21
Continuity_count_error, A–4
Continuous acquisition, 3–87
CRC, A–7
CRC check (analysis), 3–25
CRC_error, A–7
Cyclic Redundancy Check, A–7

D
Data Storage, 2–96

menu, 2–6
Start/Stop, 2–98, 3–86

DEN signal, 3–48
discontinuity indicator, A–4, A–8
Dongle, D–6
DVB, General option, 3–3, 3–50
DVB-MG

measurements, A–1
view, 2–53, 2–79

DVB-T, Analysis option, 3–51

E
EIT, A–7
EIT_error, A–12
Emergency Repair Disk, D–1
encryption data, A–11
Error limits, transport rate, 2–44, 2–48
Event Information Table, A–11
Event trace, 3–89
Event Viewer, 2–35, 2–37, 3–78
Exiting the application, 1–4

F
Filtering Configuration, 2–98

settings, 3–94
First-time operation, ix, 1–2

G
General settings, 3–50
Ghost packet error analysis, 3–11
Ghost scanning, Analysis option, 3–51
Graphic View settings, 3–83

H
Hardware, installation, ix, 1–2
Hardware configuration settings, 3–48
Help menu, 2–7
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Hierarchic view, 2–11
settings, 3–81

Hierarchic window, 2–70

I
Icons, Hierarchic view, 2–14
Installation, hardware, ix, 1–2
InterSI consistency error analysis, 3–12
InterSI probe, 2–93, 3–14

L
Lock symbol, 2–16
Logging on, 1–3
Logins, 1–3

M
Mask Discontinuities, 3–67
Mega Frame

Rate, 3–76
Syntax, 3–63
Timing, 3–71

Mega Frame CRC error analysis, 3–27
Mega Frame frequency offset error analysis, 3–27
Mega Frame Size, 3–13
Mega Frame size error analysis, 3–13
Mega Frame syntax analysis, 3–26
Mega Frame syntax error analysis, 3–27
Mega Frame time offset error analysis, 3–27
Menu bar, 2–4
Menus

active view, 2–7
Analysis, 2–6
Configuration, 2–5
Data Storage, 2–6
Help, 2–7
icon shortcut, 2–19
View, 2–5
Window, 2–6

Message View settings, 3–78
Messages, 2–23
MGT PID with PUSI and pointer field, 3–23
MIB file, 2–103
Minimum interval between sections analysis, 3–39
Monitoring an input stream, 2–68
MPEG-2, General option, 3–3, 3–50

N
NIT, A–7
NIT_error, A–12
null packet, A–4
Null Packet with ADF error analysis, 3–22
Null packet with PUSI error analysis, 3–20

P
Padlock symbol, 2–16
Password, changing, emergency repair disk, 1–3
PAT, A–3, A–7
PAT PID with AFC & DI error analysis, 3–22
PAT PID with AFC and DI, 3–22
PAT_error, A–3
PAUSE, 2–9
PCR analysis

settings, 2–61, 3–65
view, 2–61

PCR probes, 2–86, 3–29
PCR/OPCR flags error analysis, 3–21
PCR_accuracy_error, A–9
PCR_error, A–8
PID, A–6
PID 0x47 error analysis, 3–20
PID Allocation (Statistic view), 2–46, 3–35
PID_error, A–6
PMT, A–5, A–7, A–8, A–15
PMT PID with AFC & DI error analysis, 3–23, 3–27
PMT PID with AFC and DI, 3–23
PMT PID with TSC error analysis, 3–20
PMT_error, A–5
Presentation Time Stamp, A–10
Printing, Section analysis view, 2–58
Probes, 2–86

InterSI, 2–93, 3–14
PCR, 2–86, 3–29
PTS/DTS, 2–90, 3–31
Removing, 3–5
Section syntax, 3–25
Setting, 3–4
Transport rate, 3–72

Profile, 3–43, 3–47
program, A–6
Program Allocation (Statistic view), 2–43, 3–33
Program Association Table, A–3
Program Clock Reference, A–8
Program Map Table, A–5, A–15
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Program paradigm, 3–13, B–1
PSI, A–7
PSIP tables PID with ADF, 3–23
PSIP tables PID with TSC, 3–23
PSIP tables PID with TSC error analysis, 3–23
PTS, A–10
PTS/DTS analysis view, 2–59
PTS/DTS probes, 2–90, 3–31
PTS/DTS timing analysis, 3–69
PTS_error, A–10
Pulldown menus. See Shortcut menus

R
Registry editor, 3–45
Remote control, 2–103
remultiplexing, A–8
Repair Disk Utility, D–2
Report Configuration, 2–24
Report view, 2–23
Reserved PID with TSC error analysis, 3–20
RST_error, A–12
Rta.trp, 2–97

S
Scrambled ES without CA descriptor, 3–13
Scrambling without CAT error analysis, 3–11
SDT, A–7, A–12
SDT_error, A–12
section, A–5, A–7
Section analysis view, 2–56
Section number analysis, 3–25
Section rate analysis, maximum and minimum

intervals, 3–37, 3–74
Section rate view, 2–58
Section rates analysis, settings, 3–74
Section Syntax probes, 3–25
service information, A–11, A–12
Settings, 3–46
Settings window, 3–42
Settling Filter, 2–61, 3–30, 3–65
Setup, hardware, ix, 1–2
Shortcut menus, 2–19

Report view, 2–26
Shutting down the computer, 1–5
SI_repetition_error, A–14
SIDAT 360 Data Broadcasting Analysis, Analysis

option, 3–51
SIDAT 360 Profiles, Analysis option, 3–51
Smoothing time, Analysis option, 3–51
SNMP, 2–103

Software key. See Dongle
Software repair, D–1
Software version, xiii
Specifications, ix, 1–2
Start acquisition, 2–99, 3–86
Start condition, 3–86
Starting the application, 1–4
Statistic analysis settings, 3–11
Statistic view, 2–42, 2–75
Status bar, 2–9
Stop acquisition, 3–87
Stop conditions, 3–87
Sync_byte_error, A–3
SyncByte, A–2
system time, A–8

T
Table ID error analysis, 3–12
table_id, A–5, A–12
TDT, A–12
TDT_error, A–12
TEI. See Transport error indicator
Terrestrial descriptor consistency, 3–13
Title bar, 2–3
Toggle Docking, 2–26
Toolbar, 2–8
TOT, A–7, A–12
TP Error Indicators (Statistic view), 2–52
Transport error indicator analysis, 3–22
Transport rate

analysis, 3–2, 3–33
interval, 2–44, 2–48

Transport rate analysis, 3–36
settings, 3–72

Transport_error, A–6
transport_error_indicator, A–6
transport_scrambling_control, A–10
Trigger

configuration, 3–48
Data storage start condition, 3–86

TS_Sync_Loss, A–2
Type Alloc (Statistic view), 2–51, 3–35

U
Uninstalling MTS software, D–4
UNP. See Unsynchronized packet error analysis
unreferenced PID, A–15
Unsynchro Packets (Statistic view), 2–52
Unsynchronized packet error analysis, 3–12
Use DEN signal, 3–48
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V
Version, software, xiii
Version number analysis, 3–25
View

IP monitoring, 2–65
MIP packet analysis, 2–64
PCR analysis, 2–62
PTS/DTS analysis, 2–60
Section analysis, 2–56

Section rate, 2–58
View menu, 2–5

W
Window, application, 2–1
Window menu, 2–6
Windows NT, initialization, 1–3
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